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Preface

The GeoExpress User Manual is written for geographic information system (GIS) professionals
that want to compress and manipulate geospatial data with GeoExpress. This guide assumes
that you have basic knowledge of GIS, including mosaics, coordinate reference systems, multis-
pectral imagery, and LiDAR point clouds. This guide describes how to install and operate the
graphical version of GeoExpress. To install GeoExpress on Linux, you must install the command
line version of GeoExpress. For installation instructions and other information about the com-

mand line version of GeoExpress, see the GeoExpress Command Line User Manual.
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Product OVeNVIEW. . . . 1

New Features

GeoExpress is a software solution for compressing and manipulating geospatial data. GeoEx-
press supports a broad range of file formats, including the industry standard MrSID format and
the ISO standard JPEG 2000 format.

Here are some of the tasks that you can perform with GeoExpress:

e Compress raster and LiDAR data.

¢ Create seamless mosaics.

o Specify separate compression ratios for individual bands in a multispectral image.
o Reproject raster images to another coordinate reference system.

o Perform color balancing.

o Crop and demosaick raster images.

o Despeckle rasterimages.

« Edit image metadata.

Save the images that you create with GeoExpress to a local machine or a LizardTech
Express Server. Then, view the images in the geographic information system (GIS) software of

your choice, including Esri®, Bentley®, Autodesk®, and more.

Version 9 of GeoExpress includes the following new features and enhancements:




GeoExpress 9.5 User Manual

GeoExpress supports compressing LiDAR point clouds stored in plain-text format or in the
LAS and LAZ formats. The output image is stored in the MrSID Generation 4 format or the LAZ

format.

When you crop images, you can define the area that you want to crop with a shapefile. The
shapefile that you select can contain multiple polygons. You can then create a single image that
contains the area of all the polygons, or you can create separate images for each polygon. Pre-

viously, shapefiles needed to contain exactly one polygon.

Perform color balancing operations on multiple images. When you adjust color balancing settings
for one image, you can apply the settings to multiple otherimages. Previously, you could only

color balance single images and mosaics.

Each edition of GeoExpress, including the trial, now uses the same installer. For example, you
can enter a license code to change from the trial to the standard edition or from the standard edi-
tion to the unlimited version. Previously, you needed to uninstall one edition of GeoExpress then

download a separate installer for the other editions of GeoExpress.

When you compress a floating point image, GeoExpress uses quantization to compress the

image. You can create 32-bit floating point images in the MrSID Generation 4 format.

Quantization is a lossy compression method that reduces the number of pixel values in the image.

Quantization is necessary for floating point images for two reasons:

Performing arithmetic on floating point values results in rounding discrepancies.
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Compressing floating point values results in unnecessarily large images. This is because some of

the digits in each pixel value contain data that is not significant and cannot be compressed.

As a result, GeoExpress uses a lossy compression method for floating point images, but guar-

antees the accuracy of the image data to an optimized precision value.

To improve the appearance of MrSID images in other GIS programs, you can use GeoExpress to
write dynamic range metadata for images. For an image where the dynamic range is less than the
full range of possible values for the image, you can use your GIS program to stretch the pixel val-

ues across the full range. For example, if you have a 16-bit image and the dynamic range is 12

bits, then you may want to use dynamic range stretching to improve the appearance of the image.

When you create an auxiliary file for an image, GeoExpress writes additional metadata into the
auxiliary file. If the image contains regions without image data, the no-data values are stored in
the auxiliary file. Additionally, if you generate dynamic range metadata for the image, the

dynamic range values are stored in the auxiliary file.

The performance of multi-core processing has been improved. Each job that you run in GeoEx-

press uses less processing power and finishes faster.

You can calculate image statistics for each band in an image from the command line. The image
statistics include the minimum value, the maximum value, the mean value, and the standard devi-

ation. Enter the following command to calculate statistics for an image:

mrsidgeoinfo -stats <Image Name>

Any images that you add to the GeoExpress graphical user interface appear in the same simple

job list. You can view and run all jobs in the same job list regardless of the image compression
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and manipulation operations that you want to perform. Previously, jobs were scattered across mul-

tiple tabs.

GeoExpress automatically uses its optimization feature whenever possible. The optimization fea-
ture performs a subset of image compression and manipulation operations without re-encoding
images. Previously, to use optimization you needed to remember which operations supported

optimization, and you needed to add images to a separate Optimize tab.

The user interface includes updated window graphics and icons.

If you run GeoExpress on a machine with a multi-core processor or on a machine with multiple pro-
cessors, GeoExpress creates multiple threads to process jobs more quickly. The number of
threads and jobs that you can run at one time depends on the number of cores in your machine's

processor.You can use a maximum of eight cores for image encoding.

For images that include rotation metadata, GeoExpress creates rotated output images. This fea-
ture is turned on by default so that your images are displayed with the correct orientation even in
viewers that do not support metadata for image rotation. Previously, GeoExpress preserved rota-

tion metadata without rotating the output image.

You can add custom watermarks to your images. GeoExpress supports watermark images in
BMP, PNG, and JPEG formats. You can use black and white images with maximum dimensions

of 128 pixels by 128 pixels.

You can create mosaics that use multiple coordinate reference systems from the command line.
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GeoExpress now supports PNG files. You can perform any operation with PNG files that you can

perform with other supported file formats.

GeoExpress can now interpret NITF files with RPC metadata.

NOTE: To see a list of fixes and other information for the current version of GeoEx-

press, see the Readme.

Before you install GeoExpress, verify that your system meets the minimum system requirements.

For optimal performance, verify that your system meets the following recommended hardware

requirements:

e 2.5 GHz quad core processor

e 4GB RAM

e 200 MB of disk space for installation and additional space forimages
e SATA drive or better

However, it is still possible to run GeoExpress on systems with the following minimum hardware

requirements;

e 1.5 GHz processor
¢ 1GBRAM

o 200 MB of disk space for installation and additional space for images

You can install GeoExpress on 32-bit and 64-bit versions of the following operating systems:

e Windows Server 2012

e Windows 8

e Windows 7

¢ Windows Server 2008 R2
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o Windows Server 2008 Service Pack 2

¢ Windows Vista Service Pack 2

NOTE: Windows Server 2008 R2 is for 64-bit machines only.

On Windows, GeoExpress requires the following software to run:

e Microsoft .NET Framework 4.5
o Visual Studio C++ 2010 Redistributable
e SlimDX Runtime .NET 4.0

If this software is not installed on your machine, the GeoExpress installer installs the software for

you.

NOTE: The SlimDX Runtime is used to display LiDAR point clouds in 3-D.

When you purchase GeoExpress, you can choose to download the software from an FTP site or
toinstall from a DVD. The installation software contains a license key, sample imagery, and the

GeoExpress documentation.

Alternatively, download the trial of the software from the LizardTech website.
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The GeoExpress Installer. ... 7
Installing GEOEXPIESS. . . . ..o e 8
Licensing GEOEXPIress. . . . ..o oo 9
Installing Data Cartridges. ... 11

To set up GeoExpress, complete the following steps:

o Run the GeoExpress installer to install the GeoExpress application and the Express Cart-
ridge Manager.

o Enteralicense code or connect to a License Server.

o If you have a copy of GeoExpress Standard Edition, connect to an Express Cartridge Man-

ager Server or use the Express Cartridge Manager to configure a data cartridge.

The GeoExpress installer includes the following products:

o GeoExpress. The graphical version of GeoExpress. This version includes the command
line interface.

o GeoExpress Command Line. The command line version only. For more information on
the command line version of GeoExpress, see the GeoExpress Command Line User
Manual.

o License Server. A server that hosts floating licenses for networked computers. For more
information on floating licenses and instructions for configuring a license server, see Float-
ing Licenses on page 219.

o Express Cartridge Manager. The data cartridge manager. If you install the Standard
Edition of GeoExpress, you must install the Express Cartridge Manager or have access to
an Express Cartridge Manager Server.

o Express Cartridge Manager Server. A server that hosts a shared data cartridge for net-

worked computers.
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o ExpressView Browser Plug-in. A browser plug-in that you can use to view MrSID,

JPEG 2000, and JPIP files. For browser requirements and usage instructions, see the

ExpressView User Manual.

o GeoViewer. A free geospatial data viewer with support for raster imagery, LiDAR point

clouds, shapefiles, WMS sources, and JPIP sources.

NOTE: The products that you see in the installer vary depending on your edition of

GeoEXxpress.

To upgrade from a previous version of GeoExpress, uninstall the previous version of GeoExpress

before you run the installer.

1.

2.

Log on to the machine where you want to install GeoExpress with administrator privileges.

Navigate to the directory where you downloaded the installer or insert a GeoExpress install-

ation DVD into your DVD drive.

If you downloaded the installer from an FTP site, the installer is saved as an ISO file. To

open the ISO file, perform one of the following steps:

e Burnthe ISO file to a DVD.

e Use an ISO reader to mount the file to a virtual drive.
Run the AutoRun . exe program.
The Product Selection window opens.
Click GeoExpress.
The GeoExpress Installation Wizard opens in a separate window.

The installation wizard prompts you to complete the following tasks:
o Accept the License Agreement.
o Select the directory where you want to install GeoExpress.
¢ Install the Microsoft .NET Framework and Visual Studio C++ Redistributable.
o Optionally, add GeoExpress to your machine's path environment variable. If you
add GeoExpress to your machine's path, you can run GeoExpress commands from

the command line without navigating to the GeoExpress directory.




Chapter 2: Installation and Licensing

6. Inthe Product Selection window, click any other products that you want to install and fol-
low the installation instructions.

7. Close the Product Selection window.

The first time that you run GeoExpress, you must enter a serial number and license code. Altern-

atively, instead of entering a license code, you can connect to a license server.

Serial numbers are specific to a version of GeoExpress, and determine the functionality available
to you. For example, there are different serial numbers for GeoExpress Standard and GeoEx-
press Unlimited. If you want to use GeoExpress as a trial for 30 days, you do not need to enter a

serial number.

License codes are specific to your machine. You can enter the temporary license code included
with the software to use GeoExpress for 30 days, or you can request a permanent license code
from LizardTech Customer Support. If you activate a temporary license code, you can switch to a

permanent license code by editing the GeoExpress license options.

Alternatively, if you connect to a license server, you use a floating license that can be shared by

multiple computers.

NOTE: You must run GeoExpress with administrative privileges to activate a license

code or switch to a permanent license code.

1. Run GeoExpress by clicking the desktop icon or by clicking the Start menu and clicking

Programs > LizardTech > GeoExpress > GeoExpress 9.
GeoExpress starts.
2. Click Options > Licensing.

The License Management dialog box appears. If the temporary license code has

expired, the License Management dialog box opens when GeoExpress starts.
3. Inthe Request License section, click Copy.

4. Clickthe Request License button to open a web browser and navigate to the following
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URL:

https://www.lizardtech.com/support/product-activation/

5. Fill out the form and paste your locking code in the Locking Code field.

LizardTech Customer Support will send you a license code within one business day.

NOTE: If you use GeoExpress with a license server, you do not need to get your

machine's locking code.

1. Run GeoExpress as an administrator by right-clicking on the desktop icon and selecting

Run as administrator.
2. Click Options > Licensing.

3. Inthe Enter License section, enter the serial number that you received from LizardTech

Customer Support.
The View License section displays whether the serial number is valid.

4. Inthe Enter License section, enter the license that you received from LizardTech Cus-

tomer Support.
5. Optionally, if you purchased a NITF license, select the Prefer NITF License check box
6. Click OK.

The main window title displays the license type.

1. Run GeoExpress as an administrator by right-clicking on the desktop icon and selecting

Run as administrator.

2. Inthe Enter License section, enter the name of the License Server. For example, you

might enter the following server name:

LIZARDTECH-SERVER

3. Click OK.

-10-
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For more information on floating licenses and the LizardTech License Server, see Floating

Licenses on page 219.

The standard edition of GeoExpress requires a data cartridge to create new compressed images.
The data cartridge represents a specific purchased amount of data that you can use to create
these images. Data cartridges are generated by LizardTech and emailed to you as an attached
file. You manage data cartridges in the Express Cartridge Manager. You can either install a data
cartridge on your local machine or you can use a data cartridge from an Express Cartridge Man-

ager Server.

For more information on configuring the Express Cartridge Manager and how to calculate data

usage, see Data Cartridges on page 217.

1. Click Start > Programs > LizardTech > Express Cartridge Manager ID.
The Express Cartridge Manager window opens.

2. Copy the Express Cartridge Manager ID.

3. Open a web browser and navigate to the following URL:

https://www.lizardtech.com/support/product-activation/

4. Fill out the form and paste your ID into the Express Cartridge Manager ID field.

LizardTech Customer Support will send you a data cartridge within one business day.

1. Save the email attachment that you received from LizardTech Customer Support on your

local drive.

2. Run GeoExpress by clicking the desktop icon or by clicking the Start menu and clicking

Programs > LizardTech > GeoExpress > GeoExpress 9.
GeoExpress starts.

3. Click Tools > Data Cartridge.

-11 -
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Click the Administration tab.
Click Install New Local Data Cartridge.

6. Navigate to the directory where you saved the email attachment.
7. Select the email attachment and click Open.

The data cartridge installs.

1. Run GeoExpress by clicking the desktop icon or by clicking the Start menu and clicking

Programs > LizardTech > GeoExpress > GeoExpress 9.
GeoExpress starts.

Click Tools > Data Cartridge.
3. Select the Use Network ECM option.

4. Click Select a Network ECM and enter the host name and port number of the Express

Cartridge Manager Server.

By default, the port number is 9002.

-12-
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Graphical User Interface Overview

You can use the GeoExpress graphical user interface to complete all compression and manip-
ulation tasks. To access the graphical user interface, click the desktop icon. Alternatively, click the

Start menu and click Programs > LizardTech > GeoExpress > GeoExpress 9.5.

The following figure shows the GeoExpress graphical user interface:

-13-
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[©) Standsrd/Remote (NI ===

[File Jobs Options Tools Help | ]

CLIEL LT -1 3 o O 1|

4 @ Raster Files Propertlesl Output | Preview I
o (ForL i Job Opticns

P Li DAR Files Cutput Format: I MrSID Generation 4 j| Maore Options... |

0 MiStHelens_0062 las.sid Output Destination:  C:\Dump\GIS Data\Raster\King County'King_County.sid Browse. .. |

Compression: (" Lossless @ 20 1

Advanced... |

QOutput file size: 1.3 GB Estimated memory usage: 446.5 MB
—Image Properties 5

Input File Size: 1.8GE File Type: MrSID Generation 3
Nominal Size: 269 GEB Bands: 3

Image \width: 112420 pixels Data Type: 8 bits, unsigned
Image Height: 24870 pixels MNumber Of Levels: 15

Coordinate Reference System:  NADE3/ UTM zone 10N (26910)

—Image Extents
Left: X, Resolution:
Top: Y Resolution:
Right:

Bottom:

Run Selected Jobs

/

1. MenuBar

2. Toolbar

3. Data Cartridge Gauge

4. Job List

5. Properties, Output, and Preview Tabs
6. Run Button

7. StatusBar

Menu Bar

The menu bar is a central place where you can view most of the tasks that you can perform in

GeoExpress and the options that you can set.

The following table describes some of the options unique to the menu bar:

-14 -
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Option

Description

File > Save project

Save the jobs that you have open in a project file. Project files store the options that you

have set for each job.

Options

> Preferences

Edit preferences for raster images. You can edit the default output directory and file

format, set a default compression ratio for each file format, and more.

Options

> LiDAR Preferences

Edit preferences for LIDAR images. You can edit the default compression ratio, the

default number of points to display in the preview of point clouds, and more.

Options > Licensing

View your locking code, add a license, or select a license server.

Tools > Data cart-

ridge

Install a data cartridge, select an Express Cartridge Manager Server, or view the

Express Cartridge Manager history.

For a full description of all menu options, see Appendix C - Summary of Menu Options on page

229.

The Preferences dialog box can be used to set default job options and other global settings for

raster files. In this dialog box you can set general preferences, default parameters for MrSID and

JPEG 2000 encoding, and color and line appearance in editors and selectors.

For more information about the options available on each tab, see Raster Preferences on page

160.

The LiDAR Preferences dialog box can be used to set the default preferences for LIDAR data,

including compression options, text parsing options, and preview options.

For more information about the options available, see LIDAR Preferences on page 173.

Access the GeoExpress toolbar to add images and mosaics to the Job List and to perform image

manipulation tasks. The tools that you can access in the toolbar vary depending on the image that

you select in the Job List.

The toolbar contains the following tools:

-15-
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Tool
Tool Icon Description
Name
i’ AddImage | Add animage to the Job List. You can add multiple images at a time.
Create an image mosaic from a set of georeferenced images. A
: Creat . . -
Ifﬂ reate mosaic is a set of images that has been joined together to form a
1 New
. Mosaic single image. When you create a mosaic in the MrSID file format, you
can create either a flat or composite mosaic.
Edit the metadata of an image. For raster and LiDAR files, you can
i I! Edit change the projection information stored in the metadata. For raster
= Metadata | images, you can also include custom information in the image. For
example, you can add your company name to the image.
@ Remove speckling from MrSID and JPEG 2000 images. Raster
Despeckle
images only.
? Image ] )
c Crop an image. Raster images only.
t rop
Specify part of an image as an area of interest. You can change the
E B Area of compression ratio of the area of interest to preserve more image detail
Interest in that part of the image or to blur that part of the image. Rasterimages
only.
Edit the brightness, contrast, and gamma values for an image. You
! Color Bal-
m can also change the values for each band in an image. Raster images
ance
only.
. Change the projection used by the image. You can specify a custom
ZELaRy
\-:”’n Reproject | well known text (WKT) string or select a standard coordinate ref-

erence system. Raster images only.

The data cartridge gauge is a small graphic display in the upper right corner of the main screen

that indicates the percent of the data cartridge remaining. Hold the mouse pointer over the data

-16-
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cartridge gauge to display the exact amount of data remaining in the data cartridge.

For information on how usage is calculated, see Data Cartridges on page 217. For information on

activating cartridges, see Licensing GeoExpress on page 9. For general information about data

cartridges, see Frequently Asked Questions on page 226.

To order additional cartridges, contact your LizardTech sales representative.

NOTE: GeoExpress Unlimited Edition has no data cartridge.

The Job List is the pane on the left side of the GeoExpress user interface that displays the raster
and LiDAR files with which you want to work. The Job List enables you to add or remove images
for compression and manipulation operations, work with project files, select images to view inform-

ation about them, and run your jobs.

The job list is divided into a section for raster files and a section for LiDAR files. GeoExpress
treats each image, point cloud, and mosaic in the Job List as a discrete job. The name displayed

in the Job List is a user-specified job name that has no effect on the resulting output file.

To add images and point clouds to the Job List, click the Add Image button in the toolbar.
Alternatively, drag images into the job list from another application. To create a mosaic, click the
Create New Mosaic button. The Job List displays the tiles that you add to a mosaicin an inden-
ted list.

Select an image in the Job List to view information about the image in the Properties, Output,

and Preview tabs.

When you right-click on one or more jobs that you have selected in the Job List, the context

menu appears. The context menu, or the right-click menu, displays the following options:

Option Description

Edit> Cut Remove the selected job from the Job List. Use the Cut option with the Paste option when you
it>Cu
want to move an image or tile to another position in the Job List.

Edit>Copy [ Create a copy of the selected image or tile. Use the Paste option to specify where you want to place

-17 -
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Option Description
the copy.
Edit > Select
Al Select allthe items in the Job List.
Run Run one or more selected jobs.
Cancel Stop one or more running jobs.
Remove Remove one or more jobs that you have selected from the Job List.

Job Options | Setoptions for the input file, output file, bands and compression, zoom levels, and alpha bands.

Metadata
Edit the image metadata.
Options
Manage tiles. You can add tiles, remove tiles, crop tiles, change the order of the tiles, and seta
Tile Options
coordinate reference system for tiles.
NITF Image
Select the image segments that you want to include in the output file.
Segments
E Job Export information about the selected job and about the version of GeoExpress that you are using.
xport Jo
s The job settings are saved in a text file. Export job settings when you want to remember the options
ettings

that you selected for a particular job or when you want to contact LizardTech Customer Support.

The Properties tab displays information about the selected job. The contents of the panels on
the Properties tab depend on whether the selected job is a raster job or a LiDAR job. The con-

tents also change if you select multiple jobs, if you select a mosaic, and more.

Use the Job Options panel to specify an output file format, destination, and compression ratio.
The More Options button displays additional options. You can set options for multiple selected
jobs, in which case options that do not apply to the entire selection are not available. For raster

jobs, the panel also displays the output file size and estimated memory usage.
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NOTE: For raster jobs, the estimated memory usage only displays when you select
MG2, MG3, and MG4 as the Output Format. For more information on how the memory

usage is calculated, see Calculating Memory Usage on page 195.

The Image Properties panel, or the Mosaic Properties panel if you select a mosaic, displays
information about the input file or files selected in the job list. If you select multiple files, the panel

displays the information that the files have in common.
The Image Properties panel displays the following information for raster files:

o Input File Size. The size of the selected image file. If the file contains header information,
the file size can be more than the nominal size.

« Nominal Size. The calculated size of the image based on the image size and resolution.
The nominal size measures the size of the image independent of whether the image is
compressed.

o Image Width. The image width.

« Image Height. The image height.

o Coordinate Reference System. The coordinate reference system of the image.

o File Type. The file type of the image.

e Bands. The number of bands in the image. Rest the mouse pointer over the number of
bands to see the color space of the image.

o Datatype. The image data type. For example, 8 bits, unsigned.
The Image Properties panel displays the following information for LiDAR files:

¢ File Name. The name of the file.

o X. The range of X values in the point cloud.

e Y. Therange of Y values in the point cloud.

e Z. The range of Z values in the point cloud.

o File Type. The file type of the image.

e Points. The number of points in the point cloud.

o Input File Size. The size of the selected point cloud file. If the file contains header inform-

ation, the file size can be more than the nominal size.
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o Nominal Size. The calculated size of the file based on the number of points and the num-
ber of fields for each point. The nominal size measures the size of the point cloud file inde-

pendent of whether the file is compressed.
The Mosaic Properties panel displays the following information for raster files:

¢ Mosaic Width. The total width of the mosaic.

o Mosaic Height. The total height of the mosaic.

o Mosaic Image Size. The calculated size of the mosaic.

¢ Coordinate Reference System. The coordinate reference system of the mosaic.

o File Type. The file type of the image.

e Bands. The number of bands in the mosaic. Rest the mouse pointer over the number of
bands to see the color space of the mosaic.

o Data type. The image data type. For example, 8 bits, unsigned.

For LiDAR files, the Mosaic Properties panel displays the same information as the Image Prop-
erties panel above except for all the files in the mosaic. To view information about a single file in

the mosaic, select the file in the job list to display the Tile Properties panel.

For raster images, the Extents panel indicates where the image resides in geographic space and

the pixel resolution of the image.

For raster mosaics, the Extents panel includes mosaic extents and tile extents. Mosaic extents
indicate the boundaries and resolution of the entire selected mosaic, while tile extents indicate

the extents of a single mosaic tile.

When you click More Options in the Properties tab, the Job Options dialog box appears. The
Job Options dialog box displays the most common options for a job. The contents of the Job

Options dialog box vary depending on whether the selected job is a raster job or LiDAR job.
For raster jobs, the Job Options dialog box displays the following tabs:

o Destination

e Format and Compression
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o Dimensions and Resolution

o Tiling

For LiDAR jobs where you select MrSID Generation 4 (MG4) as the output format, the Job
Options dialog box displays the following tabs:

o Compression

e Text Parsing

NOTE: If you select an output format other than MG4, the More Options button is

unavailable.

You can preview raster images and LiDAR point clouds. For raster images, you can preview
images to see the expected output of a compression or manipulation operation. To cancel the ren-

dering of a preview image, click on the Properties or Output tab.

The following figure shows the Preview tab:
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Properties I Output ~ Preview I
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Gray:
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X and Y coordinates for the position of the cursor are given below the image pane.

For more information on how to preview an image or mosaic, see Previewing an Image on page

34 and Previewing a Mosaic on page 153.

Previewing Raster Images

The Preview tab includes a toolbar that you can use to navigate the preview image. For raster
images, you can move the slider in the toolbar to change the scale of the preview image. If you
set the scale to 1:1, you can click the check box labeled Preview output image with target
encoding options at 1:1. When you select the check box, GeoExpress runs the image com-
pression or manipulation operations on the visible portion of the image.

[
For multispectral imagery, click the Band selector button === in the toolbar of the Preview tab

to manually select the bands that you want to preview. You can select Default View, RGB, or

Grayscale. The Default View uses the first three bands of the multispectral image as the RGB
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bands. To manually select the RGB bands that you want to use, select the RGB option. Click

Grayscale to view a single band of the source image as a grayscale image.

NOTE: The Band Selector only affects the image preview. To change the RGB bands
used in the encoding process, click Advanced in the Properties tab. Then, select the

RGB bands that you want to use in the Bands tab.

LiDAR point clouds are displayed in 3-D. Click the Orbit focal point button o to rotate the

image. Click the Refresh points button L- to clear the preview pane and render the points in
the current view again. To render your points quickly, GeoExpress draws a representative sample

of your points rather than drawing every single point. If you pan or zoom in, you may want to
refresh points to draw more points in the area that you are viewing. To increase or decrease the

default number of points that GeoExpress draws, see Viewing Preferences on page 176.

If the color gradient for the LiDAR point cloud does not display properly, you may also want to
(B
adjust the gradient range for the point cloud. Click the Previewer settings button === to adjust

the gradient range. For example, if the point cloud displays as a single color rather than a gradient
range of multiple colors, it's likely that one or more points in the point cloud has an incorrect Z
value. In this case, you may want to adjust the minimum or maximum Z value used for the gradi-

ent.

NOTE: To preview a LIDAR point cloud stored as a text file, ensure that you select the

option to Read the whole file when the Text Parsing dialog appears.

The Output tab shows the session log and the progress of running jobs. Use the Output tab to

monitor the progress of running jobs, cancel running jobs, and export the session log.

For more information about log files and for a sample log file entry, see Viewing and Using Log

Information on page 177.
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Click the Run button to run one or more jobs. The jobs that you run depend on which jobs you

have selected in the Job List. If no jobs are selected, then the Run button runs all jobs.

For more information on running jobs, see Running Jobs on page 35.

The status bar in the lower-left corner displays a message when GeoExpress renders an image

preview. Use the status bar to check that your image preview is being generated.
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This chapter describes the process for most compression and manipulation operations in GeoEx-

press.
To perform compression and manipulation operations, complete the following tasks:

1. Addimages, LiDAR point clouds, or mosaics to the Job List. The images, point clouds,
and mosaics that you want to compress or manipulate in GeoExpress are called jobs.
Select the jobs that you want to manipulate or compress.

Select an output format.

Select an output destination.

Specify how much you want to compress the job.

I e

Optionally, forimages and mosaics, perform image manipulation operations. For
example, you might despeckle or reproject an image.

7. Optionally, set job options to specify additional options. For example, for raster images,
you might change the resolution or create image tiles.

8. Optionally, preview the image or point cloud before running the job.
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9. Optionally, for rasterimages, create a test image.
10. Run the job.

Before you can compress or manipulate images and point clouds, you must add them to the Job
List. When you add a raster or LIDAR mosaic to the Job List, you can show or hide the tiles that
make up the mosaic. To show or hide the tiles in a mosaic, click the arrow next to the name of a

mosaic.

“ £
1. Click the Add Image button > or the Create New Mosaic button i in the toolbar.

2. Browse files and select one or more images or point clouds that you want to add to the
Job List. To select multiple images, hold down the CTRL key and click on each image or
point cloud that you want to add.

3. Click Open.

NOTE: If you add a LIDAR text file to the Job List you must set text parsing options so
that GeoExpress can match the columns in the text file to standard fields. For more

information, see LIDAR Text Parsing Options on page 95.

TIP: You can also drag images and point clouds into the Job List from your system'’s
file manager. Alternatively, click File > Add image(s).

To add an image that you opened recently, click File > Recent files.

The following table describes the file formats of the images that you can add to the Job List:

File Supported Supports
File Format Notes

Extension Data Types Multispectral
Varies.
Most com-

CADRG mon file 8-bit unsigned No
extension is
.toc.

DTED .dto, .dt1, 16-bit signed, No, limited to
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File Supported Supports
File Format Notes
Extension Data Types Multispectral
32-bit floating
.dt2 one band
point
Earth Resource Mapping's Enhanced
ECW .ecw 8-bit unsigned Yes
Compression Wavelet format.
8-bit and 16-bit
GeoExpress supports color lookup tables
signed and
ERDAS IMAGINE | .img Yes (CLUTSs) with 8-bit per sample RGB color
unsigned, 32-bit
values.
floating point
In4-band LAN images, the 2nd, 3rd, and
ERDAS LAN lan 8-bit unsigned Yes 4th bands are interpreted asred, green,
and blue, respectively.
No, limited to
JPEG .jpg, .jpeg 8-bit unsigned Requires a world file for georeferencing.
three bands
8-bit and 16-bit
Multiple bands supported for all color
JPEG 2000 P2, .jpc signed and Yes
spaces.
unsigned
Thisis a binary, uncompressed LIDAR
point cloud format. GeoExpress supports
LAS las N/A
LAS versions 1.0 through 1.3, with exper-
imental support for LAS 1.4.
Thisis a binary, compressed LiDAR point
LAZ laz N/A
cloud format.
8-bit and 16-bit
MrSID Generation 4 bands are supported for CMYK input
.sid unsigned, 32-bit | No
2 (MG2) only.
floating point
MrSID Generation d 8-bit and 16-bit N 4 bands are supported for CMYK input
.si o
3(MG3) unsigned only.
MrSID Generation ) Thisis a binary, uncompressed LIDAR
.sid N/A
4 (MG4) LIDAR point cloud format.
MrSID Generation d 8-bitand 16-bit | Yes,upto255 | Multiple bands supported for all color
.Si

4 (MG4) Raster

signed and

bands

spaces.
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File Supported Supports
File Format Notes
Extension Data Types Multispectral
unsigned, 32-bit
floating point
8- and 16-bit
Only supports uncompressed, JPEG
NITF 2.0,2.1. .ntf signed and Yes
compressed, and JP2 compressed data.
unsigned
8-bit and 16-bit
PNG .png No Requires a world file for georeferencing.
unsigned
Raw (uncom- 8-bit and 16-bit
pressed) BBB files | .bil, .bip, signed and v
es
—-BIL, BIP,and .bsq unsigned, 32-bit
BSQ floating point
Sun Raster .ras, .rast 8-bit unsigned No
Varies.
Most com- Also known as ASClI files. These are
Text mon file N/A plain-text files with delimiters for point
extension is clouds.
txt.
8-bit and 16-bit For more information on supported
signed and TIFF compression formats, see Sup-
TIFF/GeoTIFF tif, tiff, .tfw Yes -
unsigned, 32-bit ported TIFF Compression Typeson
floating point page 206.
.nes, .ses, Both the old and new USGS DOQ
usGS DOQ .nws, .sws, | 8-bitunsigned No formats are supported and can be com-
.dog bined in mosaics.
Requires a world file for georeferencing.
Windows BMP .bmp 8-bit unsigned No
Only supported for Windows platforms.

o Password-protected MrSID files cannot be used as input files.

o While GeoExpress encodes indexed color images, it is strongly recommended that you

scan data into 8-bit grayscale or 24-bit color before encoding. In this case, 24-bit color

refers to the number of bits for a pixel value in a three-band image.
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o World files are supported for all image formats.

e The LAS, LAZ, MG4 LiDAR, and Text file formats are for LiDAR point clouds only.

o GeoExpress does not support LIDAR waveform data.

o GeoExpress has experimental support for LAS 1.4 files. For LAS 1.4 files, extended vari-
able length records (EVLR) and well known text (WKT) definitions are known not to be sup-

ported.

When you compress floating point images, GeoExpress uses the quantization compression

method. For more information on floating point images, see Using Quantization for Floating

Point on page 43.

IMPORTANT: An option is available to allow world files to override native geor-
eferencing. Note that this will override any coordinate reference system (CRS)
metadata — including well-known text strings (WKTs) — that may have been embedded
in the file. In this situation you can manually edit the image's CRS on the Reprojection
Manager accessible by choosing Reproject from the Tools menu. For more information,

see World Files on page 182.

To remove a job from the Job List, right-click on the job name and click Remove. Alternatively,

select the job that you want to remove and press the Delete key.

When you remove a mosaic job from the Job List, you also remove all the tiles associated with

the mosaic.

NOTE: You do not need to remove an image or mosaic from the Job List to keep it from
being encoded. Only the files that you select in the Job List are encoded when the Run

button is clicked.

Select a job in the Job List to view information about the job, set job options, and run the job.

To select a job, click on the name of the job. To select multiple jobs, hold the CTRL key while you
click on the names of the jobs that you want to select. To select multiple consecutive jobs, hold

the SHIFT key and click on the names of the first and last images that you want to select. For
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example, you have six jobs in the Job List and you want to select the second, third, and fourth
jobs. Hold the SHIFT key, then click on the second job and the fourth job. The three jobs are selec-
ted.

To select all the jobs in the Job List, right-click anywhere in the Job List and click Edit > Select
All. Alternatively, use the CTRL+A keyboard shortcut.

When you compress an image or point cloud, the default output format is MrSID Generation 4.

You can change the output format in the Properties tab.

1. Select one or more jobs in the Job List.
2. Click Properties to view the Properties tab.

3. Inthe Job Options panel, select an output format from the Output Format drop-down.

NOTE: Some output formats may not be available depending on certain properties of

your input image, such as the data type and number of bands.

Many of the options available to you in GeoExpress vary depending on the output format that you
select. Additionally, the options available depend on whether the file is a raster file or a LiDAR

point cloud file.
GeoExpress supports the following output formats:

o MrSID Generation 4 (MG4)
e MrSID Generation 3 (MG3)
e MrSID Generation 2 (MG2)
e JPEG 2000 (Part 1)

o JPEG 2000 (GMLJP2)

e NITF 2.1* (Raw)

e NITF 2.1* (JPEG 2000)

e GeoTIFF

e LAS

o LAZ
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The MrSID format is a proprietary format developed by LizardTech that supports lossy and
lossless compression. There are several generations of the MrSID file format. Additionally, for the
latest generation, MrSID Generation 4 (MG4), there is a version that supports raster and a version

that supports LiDAR.

The raster version of MG4 supports multispectral data, per-band compression, custom metadata,
and advanced image manipulation features. The format is widely supported across GIS software
packages. The LiDAR version of MG4 stores compressed point clouds in an accessible format

meant to address some of the problems with storing and accessing large LiDAR point clouds.

For both raster and LiDAR data, if you're not sure which file format to select, you may want to

select MrSID Generation 4.

The JPEG 2000 format is an open standard that provides superior compression compared to the
original JPEG format.The JPEG 2000 (Part |) format uses the original JPEG 2000 specification
which is more widely supported. The JPEG 2000 (GMLJP2) format includes support for geo-
graphic markup language (GML). Use the JPEG 2000 (GMLJP2) format when you need to create
JPEG 2000 files that contain coordinate reference systems (CRS), topology, and other geo-

graphic features.

For a comparison of MrSID and JPEG 2000 files, see Comparison of Compressed Output

Formats on page 39.

The NITF format is a container that can include an image, image metadata, and other graphics.
GeoExpress supports creating NITF files that contain raw or JPEG 2000 images.The NITF format
is the standard for various departments of the United States government. Use the NITF format

when your organization requires NITF metadata.

The GeoTIFF format embeds georeferencing metadata into TIFF images. In GeoExpress, you
can only create GeoTIFF files from MrSID input files, and you can only create uncompressed

GeoTIFF files. Use the GeoTIFF format when you might need to view your image in an image
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viewer that does not support GIS. Any image viewer that can read TIFF files will display
GeoTIFF images. If the viewer does not support the georeferencing metadata, the metadata is

ignored. GeoTIFF is generally an uncompressed file format.

The LAS format is one of the most commonly used LiDAR file formats, and can be read in vir-
tually any application that support LiDAR point clouds. LAS is a public, uncompressed file format
maintained by the American Society for Photogrammetry and Remote Sensing (ASPRS). GeoEx-

press can write LAS 1.0 through 1.3 files.

When you create a LAS file from another LAS file, GeoExpress uses the same version of LAS.
For example, if the input file is a LAS 1.1 file, GeoExpress creates another LAS 1.1 file. If you
write a LAS file from MrSID or from another format, the version of LAS that GeoExpress uses
depends on the contents of the file. If the file contains features unique to a specific version of

LAS, GeoExpress uses that particular version.

The LAZ format is a compressed format for LIDAR point clouds. LAZ is an open-source file format

developed by Martin Isenberg at RapidLasso.

Select an output destination to specify where you want to save the output file. By default, the out-

put destination is the same directory where the input image is stored.

For more information about the output destination, and to select an Express Server as the output

destination, see Destination Options on page 91.

The images and point clouds that you create with GeoExpress are compressed by default. To spe-
cify how much you want to compress each raster image, you can specify a compression ratio, spe-
cify a target file size, use lossless compression, set per-band compression ratios, or use
quantization. For LiDAR point clouds, you can specify a compression ratio or select lossless com-

pression.
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Use lossless compression for an image or point cloud to compress the data as much as possible
without changing the image or point cloud. To use lossless compression, click the Properties tab

and select the Lossless radio button.

Specify a compression ratio for an image or point cloud to specify how much smaller you want the
output to be than the input. For example, if you have an uncompressed 100 megabyte image and
you specify a compression ratio of 20:1, the file size of the output image is 5 megabytes. To set a
compression ratio for a selected image, click the Properties tab and select the radio button next

to the blank compression ratio field. Then, enter the compression ratio that you want to use.

When you compress floating point images, GeoExpress uses the quantization compression

method. For more information, see Using Quantization for Floating Point on page 43.

For more information on compression, see Compression on page 39. For more information on

setting default compression preferences, see Preferences on page 159.

For raster images and mosaics, you can use the tools in the Toolbar to perform the following

image manipulation operations:

o Edit metadata for an image.

e Despeckle animage.

e Crop animage.

¢ Select an area of interest.

e Set color balancing for an image.

¢ Reproject animage.

NOTE: You can also edit the coordinate reference system metadata of LiIDAR point

clouds.

For more information on each image manipulation operation, see Image Manipulation on page

45.

To set job options, click More Options in the Properties tab. The job options that you see

depend on whether the job is for a raster file or a LiDAR file and on the output format that you
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select.

For rasterimages, you can use job options to select tiling options, enter a custom resolution or set
of dimensions, and more. For LiDAR point clouds, you can use job options to remove LAS vari-

able length record (VLR) metadata, set column mapping options for text files, and more.

For more information, see Job Options Overview on page 91.

NOTE: For rasterimages, you can also click Advanced to set additional options. For
example, you can use the advanced options to select a color space, edit transparency

values, and more. For more information on advanced job options, see Advanced Job

Options on page 97.

You can preview raster images and LiDAR point clouds.Preview images to see the expected out-
put of a compression or manipulation operation. When you preview an image, you do not use data

from the data cartridge.

1. Select the job in the Job List.
2. Click the Preview tab.

The preview renders in the Preview tab.

3. Optionally, for rasterimages, move the slider above the preview image to change the
—
scale of the image or click the Band Selector button m== to manually select the bands

that you want to view.

For more information on the Preview tab and the Band Selector, see Preview Tab on page 21.

For raster images, you can create test images to test an image manipulation or compression oper-
ation without using data from the data cartridge. Test images are output images that have a vis-

ible watermark. You can create images and mosaics as test images, but not LiDAR point clouds.
1. Select one or more jobs in the Job List.

2. Click Advanced in the Properties tab.
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The Advanced Job Options dialog box appears.

Click the Output tab.
Select the Encode As Test Image check box and click OK.
Click the Run button to run the job.

The following figure shows a test image:

Running Jobs

When you run a job, GeoExpress performs the compression and manipulation operations that you
selected. To run one or more jobs, select the jobs that you want to run and click the Run Selec-
ted Jobs button. To run all jobs, click a blank space in the Job List to ensure that no jobs are
selected and click the Run All Jobs button.

When you run one or more jobs, GeoExpress displays the Output tab. Use the Output tab to mon-
itor the progress of the operation. To cancel one or more running jobs, click the Cancel job but-

ton or the Cancel all button in the Output tab.

If you click away from the Output tab, GeoExpress continues running the jobs in the background.
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TIP: GeoExpress adds information about each job that you run to the GeoExpress log

file. For more information on logs, see Viewing and Using Log Information on page 177.

Export job settings when you want to save information about a particular job. The job settings are

saved to a text file and include the following information:

o GeoExpress version number.
o Job properties from the Properties tab.

e Job options.

To export job settings, right-click on the name of a job in the Job List and click Export Job Set-

tings.

To save the state of the Job List, create a project file. The project file is a text file that saves

each job in the Job List and any options that you have applied to each job.

The project file saves the file path of each image, mosaic tile, and LiDAR point cloud in the Job

List. If you move an files to another directory, you can edit the project file in a text editor.

To open an existing project, click File > Open project in the menu bar. Saving an edited project

overwrites the original.

NOTE: In GeoExpress version 8.5 and earlier, the Job List contained multiple tabs. If
you open a project file that was created in any of these versions, GeoExpress 9 displays

all the jobs together in the simplified Job List.

To create a new project, click File > New project in the menu bar. When you create the new pro-
ject, you clear the Job List. If there are items in the Job List that have not been saved, GeoEx-

press prompts you to save the jobs in a project file.
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To save a project, click File > Save project.
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Compress your images and point clouds to decrease the size of the files. GeoExpress com-

presses your images and point clouds by default.

When you compress raster images with GeoExpress, you can specify a compression ratio, specify
a target file size, use lossless compression, or use quantization for floating point images. If you
decide to specify a compression ratio for a raster image, you can specify a separate compression
ratio for each band in an image. When you compress LiDAR point clouds with GeoExpress, you

can specify a compression ratio or use lossless compression.

If you specify a compression ratio or a target file size, GeoExpress uses lossy compression. When
you use lossy compression, you compress an image to a much smaller file size by discarding
some image data or removing points from a point cloud. Additionally, when you compress a float-
ing point image, GeoExpress uses a lossy compression method called quantization to compress

the image.

When you use lossless compression, you compress an image as much as possible without dis-

carding any image data.

For raster images, GeoExpress can create compressed images in the MrSID and JPEG 2000
formats. Because the NITF format can contain JPEG 2000 files, you can also create compressed
NITF files. For LiDAR data, GeoExpress can create compressed files in the MrSID and LAZ
formats. For LiDAR data, LAZ files can only be created using lossless compression. MrSID files

are lossless by default, but you can also specify a compression ratio to create lossy files.
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TIP: Select an image in the job list to view the file format, output file size, and more in

the Properties tab.

The following table compares some of the features supported by the raster output formats:

Feature Output Format
MG2 | MG3 | MG4 | JPEG 2000

Lossy output with maximum of 3 bands, cropping but no advanced encoding,
output lessthan 2 GB ¢ * * *
Advanced encoding (reprojection, color balancing, despeckling, area of
interest encoding, etc.) * * *
Output file size greater than 2 GB . . .
Lossless output . . .
Mosaic that has MrSID tiles as input . . .
Multispectral output . .
Arbitrary band mapping .
Per-band compression .

The following table compares some of the features supported by the LiDAR output formats:

Feature Output Format
LAZ MG4
Lossless compression . .
Specifying a compression ratio *
Creating mosaics *

For more information on output formats, see Supported Output Formats on page 30.
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Specify a compression ratio for an image to specify how much smaller you want an image to be

than the input image. For example, if you have a 100 megabyte image and you specify a com-

pression ratio of 20:1, the file size of the output image is 5 megabytes.

4.

£
Click the Add Image icon & to add an image to the Job List.
Select the image in the Job List.

In the Properties tab, select the radio button next to the blank compression ratio field.
Then, enter the compression ratio that you want to use.

Enter the ratio that you want to use in the text field.

As a rule of thumb, you can compress raster images to a ratio of 20:1 without introducing notice-

able compression artifacts. Compression artifacts include blurring and speckling. By default, the

compression ratio for RGB images is 20:1 and the compression ratio for grayscale images is 10:1.

For multispectral images and LiDAR point clouds, GeoExpress uses lossless compression by
default.

You can set individual compression ratios for each band in a multispectral image. Use per-band

compression when you want to compress certain bands in an image more than others. For

example, if you want to preserve the visual quality of a multispectral image, you can compress the

RGB bands of the image less than the other bands. You can only set per-band compression ratios

for MrSID Generation 4 output images.

£
Click the Add Image icon & to add an image to the Job List.
Select the image in the Job List.

In the Properties tab, select MrSID Generation 4 from the Output Format drop-down.
In the Properties tab, click More Options.

On the Compression tab, select the Per Band radio button.

Click Select Bands.

Select one or more bands from the list and enter a compression ratio in the Compression
Ratio text field. Alternatively, select the Lossless check box for the selected bands.

Click Apply to Selected to set the compression ratio for the selected bands.

Click OK.
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For multispectral images, you can select the RGB Color Transform option to set the first three
bands of an image as the RGB bands. When you set the first three bands of the image as the
RGB bands, GeoExpress optimizes the image compression ratio of each one of the RGB bands
to create a smaller image without sacrificing visual quality. If you select the Lossless option,

GeoExpress does not optimize the compression ratio of the RGB bands.

If the first three bands of the image are not the RGB bands, change the order of the bands before

you apply the RGB color transform.

By default, GeoExpress matches the colorspace of the output image to the colorspace of the
input image. When you change the compression method of an image to per-band compression,

GeoExpress does not apply the RGB color transform by default.

Specify a target file size for a raster image to create an output image whose file size equals the
target file size. You can specify a target file size for MrSID Generation 3 and Generation 4

images.

[
Click the Add Image icon L+ 4 to add an image to the Job List.
Select the image in the Job List.

In the Properties tab, select Target File Size in the Compression Method drop-down.

> w2

Enter the target file size in megabytes in the text field.

Use lossless compression to compress an image or point cloud as much as possible without dis-
carding any data. You can use lossless compression to create MrSID Generation 3,
MrSID Generation 4, JPEG 2000, and LAZ images.

Lossless compression typically yields a 2:1 compression ratio which yields a 50% reduction in the
file size. Use lossless compression when you need the compressed file to be identical to the ori-

ginal file.

‘
1. Click the Add Image icon > to add an image or point cloud to the Job List.
2. Select the image or point cloud in the Job List.

-42-



Chapter 5: Compression

3. Inthe Properties tab, select the Lossless radio button.

NOTE: If you compress an image that has already been compressed, you can select
the Lossless radio button to ensure that GeoExpress does not discard any additional
data.

When you compress a floating point image, GeoExpress uses quantization to compress the

image. You can create 32-bit floating point images in the MrSID Generation 4 format.

Quantization is a lossy compression method that reduces the number of pixel values in the image.

Quantization is necessary for floating point images for two reasons:

o Performing arithmetic on floating point values results in rounding discrepancies.
o Compressing floating point values results in unnecessarily large images. This is because
some of the digits in each pixel value contain data that is not significant and cannot be

compressed.

As a result, GeoExpress uses a lossy compression method for floating point images, but guar-

antees the accuracy of the image data to an optimized precision value.

To compress a floating point image with the quantization compression method, complete the fol-

lowing steps:

[
Click the Add Image icon P to add a floating point image to the Job List.
2. Select theimage in the Job List.

—_

3. Inthe Properties tab, click More Options.
4. Select MrSID Generation 4 as the output format.

GeoExpress selects the Quantization compression method automatically for floating

point images.

5. Optionally, click the Set Quantization button to configure quantization precision and

other quantization options.

For more information on quantization options, see Quantization Options on page 116.
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All manipulation operations are for raster images only with the exception of editing metadata. Use
the toolbar to perform image manipulation operations. You can perform the following image

manipulation operations:

o Edit metadata for an image. Edit the metadata of a raster image to include custom inform-
ation in the image. Edit the metadata of a LiDAR point cloud to edit the coordinate ref-
erence system information. You can edit the metadata of MrSID and JPEG 2000 files.

o Despeckle an image. Remove speckling from MrSID and JPEG 2000 images.

o Crop animage. Select the area of an image that you want to keep and discard the other
areas.

o Select an area of interest for an image. Specify part of an image as an area of interest.
You can change the compression ratio of the area of interest to preserve more image
detail in that part of the image or to blur that part of the image.

¢ Adjust the color balance for an image. Edit the brightness, contrast, and gamma values for
an image. You can also change the values for each band in an image.

¢ Reproject an image. Change the projection used by the image. You can specify a custom

well known text (WKT) string or select a standard coordinate reference system.

Image manipulation operations only take effect after you run the job for the image.
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Use the Edit Metadata tool to edit the metadata of images and LiDAR point clouds. You can also

use the tool to view the existing metadata of rasterimages.

For raster images, the following list describes the types of metadata that you can edit in GeoEx-

press:

o User. Custom metadata fields that you can use to store comments, information about
your organization, and any other information that you find useful. You can edit user

metadata for any image.

« Image. Metadata fields that describe the image, including the image location, resolution,
and other metadata. You can edit image metadata for images with the MrSID and

JPEG 2000 output formats.

o NITF. Metadata fields that describe the image file header, subheader, and security fields.

You can edit NITF metadata for images with the NITF output format.

For LiDAR point clouds, you can only edit coordinate reference system metadata.

The types of metadata that you can edit depend on the output format that you select for an

image.
1. Select one or more jobs in the Job List.
2 Click the Edit Metadata button B the toolbar.
The Metadata Manager appears.
3. To edit user metadata, ensure that the User tab of the Metadata Manager is selected.

o Add user tags by clicking Add User Tag, then entering a name and value for the
tag. Alternatively, select an existing tag name from the drop-down.

o Edit the values of existing tags by clicking the value field and entering another

value.

NOTE: Tag names cannot contain spaces, and tag values cannot be empty.

Existing tags can be deleted but cannot be renamed.
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4. To edit image metadata, click the Image tab of the Metadata Manager.

« Save the image's coordinate reference system in the metadata by clicking Select a
Coordinate Reference System or entering a custom well known text (WKT)
string in the WKT text field.

For more information on selecting a coordinate reference system, see Selecting a

Coordinate Reference System on page 86.

o Edit the image origin, image resolution, and dynamic range.

NOTE: Selecting a coordinate reference system in the Metadata Manager does

not reproject the image.

5. To edit NITF metadata, click the NITF Options tab in the Metadata Manager.
« Edit the file header and file security fields in the File Header subtab.
o Edit the image subheader, image comments, and image security fields in the
Image Subheader subtab.
6. Click OK.

NOTE: Some existing JPEG 2000 images are encoded in such a way that certain
decoders may fail to display them if you edit their metadata. To accommodate these
images, GeoExpress handles several JPEG 2000 parameters in a special way. If you
are editing the metadata of existing images and wish to change parameters for tile
length markers, packet length markers, or tile parts, you must change them on the

JPEG 2000 tab of the Preferences dialog. (For more information see JPEG 2000 Prefer-

ence Options on page 171 and Advanced JPEG 2000 Options on page 133.)

For LiDAR point clouds, you can edit the coordinate reference system (CRS) stored in the file

metadata.

1. Select one or more jobs in the Job List.

2 Click the Edit Metadata button in the toolbar.

The LiDAR Metadata dialog appears.

3. Begin typing the name of a CRS or an EPSG code in the Coordinate Reference
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System field.
A list of catching coordinate reference systems appears.

4. Select the CRS from the list.
5. Alternatively, select the Use custom WKT check box and paste a well known text (WKT)

string into the text box.
6. Click OK.

For raster images you can view existing metadata.
1. Selectajobinthe Job List.
2 Click the Edit Metadata button B the toolbar.
The Metadata Manager appears.
3. Clickthe Viewer tab.
The image metadata appears.

4. If an image has geographic markup language (GML) embedded in the metadata, select
the GML option to view the GML.
5. Click OK.

NOTE: To view sample metadata, see Sample MrSID Metadata on page 207.

LizardTech user metadata is merely descriptive and has nothing to do with the image pixel data.
There are 12 default user metadata tags. They can be thought of as addenda or footnotes and
include such data as geographic location, company name, and scan info. You can include data for
any or all or none of the tags, and you can add your own custom user metadata tags for other

information you would like to include. All of LizardTech's user metadata tags can be edited.

LizardTech image metadata is information about the pixel values that tells viewing software how

to interpret or treat each pixel. There are many image metadata tags, and a small subset of these
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are available for editing.

Editing the image tags does not affect the pixel values themselves. For example, changing
WKT metadata does not reproject an image from one CRS to another. However, changing

metadata may affect how an image is displayed in a viewer.

You can assign a WKT to the image that identifies its coordinate reference system. This is useful
when you know the CRS of an image but that data isn't captured anywhere in the file. It's also use-

ful if the WKT is incorrect and you need to correct it.

IMPORTANT: Setting the WKT in the metadata of an image does NOT reproject the
image. It only identifies where the image already is. To reproject an image to a new
CRS, use the reprojection tools. Additionally, carelessly changing the WKT of an image
may make the image inaccurate or unusable in any GIS applications that rely on this

information.

These X and Y fields can be used to set the x, y location of the image.

These X and Y fields can be used to set the x and y resolutions of the image.

To improve the appearance of MrSID images in other GIS programs, you can use GeoExpress to

write dynamic range metadata for images.

NOTE: If you select MrSID Generation 4 as the image output format, dynamic range val-
ues are calculated automatically for all images except for eight bit images. If you want to
enter the dynamic range values manually for those images, change the method for gen-
erating the dynamic range to None in the Format-Specific tab of the Advanced Job
Options dialog. For more information on calculating the dynamic range, see Dynamic

Range Metadata Generation on page 125.
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The dynamic range metadata is particularly useful for images that only use a small portion of their
datatype bandwidth. For example, 11-bit images are often stored as 16-bit images, where the
upper five bits are left empty. The only bits that are meaningful are the first eleven. The full
dynamic range of pixel values in an unsigned 16-bit image runs from 0 to 65535. The first eleven
bits fall between 0 and 2047, which is only 3% of the full range! When you look at the histogram of

this image (for information on histograms see The Color Balance Tool on page 79), all of the val-

ues will be gathered into the far left side, causing the image to appear black when it's scaled to dis-
play on a computer monitor. For an 11-bit image, the minimum value would be 0 and the

maximum value would be 2047 (211 - 1).

An alternate way to think of dynamic range is "window and level." The window is the width of data
that's important and the level is where the midpoint of the window lies within the entire range. For
our 11-bit image, the window, or width, is 2048 (211), and the level, or midpoint, is 1023.5 (21 -1
)/ 2). The window and level are displayed next to the Min and Max fields to aid you in setting the

dynamic range.

To set the dynamic range of the image, type the minimum pixel value in the Min field and the max-

imum pixel value in the Max field.

IMPORTANT: Setting the dynamic range does not change the pixel data of the image. It
only gives clues as to how the image should be displayed. Some applications may
honor this value and some may ignore it, depending on how the pixels need to be rep-
resented for a given workflow. Additionally, setting the dynamic range is not the same
as color balancing. Color balancing changes the actual pixel values, which changes the

nature of the image. (For more information see Performing Color Balancing for a Mosaic

on page 151.)

In addition to the image metadata that you can edit, GeoExpress embeds encoded MrSID and
JPEG 2000 images with a header to preserve metadata from source images. This header is able
to carry information on image location, projection, date produced, and RGB color lookup tables
(CLUT) for indexed color images. Each tag is accompanied by a short description of the method
used to write out the data, either ASCII, signed or unsigned 8-bit, signed or unsigned 16- or 32-bit

integers, or single or double-precision floating point.
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Certain input image types such as NITF, GeoTIFF, ERDAS IMAGINE and USGS DOQ may
have additional metadata tags. Such tags are carried over from the source image as-is to the out-
put file in addition to the standard LizardTech metadata tags. If the image being encoded is a
mosaic, GeoExpress preserves the metadata values from the first image in the mosaic. If no
information is available for a specific tag, the tag is left out of the header. Some tags apply to any
MrSID or JPEG 2000 image, with or without georeferencing information; other tags apply spe-

cifically to georeferenced images.

NOTE: When encoding GeoTIFF imagery, all the native GeoTIFF metadata tags are pre-

pended with the string "GEOTIFF CHAR: :".

In addition there are special tags that contain statistical information about the pixel intensities in
an encoded image. These tags contain the minimum, maximum, mean, and standard deviation
of the pixel values in the image. For a grayscale image, single values are output. For an RGB
image, values are output in an array where the first value represents the red band, the second

band represents the green band, and the third band represents the blue band.

Both the mrsidgeoinfo command line tool and ExpressView Browser Plug-in can display

metadata tags. Both tools are included on the GeoExpress DVD.

The tags written into MrSID and JPEG 2000 metadata are listed below. If an image or mosaic is
cropped while being encoded, the values apply to the cropped output image unless noted oth-

erwise. There is no predetermined order for the tags.

Tag Description Notes

Number of bits per sample

IMAGE::BITS_PER_SAMPLE
(uint16)

Values: 0 for RGB, 3 for gray-
Colorspace ofimage
IMAGE::COLOR_SCHEME scale, 2 for CMYK, 10 for
(uint32)
multispectral

Values: 0 for unsigned 8-bit
Datatype of samplesin
IMAGE::DATA_TYPE int, 1 for 32-bit float, 2 for
image (uint32)
unsigned 16-bit int
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Tag

Description

Notes

IMAGE::

DEFAULT_DATA_VALUE

Sample values for back-

ground pixel

Stored as an array of values,
one for each band, in order.
The values are stored in the

datatype of the samples

NOTE: With older images
containing uint8 data, the tag

IMAGE: :NO DATA VALUE

may be used

IMAGE::

DYNAMIC_RANGE_WINDOW

Custom contrast setting

(double)

Represents the size of the

range of the data

IMAGE

:DYNAMIC_RANGE_LEVEL

Custom brightness setting

(double)

Represents the midpoint of

the range of the data

IMAGE::EOM End of metadata

Height of the image, in
IMAGE::HEIGHT

pixels (uint32)

Size of the inputimage or
IMAGE::INPUT_FILE_SIZE

mosaic in bytes (double)

IMAGE::

INPUT_FORMAT

Name of inputimage type

(string)

Stored as an array of 256*3

values, one value for each

VALUE

data" pixel

IMAGE::INPUT_LUT Color lookup table
band (R,G,B) for each of the
256 entries in the table
Filename of the input
IMAGE::INPUT_NAME
image (string)
Used only by older MrSID
Sample values for back- images; see
IMAGE::NO_DATA_VALUE
ground pixel IMAGE::DEFAULT_DATA _
VALUE
IMAGE::SOM Start of metadata
IMAGE:: TRANSPARENT_DATA _ Sample values for the "no | Stored asan array of values,

one for each band, in order.
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Tag

Description

Notes

Values are stored in the data-

type of the samples

IMAGE::WIDTH

Width of the image, in
pixels (uint32)

IMAGE::X_RESOLUTION

Georeferencing pixel res-
olution in x-direction

(double)

IMAGE::XY_ORIGIN

Georeferencing (x,y) loc-
ation for the center of the

upper left corner pixel

Stored as an array of two

doubles

IMAGE::Y_RESOLUTION

Georeferencing pixel res-
olution in x-direction

(double)

The tags in the table below apply only to images encoded with areas of interest:

Tag

Description

Notes

IMAGE::AOl::n::REGION::VECTOROVERLAY

file, if any — (string)

Name of vector overlay

LAYER

IMAGE::AQI::n::REGION::VECTOROVERLAY_

used) — (integer)

Layer number from vec-

tor overlay file (if one is

IMAGE::AOI::n::REGION::X

Upper left X pos of

region — (integer)

IMAGE::AQOl::n::REGION::Y

Upper left Y pos of

region — (integer)

IMAGE::AQOl::n::METHOD

(string)

The AOIl method used — | Values: "shiftinner",

"shift outer", "weight"

IMAGE::AOQl::n::WEIGHT

Weight value used —
(double)
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Tag Description Notes

Magnification at which
IMAGE::AOl::n::MAGNIFICATION AOl was applied —
(double)

Optional name of AOI
IMAGE::AOl::n::NAME
region — (string)

Optional comment for
IMAGE::AOI::n::COMMENT
AOl region — (string)

Optional URL referring
IMAGE::AOQl::n::URL
to AOI region — (string)

The tags in the table below apply to MG2 images only:

Tag Description Notes

Block size used in MrSID
IMAGE::COMPRESSION_BLOCK_SIZE
encoding (uint32)

G-weight value used in

IMAGE::COMPRESSION_GAMMA
MrSID encoding (float)

Version of encoder used
IMAGE::COMPRESSION_VERSION
(array of 3 sint32 values)

Weight value used in

IMAGE::COMPRESSION_WEIGHT
MRSID encoding (float)

Date and time ofimage
IMAGE::CREATION_DATE
encoding (string)

Number of zoom (res-
IMAGE::COMPRESSION_NLEV olution) levels in the image
(uint32)

The number and datatype of
Maximum sample values

IMAGE::STATISTICS:MAXIMUM for each band in the input

the values correspond to the

number of bands and
image (array of values)
sample type of the image
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Tag

Description

Notes

IMAGE::STATISTICS:MINIMUM

Maximum sample values
for each band in the input

image (array of values)

The number and datatype of
the values correspond to the
number of bands and

sample type of the image

IMAGE::STATISTICS:MEAN

Average value of all
samples for each band

(array of doubles)

IMAGE::STATISTICS:STANDARD _
DEVIATION

Standard deviation of all

samples for each band

IMAGE:: TARGET_COMPRESSION_
RATIO

Compression ratio used

for encoding (float)

For MG2, this only approx-
imates the actual com-

pression ratio achieved

The tags in the table below apply to MG4 images only:

Tag

Description

Notes

IMAGE::QUANTIZATION_SCALE

Precision value used for

quantization

For floating pointimages,
GeoExpress uses the quant-
ization compression method.
For more information on the
precision value, see Quant-

ization Precision on page 117.

When using GeoTIFF input images, the GeoTIFF metadata tags are copied directly into the
MrSID or JPEG 2000 file. When using ERDAS IMAGINE and USGS DOQ metadata, certain

other custom metadata tags are inserted as well.

You can edit the following metadata for images with the NITF output format.
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o File header

o File security fields
¢ Image subheader

¢ Image security fields

e Image comments
For more information on NITF metadata, see the NITF 2.1 specification at the following URL:

http://www.gwg.nga.mil/ntb/baseline/docs/2500¢/2500C. pdf

In addition to the NITF metadata that you can edit, GeoExpress embeds metadata from NITF
input files to preserve the source metadata. When reading a NITF file, GeoExpress stores many

NITF fields as metadata, for example as tag/value pairs in MrSID imagery.

NOTE: The following discussion assumes familiarity with the NITF specification.

In general, the tag name is of the form
NITF::xxnnn::field

where xx is a two letter code representing the NITF segment (IM forimage, FH for file header)
and nnn is the NITF segment number. TRE fields contain the prefix "TRE_". Specifically, GeoEx-

press stores input fields in metadata tags as described in the following tables.

GeoExpress stores file header fields in the following tags:

File Header Fields

NITF Field GeoExpress Tag
FHDR NITF::FH00O: : FHDR
FVER NITF::FH00O: :FVER
STYPE NITF::FH000: :STYPE
OSTAID NITF::FH000: :0OSTAID
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NITF Field GeoExpress Tag
FDT NITF::FHOOO: :FDT
FTITLE NITF::FHOO0O: :FTITLE
ONAME NITF::FHO0O: : ONAME
OPHONE NITF::FHO0O: : OPHONE
NUMI NITF::FHOO0O: : NUMI
NUMS NITF::FH00O0: :NUMS
NUML NITF::FHOOO: : NUML
NUMT NITF::FHOO0O: : NUMT
NUMDES NITF::FH00O: :NUMDES
NUMRES NITF::FH00O: :NUMRES

Of the above, GeoExpress allows the user to set the values for OSTAID, FDT, FTITLE, ONAME,
and OPHONE when encoding NITF images.

GeoExpress stores security-related fields from the file header (unless they are blanks) in the fol-

lowing tags:

Security-Related Fields

NITF Field GeoExpress Tag
SCLAS NITF::FHO0O: : SCLAS
SCLSY NITF::FHO00: :SCLSY
SCODE NITF::FHO0O: : SCODE
SCTLH NITF::FHO00: :SCTLH
SREL NITF::FH0O0O: :SREL
SDCTP NITF::FHO0O: : SDCTP
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NITF Field GeoExpress Tag
SDCDT NITF::FHO0O: :SDCDT
SDCXM NITF::FHOO0O: : SDCXM
SDG NITF::FHOO0O: :SDG
SDGDT NITF::FHO0O: : SDGDT
SCLTX NITF::FHO00: :SCLTX
SCATP NITF::FHO0O: : SCATP
SCAUT NITF::FHO0O: : SCAUT
SCRSN NITF::FHO0O: : SCRSN
SSRDT NITF::FHO0O: : SSRDT
SCTLN NITF::FHO00: :SCTLN

GeoExpress allows the user to custom set all of the above.

GeoExpress stores image segment fields in the following tags:

Image Segment Fields

NITF Field GeoExpress Tag

1ID1 NITF::IM001::IID1

IDATIM NITF::IMOO1::IDATIM
TGTID NITF::IMO0O1::TGTID

IID2 NITF::IM0O01::IID2
ISORCE NITF::IMOO1: :ISORCE
ICORDS NITF::IMOO1::ICORDS
IGEOLO NITF::IMOO1::IGEOLO
NICOM NITF::IMOO1::NICOM
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NITF Field

GeoExpress Tag

ICOM1

NITF::IM001::ICOM1

ICOM9

NITF::IM00L1::ICOM9

GeoExpress allows the user to custom set these image segment fields: II1D1, IDATIM, TGTID,

IID2, ISORCE, NICOM, ICOM1...ICOMO.

In addition, GeoExpress does the following:

¢ handles the security fields in the Image Segment as they are handled in the file header

o stores all detected TREs in metadata as binary data. For example, USEOOA data would

be stored as an array of bytes using the following tag:

NITF::IM001:: TRE_USEOQOA

o explicitly recognizes the following TREs when reading in a NITF file:

J2KLRA, USEOOA, STDIDC, PIAIMC, RPCO0A/B

For these TRESs, additional metadata entries are created corresponding to each of their

constituent fields. For example, PIAIMC data is represented as follows:

NITF::IM001:: TRE_PIAIMC_CLOUDCVR

NITF::IM001:: TRE_PIAIMC_SRP

NITF::IM001:: TRE_PIAIMC_SENSMODE

NITF::IM001::TRE_PIAIMC_SENSNAME

To assist in editing the user metadata of multiple images, the Metadata Manager allows

metadata templates to be saved and applied to one or more images. A metadata template con-

tains all of the tags and values that you wish to apply to a given image or images.
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Metadata templates are created, edited, saved, retrieved and applied in the Metadata Template
Editor.

1. Select one or more jobs in the Job List.

2. Select Metadata from the Options on the menu bar.
The Metadata Manager dialog box appears.

3. Click Metadata Templates at the bottom left.
The Metadata Template Editor appears.

Selecting or clearing the check box associated with a value or set of values enables or disables

the given tag.

The image tags are the same as those in the Metadata Manager except that you can choose to

save any or all of these in the template.

1. Click in the name or value cell of the row that starts with an asterisk.
2. Start typing in the Name and Value fields.

Tag names cannot contain spaces and tag values cannot be empty.

1. Select the entire tag by clicking the gray cell at the far left of the row.
2. Pressthe Delete key.

1. Click the Save Template button.
The Save Metadata Template dialog appears.

2. Enter a name for the template and click OK.

-60 -



Chapter 6: Image Manipulation

1. Clickthe Load Template... button. The Load Metadata Template dialog appears.

2. Choose a template from the drop-down list and click OK.

1. Choose the template in the Load Metadata Template or Save Metadata Template dia-

log.
2. Right-click the template name and click Delete this template.

1. Create a template or load a template in the Metadata Template Editor.

2. Click Apply Template.

If you need to make images with higher compression ratios, use the Despeckle tool to minimize

compression artifacts.

A side effect of lossy encoding schemes is that subtle compression artifacts are introduced which
alter the pixel values of the source image. While these changes are usually invisible to the human
eye, they can damage the integrity of any collar regions in the image, which makes it difficult to
seamlessly mosaic images together. The best way to avoid this "speckling" in the collar areas is to
compress to MrSID Generation 4 (MG4), or to losslessly encode source images to MrSID Gen-

eration 3 or JPEG 2000.

IMPORTANT: Despeckling is a computationally expensive operation that increases the
time it takes to encode an image. Also, despeckled JPEG 2000 files employ an alpha
band to mask the transparent region; most, but not all, applications can view JPEG
2000 files with alpha bands.

Despeckling is only supported for MG3, MG4, and JPEG 2000 output. If you select JPEG 2000 as
the format of your despeckled output, that output will be a GMLJP2 file and thus a JPEG 2000
Part Il file, even if your input was a JPEG 2000 Part | file. Source images with alpha bands can-

not be despeckled when outputting to JPEG 2000. Also, the area of valid image data must be con-
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tained within a single polygon (for example, an image of a series of islands cannot be des-

peckled).

By default, images are not despeckled upon encoding. Further, despeckling is not recommended
for images without a collar. To despeckle images by default for the MrSID or JPEG 2000 formats,
set the despeckling option in the preferences. For more information on preferences, see Prefer-

ences on page 159.

NOTE: Some existing JPEG 2000 images are encoded in such a way that certain
decoders may fail to display them when despeckled with GeoExpress' default settings.
To accommodate these images, GeoExpress handles several JPEG 2000 parameters
in a special way. If you are despeckling images using the Despeckling tab and wish to
change parameters for tile length markers, packet length markers, or tile parts, you must
change them on the JPEG 2000 tab of the Preferences dialog. (For more information see
JPEG 2000 Preference Options on page 171 and Advanced JPEG 2000 Options on
page 133.)

When you select a single job for despeckling, the image is displayed in the preview area of the dia-
log. If you select multiple jobs, the preview pane and navigation buttons are not displayed. You
can despeckle images with the MrSID Generation 4, MrSID Generation 3, or JPEG 2000 output

format.

1. Add a source image or mosaic to the Job List.

2 Click the Despeckle button @ on the toolbar.

The Despeckle Options dialog box appears.
3. Select the Despeckle Output check box.

4. Optionally, enter threshold and point spacing values by typing them in the edit fields or
using the slider controls (see below for information about these values). Note: The sliders
only move within the recommended range (1-127 for threshold and 6-12 for point spacing),
but you may enter any integer greater than zero in the fields.

5. Optionally, to preview the effects of the threshold at different settings select the View

Threshold check box and then move the Threshold slider. Black areas are pixels whose
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values fall below the threshold and will be used to determine the despeckling collar of the
image.
6. Click OK.

All pixel values below the despeckling threshold will be used in the despeckling process. For
example, with a threshold value of 10, GeoExpress treats any border pixels with a value less than

10 as no-data pixels.

By default, the threshold value is 8.

In order to despeckle an image, GeoExpress must determine the mask or "outline" of the valid
image data. This outline is created as a polygon of connected points, similar to a "connect the
dots" drawing. Image data that fall outside the outline are treated as invalid and subject to des-

peckling.

Whether image pixels are incorporated into the mask or abandoned as "islands" of data is largely
a function of the point spacing value, which determines the distance between the points that
make up the outline. The less distance there is between points in the outline, the more points it

takes to create the entire outline.

Therefore, decreasing the point spacing value raises the number of points, which is generally
desirable and is particularly useful when the outline is complex, such as that of a coastline.
However, higher numbers of points may slow performance or cause the job to fail. Conversely,
increasing the point spacing value reduces the total number of points, which makes for better per-
formance. When the outline is simple, such as a rectangle, the point spacing value can safely be

increased.

For any given dataset, some trial and adjustment may be required to arrive at the best balance
between a more accurate mask (lower point spacing value) and better encode performance

(higher point spacing value).

Generally, even values between 6 and 12 work best. By default, the point spacing value is 6.
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Use the Image Crop tool to crop a region from any raster image in the Job List whetheritis a

single image or an image mosaic.

To define the area of an image that you want to crop, draw a rectangle on the preview image or
select a shapefile with one or more polygons. If the shapefile contains multiple polygons, you can
either create a single output image that contains all of the polygon crop areas, or you can create a
separate output image for each crop area. Multiple output images are saved according to the fol-

lowing naming convention:

<output file name> <column label> <polygon ID>

For example, if you select Washington as the output file name, and the shapefile polygons have a

column for counties, one of the output files would have the following name:

Seattle KingCounty 1l.sid

NOTE: If you crop existing MrSID and JPEG 2000 images but do not compress the

images again, you do not use data from the data cartridge.

You can select a crop region by entering values for the image extents. Alternatively, click Show

Image to display an image preview and draw a rectangle of the area that you want to crop.
To manually enter the cropping extents, complete the following steps:

1. Select an image or mosaicin the Job List.

2. Click the Image Crop button = on the toolbar. The Image Crop dialog box appears.
3. Enter the cropping extents, then click OK.

To define the crop region by drawing a rectangle, complete the following steps:

1. Select an image or mosaicin the Job List.

Click the Image Crop button = on the toolbar. The Image Crop dialog box appears.

2.

3. Click the Show Image button at bottom right.

4. Use the zoom in, zoom out and other tools from the image crop toolbar to position the
image.

5. Click the Crop button on the image crop toolbar.
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6. Draw a rectangle on the image to define the crop region as shown below.

r .image Crop
Crop method:
IF{ed.angle j|

Enter cropping extents or click Show Image to draw the
extents.

Top
5271607 .35215594
Left Right
610361.345721606 619092.460986403
Bottom
5264417.02193787

Remowve Cropping |

Fill Caler:

ok | Cancel | Hidelmage | X

7. Optionally, adjust the rectangle using the corner or center handles.
8. Click OK.

The extents of the original image are displayed in the Image Extents panel on the Properties

tab for easy reference.
Cropping by Shapefile

GeoExpress allows you to crop images using a shapefile with one or more polygons. If the
shapefile contains more than one polygon, you must select the polygons that you want to use to

crop the image.

1. Select animage or mosaicin the Job List.

2 Click the Image Crop button on the toolbar.
3. Inthe Crop Method panel, select the Shapefile option.
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4. Click Browse to select the shapefile that you want to use.

A list of the polygons in the shapefile appear in the table. By default, if the polygons have

a name property, the names are displayed as the label in the table.

Optionally, use the Label drop-down to select the shapefile property that you want to dis-

play in the table as the label.

For example, you might select a property named Voting District to know which polygons

you want to select.

Select the polygons that you want to use for cropping in the table.

)
Alternatively, use the Select Features button to select polygons in the preview pane.
For both the table and the preview pane, you can press the Control key to select multiple

polygons. Additionally, when you use the select feature tool, you can right-click on a poly-

gon in the preview pane to display its properties in a table.
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F ™
, = 1 ==

Crop method:
|| Shapefile j|
Choose a shapefile and select the polygons that vou want to
crop.
CA\DumpliGlS Data'WectorWashingtoniKing C Browse...
Label: | NAME |
Label | D 4] |4
SAM 45-3386 1331
SAM 45-3387 1332
SAM 45-3388 1333
SAM 45-3389 1334
SAM 45-3412 1335
SAM 45-3454 1336
SAM 45-3505 1337
e =l
SMWYER 1338
SEA 11-1256 1333
SEA 11-1550 1340
SEA 11-1552 1341
SEA 11-1597 1342
SEA 11-1600 1343 :
SEA 11-1602 1344 SEA 11-1928
SFA 11-1R24 114R j 1908
Crop outputs: y SEA 11-1928
(» Join polygons SUM_VOTERS: | 300.00000000
(" Separate output for each polygon C Shape_area: | 87174720.84700000300
Shape_len: A4504.09057530000
Remove Cropping | E e

Fill Color: -

oK | e | T | X 550058.07009346 Y. 5269214.1728972

7. If you selected multiple polygons, select whether you want to join the cropped regions for
each polygon into a single output image, or you want to create a separate output image for

each polygon crop region.
8. Optionally, click Show Image to preview the crop area or areas on the source image.

NOTE: Cropping by shapefile is not supported when the output format is JPEG 2000

and the input image has multiple bands.

The Area of Interest Tool

The Area of Interest (AOI) encoding feature enables image customization through the pre-
servation or obscuring of detail. AOI enables you to define one or more areas within an image or
mosaic and encode these areas at a higher or lower compression ratio than the remainder of the

image. Using AOI thus creates a visual contrast between the area(s) of interest and the
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surrounding image, rendering either “sharper” (lower compression) areas or “blurred” (higher com-
pression) areas. In the image below we’ve drawn a rectangle around an area that has been

defined as an area of interest and compressed at a lower ratio than the rest of the image. Note

that more detail is preserved within that area.

GeoExpress offers three methods of encoding an area of interest: the weight, shift and mask
methods. GeoExpress enables you to encode an area of interest in MG3, MG4, or JPEG 2000
format. When the output format selected is JPEG 2000, any method can be used. MrSID encod-
ing requires the weight or mask method. For more information about using these methods, see
MG3 and MG4 Area of Interest Encoding on page 74 and JPEG 2000 Area of Interest Encoding

on page 75.

Although area of interest is a simple concept, there are many factors that come into play when
generating both the preview and the final encoded image in an area of interest operation. Some

of these factors are:

o the relative size of the selected area in relation to the entire image
o the difference between the two compression ratios applied — inside and outside the selec-
ted area

o the presence or addition of a crop operation in conjunction with an area of interest encode
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o the desired output format - MG3, MG4, or JPEG 2000

o the complexity of the imagery being manipulated
Some of the effects that a user may experience as a result of these factors are:

o slight bleeding of the AQOI resolution into the surrounding image
o “outside” area seems less compressed than expected given the specified compression

ratios
o area of interest specified as lossless is not always numerically lossless for some encode

scenarios (this variation is greater in JPEG 2000 encoding than in MrSID encoding).

You may define areas of interest in GeoExpress by vector overlay or by drawing a single rect-
angle. GeoExpress enables you to define areas of interest in MG3, MG4 and JPEG 2000 encod-
ing.

Vector overlay support enables you to include multiple areas of interest within a single image.

1. Selectajobinthe Job List

2 Click the Area of Interest button & on the toolbar.

The Area of Interest dialog box appears.

3. Toview the image while setting area of interest parameters, click the Show Image button

A single rectangle can be used to express an area of interest either as the foreground or back-

ground (see Inner and Quter Areas on page 73).

You can define a single rectangle either by entering values for offsets, x and y positions, or x and
y positions with width and height, or by drawing a rectangle across the image with the Draw Area

tool. The Draw Area tool is not accessible unless the image is shown.
To enter numerical values to define a single rectangular area of interest:

1. Access the Area of Interest dialog as described above.
Select the User Defined Rectangle radio button.
Select the format of the rectangle by selecting the radio button for Edge offset; Upper
left, lower right; Upper left, width, height; or Center, width, height.
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4. Change the unit of measurement if desired by selecting the Pixels or Geospatial
coordinates radio button.
5. Enter values in the fields to the right.

Select other desired parameters and click OK.
To use the Draw Area tool to define a single rectangular area of interest:

1. Access the Area of Interest dialog as described above and click Show Image.

2. Select the User Defined Rectangle radio button.

Click the Draw Areaicon  above the image window.
Click and drag on the image to define a rectangle as shown above.

How

5. Adjust the shape and size of the rectangle by clicking and dragging the “handles” at the
sides and corners; adjust its position using the middle handle. Offset or other positioning
values are automatically filled in.

6. Select other desired parameters and click OK.

GeoExpress supports vector overlays of Esri Shapefile (*.shp), Maplnfo TAB (*.tab), and GML ver-
sion 2 (*.gml) formats. Vector overlays must be in the same coordinate system as the input image
file and must contain closed polygons in order to be valid. GeoExpress uses all valid shapes within
the active layer as the combined area of interest; individual shapes within the active layer cannot

be turned on or off.

Area of interest options set by the user apply to all shapes in the active layer.
Vector overlays are not editable within GeoExpress.

To use a vector overlay to define an area of interest:

1. Access the Area of Interest dialog as described above.

2. Select the Vector Overlay File radio button.
A panel of vector overlay options appears in the middle of the dialog box.

3. Enter afile path in the Vector Overlay File field or click Browse to search your dir-
ectories.

4. Select an active layer from the drop-down list if necessary. GeoExpress supports only a
single layer of a given vector overlay. By default the first layer is taken.

5. Select any other desired parameters and click OK.
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To remove a currently listed vector overlay click Remove Vector Overlay File.

If a vector overlay is selected and Show Image is selected, the shapes will be drawn on top of the
input image in the image window. Filling in the shapes may give you a better idea of the areas

they define by displaying the shapes as solid polygons.
Tofill in the areas of interest, select the Fill Shapes check box below the image window.

The outline color for the drawn shapes can be customized by clicking the "Outline Color" button.
The line width for the drawn shapes can be set on the Appearance tab of the Preferences dialog
box. Changing the outline color and line width has no affect on the resulting encoded image, and

is only used for previewing purposes.

NOTE: The use of GML-formatted vector overlays can result in the creation of files with
a “.gfs” extension in the directory on your computer where the GML files are stored.

These are not used again and may be ignored or deleted.

All regions inside specified areas of interest are called “foreground”. All surrounding regions are
called “background”. The Inner and Outer radio buttons correspond respectively to foreground and

background and enable you to choose which part of an image the AOI processing will affect.

In MrSID encoding, “inner” and “outer” are not specifically referred to except when using the mask
method, as noted below. Either the foreground or background is given preference by the dif-
ference in weight between them as specified by the compression ratio of the foreground and that

of the area(s) of interest.

In JP2 encoding using the weight and shift methods, selecting the “Weight Inner” or the “Shift
Inner” button preserves the quality of the foreground at the expense of the surrounding regions.
Similarly, selecting “Weight Outer” or “Shift Outer” preserves the quality of the background at the

expense of the foreground.

The mask method renders either the foreground (by selecting the Inner check box) or background

(by selecting the Outer check box) as a solid color.
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GeoExpress is designed to accommodate a workflow that demands a number of image cus-
tomizations at a single encode. Accordingly, it is possible to crop an image and encode an area of
interest at the same time. A useful workflow would be to first define a crop region in an image and

then define an area of interest.
To specify your area of interest in relation to an existing crop region:

Select Area of Interest... from the Tools menu.

2. Click Show Image for an image on which you have already defined a crop region (see The
Image Crop Tool on page 64). The region you defined appears marked out in lines and
labeled as the crop region.

3. Define your area of interest and encode.

You can specify an area of interest anywhere in the image, regardless of whether or not it is in the
crop region. Obviously, areas of interest defined outside a crop region will not appear in the res-
ults for the cropped version of the image, but this may be a desired effect since a project can be

used for multiple operations.

In the illustration below, an area of interest is being drawn within an existing crop region.
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Inner and Outer Areas

All regions inside specified areas of interest are called “foreground”. All surrounding regions are
called “background”. The Inner and Outer radio buttons correspond respectively to foreground and

background and enable you to choose which part of an image the AOI processing will affect.

In MrSID encoding, “inner” and “outer” are not specifically referred to except when using the mask
method, as noted below. Either the foreground or background is given preference by the dif-
ference in weight between them as specified by the compression ratio of the foreground and that

of the area(s) of interest.

In JP2 encoding using the weight and shift methods, selecting the “Weight Inner” or the “Shift

Inner” button preserves the quality of the foreground at the expense of the surrounding regions.
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Similarly, selecting “Weight Outer” or “Shift Outer” preserves the quality of the background at the

expense of the foreground.

The mask method renders either the foreground (by selecting the Inner check box) or background

(by selecting the Outer check box) as a solid color.

GeoExpress offers two methods, the weight and mask methods, for encoding an area of interest

with MG3 or MG4 as the output format.

TIP: Area of interest encoding of MG3 and MG4 images can be done more quickly if the
images were originally encoded as optimizable. For more information, see Optimizable

on page 130.

NOTE: Area of interest encoding in MG3 format automatically uses the 2-Pass optim-
izer, even if its check box on the Format-Specific tab of the Advanced Job Options

dialog box has not been selected. For more information, see 1-Pass or 2-Pass Optimizer

on page 129.

The weight method is the default for encoding areas of interest with GeoExpress. (This is not to
be confused with the weight parameter in the advanced job options.) The parameters for using
the weight method differ depending on the output format. MG3 and MG4 require the user to enter

a compression ratio for the area of interest.

GeoExpress calculates the resultant image filesize as part of the encoding process, taking into
account the user-defined compression ratios for inside and outside the area of interest. Selecting
the weight radio button enables you to specify an encode ratio for the area of interest or select the
Lossless check box. The outside area will be encoded at the compression ratio specified in the

Job Options dialog. These ratios are used in a calculation of the overall image compression.

The calculated filesize appears on the Properties tab for the image once you close the Area of

Interest dialog box.
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The mask method renders either the foreground or the background as a solid color, completely

obscuring (actually removing) the underlying image data.
The mask method only applies to encode jobs and is not available for optimizations.
To mask any area(s) inside the AOI polygon(s) (foreground), select Mask Inner.

To mask any region(s) outside the AOI polygon(s), select Mask Outer.

To specify or change the mask color, select either Mask Inner or Mask Outer, then click Mask

Color. The AOI Mask Color dialog box appears.

By default the mask color is black. Black drives all pixel values to the minimum supported value
(usually zero), while white drives all pixel values to the maximum supported value (e.g. 255 for an

8-bit image). You can also specify a custom 8-bit RGB color value.

To specify a custom 8-bit RGB color value, select the Custom option and fill in the red, green and

blue values.

The compression ratios for the inside and outside of the area of interest are reported in the GeoEx-
press log file after you run the area of interest job. For more information on log files, see Viewing

and Using Log Information on page 177.

GeoExpress offers three methods, the weight, shift and mask methods, for encoding an area of
interest (AQI) with JPEG 2000 (JP2) as the output format. Also, the weight and shift methods can

favor the “inner” or “outer” area (for more information see Inner and Outer Areas on page 73).

In JPEG 2000 encoding the weight value controls the image quality of the foreground relative to

the background or vice versa: larger values will result in a higher quality foreground and a lower
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quality background, and smaller values will result in less of a marked difference. (Note: a value of

1.0 will have essentially no AOI weighting effect.)

1. Clickthe Area of Interest button & on the toolbar (or select Area of Interest... from
the Tools menu) to access the Area of Interest dialog box.

2. Define an area of interest by one of the following methods (for more information see Defin-

ing Areas of Interest on page 69):

e using a vector overlay

o drawing or entering values for a single rectangle
3. Select Weight Inner or Weight Outer.
The Value field appears with the default value of 100.

Change the default value if desired.
If desired, choose a number of resolution levels to be included in the AOI process from the
drop-down list. The default is all levels, but you may choose any number equal to or less
than the number of resolution levels the image includes (see Zoom Options on page 108).
For example, if the image is being encoded to have five resolution levels, then you may
choose five or less and the default would be all five levels.

6. Click OK.

When using the Weight method, the actual boundaries of the region are defined by the extents of
the codeblocks within each resolution level. Because the spatial extent of the codeblocks varies
by level, the actual encoded region may appear larger than the selected region, and a step-like

fall-off in quality may be noticeable.

The shift method is an alternative way to express the encoding of an area of interest when JP2 is
selected as the output format. Rather than affecting the amount of quality in a codeblock at
encode time, the shift mode adjusts the “importance” of individual pixels by the specified shift
amount. In other words, this function promotes the importance (or sharpness) of the data inside or

outside the area of interest (see Inner and Outer Areas on page 73). The shift value to be spe-

cified is the number of bit positions to “promote” the foreground region over and above the back-

ground. For 8-bit samples, an appropriate scaling factor would be 12. Images to be encoded with
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large bit-depths and/or a large number of levels may, under certain conditions, require a higher

value.

1. Clickthe Area of Interest button & on the toolbar (or select Area of Interest... from
the Tools menu) to access the Area of Interest dialog box.

2. Define an area of interest by one of the following methods (for more information see Defin-

ing Areas of Interest on page 69):

e using a vector overlay

o drawing or entering values for a single rectangle
3. Select Shift Inner or Shift Outer.
The Value field appears.

Enter a shift value.
If desired, choose a number of resolution levels to be included in the AOI process from the
drop-down list. The default is all levels, but you may choose any number equal to or less
than the number of resolution levels the image includes (see Zoom Options on page 108).
For example, if the image is being encoded to have five resolution levels, then you may
choose five or less and the default would be all five levels.

6. Click OK.

The differences between the two methods are subtle and technical; we recommend that the
weight method be used unless large quality differences are desired. While the shift method does
not suffer the stepping effects of the weight method, it affords less granularity of control between

foreground and background. The weight method is enabled by default.

Although with practice and experimentation the shift mode can be used to completely mask out a
desired region, its purpose is “obscuring” areas of an image rather than masking them out. It is
recommended that you use the Mask method if you wish to achieve a masking effect (for more

information see The Mask Method on page 75).

The mask method in JPEG 2000 is the same as in MrSID area of interest encoding. See The

Mask Method on page 75.
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This parameter controls the number of resolutions levels subject to the area of interest encoder
process in the shift and weight methods; this can be used to alleviate the “stepping” effect men-
tioned above. When “Number of AOI Levels” is set to less than the total number of levels in the
image, the lower-resolution levels will not undergo AQI processing; in this way, only the N highest
resolutions are affected, so the icon image (and potentially other lower-resolutions) will appear as

if no AOI had been selected.

For information on viewing the results of encoded areas of interest, see Reading the Log File on

page 75.

When using the weight method for area of interest encoding with JPEG 2000, it is recommended
that you use a smaller codeblock size, such as width = 32, height = 32. This parameter can be set

on the Format-Specific tab of the Advanced Job Options dialog box (see Advanced JPEG
2000 Options on page 133).

The overall compression ratio chosen for the encode job can be as important to the appearance of
the region as the actual weight or shift values chosen. The image quality at a given compression
ratio may diverge dramatically from expected results when AOI encoding is enabled. Getting the

desired effect in JPEG 2000 area of interest encoding may require a trial and revision process.

A city government has an area that will be under construction with a new housing development.
The contractor needs access to high-quality imagery in the construction zone. The contractor will
need the remainder of the imagery at a lower quality in order to overlay existing roads, etc. The
city has an existing composite MrSID Generation 3 (MG3) mosaic of MrSID imagery created from
100 smaller MG3 images compressed at a ratio of 20:1. The city will import a vector overlay that
outlines the area of construction and would like to specify a lossless compression ratio in this area
(i.e. no additional loss after original 20:1 compression) and an additional 20:1 compression for the
remainder of the image in order to reduce the file size of the deliverable and still meet the con-

tractor's needs.
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The United States Department of Defense (DoD) requires as a measure against terrorism that
imagery over the nation’s capital building and White House in Washington, DC, not be delivered
in high resolution. In the past data providers have downsampled those areas of the images and
mosaicked them back together, which can be time consuming. A data provider would like to load
the mosaic of original TIFF files into GeoExpress, select a region, apply a 100:1 compression

ratio over the selected region and 20:1 compression for the remainder of the mosaic.

A Paris city employee working in the field with low bandwidth wants to view an extremely large
image of Paris online through a viewing application. She is only interested in the portion of the
image that shows the Eiffel Tower. If that portion of the image has been defined as an area of
interest, it can be given display priority so that that area appears sooner, becoming crisp and clear

before the rest of the image.

Use GeoExpress to perform color balancing operations for raster images when you select MG3,
MG4, or JPEG 2000 as the output format. You can color balance 8-bit and 16-bit unsigned gray-
scale and RGB images. You can also color balance mosaics and multiple images at a time. There
are three types of corrections that you can apply: uniform corrections, non-uniform corrections,

and automatic corrections.

For information about color balancing and mosaics, see Performing Color Balancing for a Mosaic

on page 151. For information about color balancing many images at a time, see Performing

Batch Color Balancing on page 82.

You can apply uniform corrections to single images and mosaics. Uniform corrections affect the
brightness and contrast of all pixels in the same way, so light spots will still be light and dark spots

will still be dark regardless of the corrections that you apply.

In the Uniform Corrections tab, select the bands for which you want to perform corrections and

use the sliders to adjust gamma, brightness, and contrast values.
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You can apply non-uniform corrections to mosaics only. Non-uniform corrections adjust the color
values of specific portions of each mosaic tile. Use non-uniform corrections when each tile in a
mosaic has similar flaws. For example, when one side of each tile is light and the other side is
dark. When you combine multiple images with similar imperfections, the flaws become very

noticeable. To correct these patterns across a mosaic, use non-uniform corrections.
The following list describes the three types of non-uniform corrections:

« Vignette correction. Corrects color inconsistencies caused by a camera lens. Use vign-
ette correction when your images display a lower light intensity around their edges. The cor-
rection automatically normalizes the highlights and dark spots across tiles to create a
mosaic that appears more unified. Vignette correction affects all the tiles in the mosaic.

o Tilt correction. Corrects bidirectional reflectance. Bidirectional reflectance describes the
effect of the angle of the sun on an image. Use tilt correction when the images in a mosaic
were all taken under similar lighting conditions. For example, your images may be darker
on one side than the other. When you apply tilt correction to all the tiles in a mosaic,
GeoExpress matches the color levels of each tile in the mosaic. Tilt correction affects all
the selected tiles in a mosaic.

« Seam line correction. Corrects discrepancies in the edges of tiles in a mosaic. Use seam
line correction to smooth the transitions between tiles. Depending on the geometry of a
given mosaic, sometimes seam lines cannot be generated. In that case, the Apply Seam

Lines option is unavailable. Seam line correction affects all the tiles in a mosaic.

NOTE: Tilt correction is computationally intensive. If there are many tiles in the mosaic,

both the preview and the mosaic job may take more time to process.

Automatic corrections adjust the color values of multiple images or mosaic tiles to match another

image.

You can apply automatic corrections to single images and mosaics. If the corrections are going to
be applied to multiple images, all the images must have the same number of output bands and
the same data type. If you select Duplicate job parameters, this also applies to the image

whose color corrections you want to match.
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The following list describes the automatic correction methods that you can use:

« Match tiles to each other. Mosaics only. Sets the intensity of each tile in a mosaic to
match the average of all tiles.

« Match to a selected tile. Mosaics only. Sets the intensity of the tiles that you select to
match the color levels of a source tile that you specify. To specify a source tile, select a tile
in the tile list and click Set Selected Tile As Source Tile in the Automatic Corrections
panel. Then, select the tiles in the tile list to which you want to apply the corrections and
click Apply Corrections.

« Duplicate job parameters. Matches the color balancing corrections applied to another
image in the Job List. If you have not applied color balancing corrections to another job
yet, GeoExpress displays a blank pane. Use this option to quickly apply color balancing cor-
rections to many images at a time.

o Match to histogram. Matches the histogram values of another image that you select.
GeoExpress calculates histogram values for the image that you select, including bright-
ness, contrast, gamma, and more, then GeoExpress attempts to apply those values to the

current image.

1. Select a single job from the Job List.

2 Click the Color Balance button L on the toolbar.

The Color Balance Manager appears.
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3. From the Band drop-down list select a band or Intensity.

For grayscale images, only one band is available. Select an individual band to modify it

individually or select intensity to modify all bands.

4. Make changes to histogram values by entering new values into the Min, Max and Gamma
fields, or click and drag the slider controls below the histogram.
5. Click OK.

Performing Batch Color Balancing

To perform color balancing for many images at a time, you must first set the color balancing cor-
rections that you want to apply to a single image. Then, you can apply those corrections to all the

remaining images.

Add all the images that you want to color balance to the Job List.

2. Select one of the images from the Job List.

3. Clickthe Color Balance button g on the toolbar.

The Color Balance Manager appears.

-82-



Chapter 6: Image Manipulation

10.
11.
12.
13.

From the Band drop-down list select a band or Intensity.

For grayscale images, only one band is available. Select an individual band to modify it

individually or select intensity to modify all bands.

Make changes to histogram values by entering new values into the Min, Max and Gamma
fields, or click and drag the slider controls below the histogram.

Click OK.

Select the remaining images that you want to color balance from the Job List. You can

hold the Shift key to select a range of images.

In the Automatic Corrections panel, select Duplicate job parameters from the drop-

down.

The first image to which you applied color balancing corrections appears in a list below the

drop-down.

NOTE: The list only displays images to which you have applied color balancing
corrections, and which have the same number of bands and the same data type
as the images that you selected in the Job List. Additionally, the list does not dis-

play mosaics to which you have applied corrections, only single images.

Click the first image to which you applied color balancing corrections.
Click Apply Corrections.

Click OK.

Click a blank section in the Job List to ensure that no jobs are selected.
Click Run All Jobs.

GeoExpress displays the histogram for an image on the left side of the Color Balance

Manager. The histogram control enables you to adjust the minimum, maximum, and gamma val-

ues for each band in the image.

The black slider represents the minimum pixel value, the white slider represents the maximum

pixel value, and the gray slider represents the gamma value. The range of values for the minimum

and maximum controls is based on the data type of the image. For example, for 8-bit images, the
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range of values is 0 through 255. The maximum value cannot be less than or equal to the min-

imum value.

The gamma slider is restricted to a fractional position in between the minimum and maximum

sliders. The range of gamma values is 0.102 — 9.99. The default value of 1.0.
The histogram controls adjust dynamically as the brightness and contrast values are changed.

To revert back to an image’s original state, removing all color corrections, click Reset All Cor-

rections.

Below the histogram control are two slider controls for modifying the brightness and contrast of
the active band of the image. They accept integer values from -100 to 100, -100 being low bright-
ness/contrast and 100 being high brightness/contrast. The histogram controls adjust dynamically

as the brightness and contrast are changed.

The "Enable Live Updating" check box controls how the preview image is updated. If "Enable Live
Updating" is selected, the image will update in real time as you manipulate the slider controls. If
the update performance starts to slow down, as it may for very large mosaics, you can clear this
check box to disable the live updating feature so that the image only updates after a dragging

operation is complete (i.e. when the mouse button is released).

The Reproject tool changes the projection of an image from one coordinate reference system

(CRS) to another.

A coordinate reference system defines the location of a point on a planar or spherical surface. An
example familiar to many people is a graph with x and y axes. A geographic coordinate system is
a three-dimensional reference system that locates points on the Earth’s surface based on pro-
jections. Projections are the method used to display a spherical surface onto a flat surface. In this

manner, Cartesian coordinate systems can be overlaid.

Coordinate reference systems are prearranged projections used in specific countries either in mod-

ern times or in historical maps. However, many states and counties within a country may employ a
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different coordinate reference system. These reference systems differ in order to maintain the
highest accuracy in a smaller defined region. Because they are only approximations of the shape
of the earth — which is irregularly shaped — the larger an area a given coordinate system covers,

the less accurate it will be.

An agency working on a broad area of coverage, such as statewide, will typically work in the UTM
(Universal Transverse Mercator) system, since it can be used over larger geographic areas. Organ-
izations whose area of interest covers a smaller geography, such as county or city level man-
agement, will typically work in a State Plane coordinate system. This presents problems when

trying to employ data from different sources for use in a single project.

The reprojection tools in GeoExpress enable you to take images that are georeferenced in one or
more coordinate reference systems, and reproject these images to a different coordinate ref-
erence system either individually or as a mosaic. CRSs are identified by regions of use, sub-
regions and system names as defined by the European Petroleum Survey Group (EPSG). You

can also use well-known text strings (WKTSs).

Y ou can repurpose and combine diverse data sets by using the GeoExpress reprojection tools
when you create a new image or by reprojecting your existing images. With support for over 2,500
WKT (well-known text) coordinate systems such as State Plane Coordinate Systems and UTM —
as well as hundreds of specific regional projections — GeoExpress enables geospatial pro-
fessionals to share imagery across boundaries previously imposed by disparate coordinate ref-

erence systems.

MAD B3 TM Lat-Long WGSE4
Zane 18M(26918)

As an example, say you have a shapefile using a coordinate reference system of Lat-
itude/Longitude, WGS84, while the raw imagery you purchased from an image data provider is
created in UTM, NADB83, Zone 10N. Using the reprojection feature in GeoExpress, you are able to
reproject the raw imagery to the Lat-Long coordinate reference system while converting it to MG3,

MG4 or JP2 format within your normal encoding workflow.
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NOTE: Reprojection necessarily involves encoding since pixel data cannot be altered in

compressed wavelet space.

To reproject an image, you must set a CRS for the source image and for the output image. You
can reproject images to the MrSID Generation 4 (MG4), MrSID Generation 3 (MG3), JPEG 2000,
and NITF 2.1 output formats.

P
[

1. Click the Reproject button " on the toolbar.

The Reprojection Manager dialog box appears.
2. Select the Reproject Image check box at upper left.

3. If the source image has a known CRS, then that CRS is displayed. Otherwise, click Select

Coordinate Reference System in the Source Image panel to select a source CRS.

4. To set the projection for the output image, click Select Coordinate Reference System
in the Output Image panel.
Optionally, click Advanced Options to set additional reprojection options.
Click OK.

NOTE: When you reproject an image, you affect the image's pixel data. As a result, you
should always reproject an image before you perform other image manipulation oper-

ations, especially cropping or defining an area of interest.

Select the coordinate reference system by typing any part of it in the System field, such as the
name of the state ("Utah") or an EPSG number ("4326") and then choose from the CRSs that
appear as you type. You may alternatively select one of the CRSs you use most often by choosing

it from the Recently Used Systems drop-down menu.

If a particular EPSG code is not available in the System field, select the Use Custom WKT
check box and select an option from the Select WKT drop-down list. If you've already created
and saved a custom well-known text string (WKT), you can choose it from this list. Otherwise,

select Add a new WKT to create a new custom WKT that describes the CRS. You can paste a
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WKT string in the WKT field, or you can use a text file or Esri CRS file (*.prj) as input by clicking

Browse.

NOTE: For information on how to create a WKT, see the Open Geospatial Consortium
(OGC) spec # 01-009 at http://www.geoap-

i.org/3.0/javadoc/org/opengis/referencing/doc-files/WKT.html. For a listing of common

WKT strings, see http.//www.spatialreference.org/.

1. Access the Coordinate Reference System Selector as described above.

2. Select the Use Custom WKT check box. The “Select WKT” drop-down list becomes avail-

able.

3. Select a WKT from the drop-down list and click Edit WKT. The "Edit User Defined WKT"

dialog box appears as shown above.

4. Make changes to the text string and click OK.

1. Access the Coordinate Reference System Selector as described above.

2. Select the Use Custom WKT check box. The “Select WKT” drop-down list becomes avail-

able.
3. Select the WKT from the drop-down list and click Edit WKT. The "Edit User Defined

WKT" dialog box appears as shown above.
Click Delete this WKT.
Click OK.

To specify the output resolution of the reprojected image, select the Set output resolution
check box and enter the x and y values in the edit fields. If the check box is left unselected,

GeoExpress calculates the output resolution when it performs the reprojection.

This parameter has been made configurable in the event that experienced users require adjust-
ments. However, adjusting the output resolution can have far-reaching effects and it is recom-

mended that you allow GeoExpress to calculate it for you.
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If you set the resolution manually and notice that the image is offset, select the Align pixels
with output resolution check box. This option aligns the output image to an integer multiple of

the output resolution.

The error fraction is a value from 0.0 to 1.0 that indicates the level of accuracy of the reprojection.
A value of 0.0 is the highest level of accuracy — essentially a "lossless" reprojection. An error frac-
tion of 0.125 means that each reprojected pixel could be off by an eighth of a pixel, while a value

of 0.25 indicates a quarter-pixel inaccuracy.

Block values tell the encoder to reproject the pixels in blocks of dimensions the user may specify.
(Note: These blocks are different from both the MG2 and the MG3/MG4 encoding blocks.) Using
block values improves disk access and memory usage and can improve performance. Smaller

block values use less memory but may be slower. Block values do not affect the output image.

By default the block value is 2048.

The Resample Method drop-down list shows the available resampling methods for the repro-
jection operation. Nearest Neighbor is the fastest method, while Bicubic gives more accurate res-

ults. Bilinear is a compromise — faster than Bicubic and more accurate than Nearest Neighbor.

If this check box is selected, the encoder caches the reprojection processing blocks to disk in the

form of a temp file instead of keeping them in RAM.

By default this check box is selected.

NOTE: The process of rendering previews for very large images or mosaics can be time
consuming, especially when reprojecting mosaicked images in different resolutions and

coordinate systems. Previewing does not decrement the data cartridge.
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A user has a set of 500 images in TIFF format with TIFF world files and wants to put each single
image into a new coordinate system and encode to MrSID at the same time. The user adds the
images into the Job list. GeoExpress knows where they are located (due to the world files) but
knows nothing about the coordinate reference system (CRS). The user assigns a coordinate sys-
tem to the source images to be used as a source CRS. The user can select multiple files and

apply the CRS once to all of the source data. Then the user selects the destination CRS that will
apply to all images in the current selection. The user specifies other compression parameters inde-

pendent of the reprojection option, then encodes the images normally.

Same as “Reprojection of Single TIFF Images” above, except that the user has MrSID Gen-

eration 2 images with sdw files.

Same as “Reprojection of Single TIFF Images” above, except that the user has MrSID files with
embedded GeoTIFF tags. GeoExpress automatically reads those GeoTIFF tags to determine the

source coordinate system.

Same as “Reprojection of Single TIFF Images” above, except that the user has GeoTIFF files.

GeoExpress automatically reads the CRS and assigns it as a source CRS.

The user is a provider who has many GeoTIFF images in the same CRS (UTM). The user wants
to mosaic these together and reproject them to the State Plane system. In this instance GeoEx-
press reads the CRS from the images and mosaic prior to reprojection to ensure a seamless

mosaic.
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A city government has received images in UTM from the NAIP program, has existing imagery in
state plane coordinate system and has purchased satellite imagery in lat-long. The imagery from
NAIP is a one-foot-pixel, the city’s imagery is a half-foot pixel and the satellite imagery is a five-
meter pixel. The NAIP imagery is in MrSID format, the city’s data is in GeoTIFF and the satellite
imagery is in TIFF with TIFF world files. This user can create a single MrSID mosaic in State

Plane coordinates from all three sources of imagery in one single encode operation.
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Job Options OVverview. ... .. 9
Raster Job Options. . ... .. 91
Destination Options. ... .. 9
LIDAR Job OptioNns. . ... .. 94

Click More Options on the Properties tab to access options for a job. The job options depend on

whether the selected job is a raster job or a mosaic job.

The following list describes some of the options that you can set for raster images and mosaics:

e Select an output destination.
o Select an output format and compression method.
¢ Select custom dimensions and resolution.

o Select tiling options.

NOTE: For raster images, you can also click Advanced on the Properties tab to set
additional options. For example, you can use the advanced options to select a color
space, edit transparency values, and more. For more information on advanced job

options, see Advanced Job Options on page 97.

Use the Destination tab to save output files to a file on your machine or to an Express Server.

You can only save MrSID, JPEG 2000, and NITF images to Express Server.

To select an output destination:

1. Select one or more jobs in the Job List.

2. Click Properties to view the Properties tab.

3. Inthe Job Options panel, enter a file path in the output destination field. Alternatively, to
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select an Express Server, click More Options and select the Publish to Express Server

check box.

By default, the output directory is the same as the input directory.

To change the default output directory, see Preferences on page 159.

GeoExpress 9.5 supports Express Server version 6.0 and later. You can save images in the fol-

lowing output formats to an Express Server:

¢ MrSID Generation 4

¢ MrSID Generation 3

e MrSID Generation 2

e JPEG 2000 (Part 1)

e JPEG 2000 (GMLJP2)
e NITF

If you select Publish to Express Server on the Job Options dialog, you must still specify a file
path on the Destination tab. GeoExpress uses the directory that you specify as a temporary dir-

ectory where it saves the output file before publishing to Express Server.

When you select Express Server as the output destination, the Express Server Browser

opens.

1. Inthe Express Server Browser, enter the URL of the Express Server to which you want
to save files. Alternatively, click the drop-down box to view the list of Express Servers to

which you have recently connected.
For example, you might enter the following URL:
express-server.lizardtech.com

2. Click Connect.

NOTE: The server is queried for a list of catalogs on the server. Catalogs that

have a spatial index appear with the world map icon % and the EPSG code of
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the spatial index. If there are no catalogs on the Express Server, contact the

server administrator.

3. If the Express Server requires authentication, a dialog box prompts you for a user name

and password. Enter the user name and password that you want to use and click OK.

4. Select the catalog to which you want to save your files.

NOTE: The output images that you create must use the same spatial reference

system as the target catalog.

5. Optionally, select the Replace existing files check box to overwrite files in the catalog

that have the same name.

If files with the same name exist and the check box is not selected, the upload fails and

reports that the file exists.

6. Click OK.

Use the Format and Compression tab to select an output format and compression method.

For more information about output formats, see Supported Output Formats on page 30. For

more information about compression, see Compression Overview on page 39.

Use the Dimensions and Resolution tab to change the dimensions of an image or select a cus-

tom resolution.
You can select from the following dimensions:

o Full resolution. Use the native resolution of the input image. This option is the default.

o Print. Scale the image so that the resolution matches that of a typical printer.

o Medium. Scale the image to either 2048 pixels wide or 2048 pixels high depending on the
orientation.

o Web. Scale the image to either 512 pixels wide or 512 pixels high depending on the ori-
entation.

o Custom. Enter a custom width and height, or enter a custom resolution.
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NOTE: GeoExpress will not attempt to increase the resolution of images. If you select a
resolution greater than the full resolution of an image, GeoExpress creates an image at
full resolution. For example, if the source image is 5000 pixels wide and you attempt to

set the width to 8000 pixels, GeoExpress reverts to a width of 5000 pixels.

Use the Tiling tab to break the output image into multiple tiles.
The following list describes the tiling options that you can select:

o Nottiling. Create a single output image. This option is the default.

o Number of tiles. Break an image into a number of columns and rows that you specify. For
example, if you select four columns and three rows, the job creates 12 images.

o Tile by units. Break an image into tiles based on the geospatial units of the image. For
example, if the image is in a UTM projection, the unit is meters and you can create tiles
1000 meters wide by 1000 meters high.

o Tile by pixel area. Break an image into tiles such that each tile has the width and height
that you specify. For example, you may want to create square tiles that are 2048 by 2048

pixels.

The following list describes some of the options that you can set for LIDAR images and mosaics:

o Enter a custom block size.
e Omit LAS variable length record (VLR) metadata.

e Column mapping options for text files.

Use the Compression tab to change the block size and remove variable length record (VLR)

metadata from LAS files.

The block size is the number of points that GeoExpress processes and stores at one time. Enter a
large block size to increase compression speed. Enter a small block size to decrease memory

usage. Valid values are from 2048 to 16384. The default value is 4096.

-94-



GeoExpress 9.5 User Manual

If you select the Omit Custom LAS VLR metadata option, GeoExpress removes VLR
metadata from LAS files. VLR metadata can include vendor-specific data, user-specified data,

and more.

Use the Text Parsing tab of the Job Options dialog to map text file columns to standard or cus-
tom fields and to load the whole text file. GeoExpress prompts you to set these options auto-
matically when you add a LiDAR text file. At a minimum, you must map the X, Y, and Z columns

of afile.

LAS files often contain header lines with the names of the columns and additional information.
Enter the number of header lines are in the file so that GeoExpress does not attempt to read

those lines as valid values.

Use the drop-down boxes for each column to map values to standard fields like X, Y, Z, Intensity,

and more.

Create, edit, and delete custom fields that you want to map to columns. For example, you may

want to create fields for a custom GPS time format or for sensor information.

When a job is run, each number in the data columns is represented by an offset and the default
precision factor of .001. The Precision factor fields enable you to change the factor by which the
data in any or all three axis columns will be represented to account for the number of significant

decimal places in those columns.

If you select this option, GeoExpress reads the whole text file to determine image properties like

the extents. You must select this option if you want to preview the LiDAR point cloud.

-905-



Chapter 7: Job Options

Select the Prompt me to map columns every time option to display these text parsing options

every time that a text file is added.
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For raster images, you can click the Advanced button on the Properties tab to select additional

job options.

The following table describes some of the tasks that you can perform in each tab of the

Advanced Job Options dialog box.

Tab

Tasks

Input

Change the name of the selected job.
Use world files and aux.xmlfiles to override the georeferencing information in the selected image.
Apply image rotation from the image metadata.

Apply NITF RPC from the metadata.

Output

Create a test outputimage.

Convertimages to 8-bitimages.

Set a custom watermark for the selected image.
Crop a DOQimage with corner cross points.
Flatten a composite mosaic.

Enable multiresolution mosaics.

Enable mosaics with multiple coordinate reference systems.

-97-



GeoExpress 9.5 User Manual

Tab Tasks

Enable multiple image segments for NITF images.

Select a color space for animage.
Bands
Select and map bands for an image.

Set the number of zoom levels in the output image.
Zoom Specify a target thumbnail size.

Resample animage.

Specify transparency values for MrSID Generation 4 (MG4) files.
Alpha
Create or regenerate an alpha band.

Specify transparency values for JPEG 2000 files, MrSID Generation 2 (MG2) files, and

Transparency
MrSID Generation 3 (MG3) files.

Enter quantization options for floating pointimages. Quantization is the compression method for
Quantization
floating pointimages.

Security Set password protection for MG2 and MG3 images.

Configure image encoding performance by changing the block size or strip height.

Configure the display of an image by changing the weight values and sharpness.

Format-Spe-
Generate dynamic range metadata.
cific
Select and edit JPEG 2000 profiles.

For more information, see Format-Specific Options Overview on page 121.

NOTE: The options that you can see in the Advanced Job Options dialog box depend

on the output format that you select.

The Input tab contains four panels: the Job Name panel, the Override Georeferencing panel,

the Apply Metadata to Image panel, and the Input Image panel.
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— Input Image
Input Type: Single image
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Use the Job Name panel to change the name displayed in the Job List.

Use the Override Georeferencing panel to override a file's native georeferencing information
with information from another file. The other file can be a world file or an aux.xml file included in
the same directory as the image. When georeferencing information for an image or mosaic tile is
given in the form of a world file or aux.xml file, GeoExpress can use that information to override

the file's native georeferencing. For more information on world files, see World Files on page 182.

Use the Apply Metadata to Image panel to change the output image based on information in
the image metadata. There are two types of metadata that you can apply: NITF RPC metadata
and image rotation metadata. NITF RPC metadata maps pixel data to location data for orthorec-

tification. Image rotation metadata describes how to rotate the output image.
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The Input Image panel identifies whether the input image is a single image, a mosaic, or a color
composite image, and lists the input file or files. Note that the job name can be different from the
input file name and the output file name. Also the job name is different from the project name

that is displayed in the blue bar at the top of the screen in the work area.

Output Options

Set options for the output image in the Output tab. The options that you see depend on the job

type and the output format.

i ‘ “ "
“} Advanced Job Options -

Input  Output IEands I Zoom I Alpha I Quantization I Fonﬂat-Spedﬁcl

—Output Options
[T Encode As Test Image

[T ‘watermark: I

Flatten Tile Size:

You can specify the following options:

-100 -



Chapter 8: Advanced Job Options

For raster images, you can create test images to test an image manipulation or compression oper-
ation without using data from the data cartridge. Test images are output images that have a vis-

ible watermark. You can create images and mosaics as test images, but not LiDAR point clouds.

Converting unsigned 16-bit data to unsigned 8-bit data during encoding.

You can add custom watermarks to your images. GeoExpress supports watermark images in
BMP, PNG, and JPEG formats. You can use black and white images with maximum dimensions

of 128 pixels by 128 pixels.

Click the Browse button to select the image that you want to use as a watermark. The following

figure shows an example of a watermarked image:
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USGS DOQ Cropping Option

If the job contains DOQ images, the USGS DOQ Cropping panel will be available. Cropping is

either by corner cross or disabled.

Flatten Option

To flatten a composite mosaic, select the Create Flattened Mosaic option. When you flatten a
mosaic that contains overlapping tiles, you discard the data from tiles that are not visible. For

more information on composite mosaics, see Mosaic Output Formats on page 144.

When you flatten a mosaic, the Flatten Tile Size field is available. GeoExpress divides mosaics
that are to be flattened into tiles for encoding. Acceptable values are integers between 1024 and
4096, and powers of two (1024, 2048 and 4096) are recommended though not required. The
default tile size is 4096.
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NOTE: You may encounter irregularities in the progress meter when flattening mosaics.

Band Options

Use the Bands tab to select a color space for the output image and to select and map bands.

NOTE: For MG3files, the output color space is only supported for encoding single

images and flat image mosaics.

@) Advanced Job Options
Input | Output Bands |Znum I.Pv.lpha IGuarrtizatiun Funnat-SpedﬁcI

Mumber of Mon-Alpha Input Bands: 3
—Output Color Space

Color Space: .

Red Band: |1

=l
Green Band: |2 ;I
=l

Blue Band: |3

Output Color Space

The options available in this group depend on which color space is selected in the drop-down
menu. For grayscale or RGB output, another drop-down menu enables you to select a single band

or three bands, respectively. For multispectral output, the Select Bands button appears enabling
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you to access a dialog where you can select bands from your input image and order them for your
output image. The default color space is Same as source. For more information on selecting

bands, see Selecting and Mapping Bands on page 105.

The MrSID Generation 4 (MG4) format supports multispectral color spaces, but in order for MG3
to accommodate multispectral input files, an output color space (or target color space) and band

orientation must be specified. MG2 does not support the multispectral color space.

For multispectral images, select the Apply RGB Color Transform to First Three Bands
check box if the first three bands in your output list are Red, Green and Blue, in that order. If the
first three bands are not Red, Green, and Blue, click the Select Bands button to re-order the

bands. For more information on the RGB color transform, see The RGB Color Transform on

page 42.

The following table shows supported output MrSID color spaces for various input and output

formats:
Supported Color Spaces
Color Space of Source Supported JPEG 2000 Out-
Supported MrSID Output
Image put
Grayscale Grayscale Grayscale
RGB RGB, Grayscale RGB, Grayscale
CMYK CMYK, Grayscale Not Supported
RGB, Grayscale, CMYK, Mult-
Multispectral RGB, Grayscale, Multispectral
ispectral

For multibanded output to MG4 and JPEG 2000, additional options on the Color Space drop-
down are available, most notably that a multispectral input image can use Same as source for

the output color space.

NOTE: GeoExpress does not support the CMYK color space for JPEG 2000 images,
either as input or output. For source images that are CMYK; the only supported output
color space for JPEG 2000 encoding is grayscale. The preview input image color space

controls remain the same.
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With multispectral image support, it becomes necessary to provide color space control over the
input and output images so that they can be viewed by human eyes. The Output Color Space
control shows a list of supported output color spaces for the currently selected output format. The
supported output color spaces for MrSID Generation 3 (MG3) are grayscale, RGB, and CMYK. If
the input image is already in one of the supported color spaces, Same as source will also be an
available option. By selecting an output color space other than Same as source, a group of band
selectors will become visible, allowing the user to choose which input bands map to the output
color space. If you chose RGB as your output color space, three controls would appear for choos-
ing the red, green, and blue component bands of the output image. Then you could choose which
bands of the source image were most interesting or important to you, for example bands 1, 3, and
5.

If you want to encode a six-banded image to MrSID format, you should select MG4 as your output

format.

For raster multispectral images, you can select and map image bands from a source image to a

MrSID or JPEG 2000 output image. Not all workflows are available for all output formats.

The following table shows which workflows each format supports.

Support for Band Selection and Mapping in GeoExpress Output File Formats

Supported by Output File

Workflow:
Format:
JPEG
MG2 | MG3 | MG4
2000
Choose one band from an RGB or multispectral source
. . . .
image to represent the single output ("grayscale") band
Map any three bands from an RGB or multispectral source
. . . .
image to the red (R), green (G) and blue (B) output bands
Choose to carry all source bands over to your output image
. .
in their original order
Map an arbitrary subset of bands (more than 3) from a
.
multispectralimage to your outputimage in any order
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By default, GeoExpress retains all source bands in order.

The following procedures assume you have loaded one or more images into the Job List.

You can select a single band for MrSID or JPEG 2000 output.
1. Select a MrSID or JPEG 2000 format from the Output Format drop-down menu.
2. Click the Advanced button in the Properties tab.
The Advanced Job Options dialog box appears.
3. Select the Bands tab.
4. From the Color Space drop-down menu choose Grayscale.
A drop-down menu appears listing all the available bands in the source image.

5. Choose any single band from the drop-down menu.

Set other options on this tab or click OK.

You can select and map bands for RGB output in MG3, MG4, or JPEG 2000 format.
1. Select a MrSID or JPEG 2000 format from the Output Format drop-down menu.
2. Click the Advanced button in the Properties tab.
The Advanced Job Options dialog box appears.

3. Select the Bands tab.
From the Color Space drop-down menu choose RGB. Several drop-down menus

appear listing all the available bands in the source image.
5. Choose any three bands from the drop-down menus.

6. Click OK.

You can carry over all source bands to MG4 or JPEG 2000 output formats in their original order.
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Select MrSID Generation 4 or JPEG 2000 from the Output Format drop-down menu.
Click the Advanced button in the Properties tab.
The Advanced Job Options dialog box appears.

Select the Bands tab.
From the Color Space drop-down menu choose Same as source.

Set other options on this tab or click OK.

You can select and map more than three bands for MG4 output.

1.

2.

5.

Select MrSID Generation 4 from the Output Format drop-down menu.

Click the Advanced button in the Properties tab.

The Advanced Job Options dialog box appears.

Select the Bands tab.

From the Color Space drop-down menu choose Multispectral, then click Select Bands.

The Select Bands dialog box appears. By default, all bands are carried over from the

input list to the output list.

NOTE: The Alpha band is encoded losslessly and is not displayed in the list of
bands. For more information on Alpha bands in MrSID images, see Alpha
Options on page 111. For more information about Alpha bands in JPEG 2000
imagery, see Encoding with Alpha Bands in JPEG 2000 on page 187.

If the image contains red, green, and blue (RGB) bands, re-order the bands with the up
and down arrows so that these bands are at the top of the bands list, then select the option

to Apply RGB Color Transform to First Three Bands.

IMPORTANT: When you set the first three bands of the image as the
RGB bands and apply the RGB Color Transform, GeoExpress optimizes the
image compression ratio of each one of the RGB bands to create a smallerimage

without sacrificing visual quality.
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For more information on the RGB color transform, see The RGB Color Transform

on page 42.

6. Optionally, select the bands that you want to remove from the output image and click the

left arrow to remove them.

7. Click OK.

NOTE: For information on setting per-band compression ratios, see Specifying Per-

Band Compression Ratios on page 41.

Use the Zoom tab to select the number of zoom levels that you want in the output image or to

specify a target thumbnail size. For an MG3 or MG4 file you can also resample the image.

-108 -



Chapter 8: Advanced Job Options

I
&) Advanced Job Options . |

Input I OLrtertI Bandz Zoom |Alpha I Cuartization Funnat-SpedﬁcI

—Zoom Levels

" Number Of Zoom Levels

" Target Thumbnail Size

Reduce level of detail by a factor of: I vI

The number of zoom levels in an encoded image can be specified directly or it can be dependent
on the image size in relation to a specified target thumbnail size. The larger the image, the

greater the number of zoom levels it can contain.

By default, GeoExpress does not specify the number of zoom levels but uses a thumbnail size of
32 pixels instead. You may specify a higher value here, resulting in fewer zoom levels, or a lower
value, resulting in more. Alternatively you may specify a number of zoom levels or instruct the pro-

gram to use the maximum number of zoom levels the image can contain.

To specify the number of zoom levels, select the Number of Zoom Levels radio button and

drag the slider or enter the number of levels in the Zoom Level field.

Zoom level can be set to any value greater than zero for MG3 and MG4 and from three through

nine levels for MG2.
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NOTE: The full resolution (or base) image is called the zeroth level (Oth level) and is not
counted as one of the zoom levels. For example, setting the zoom level at three will res-

ult in three additional resolutions besides the base level.

To specify the target thumbnail size, select the Target Thumbnail Size radio button and enter a

dimension in pixels.

To allow GeoExpress to automatically calculate and use the maximum number of zoom levels
possible for an image, select the Use Maximum Zoom Levels for Image radio button. This

option is selected by default.

Resample an image to reduce the number of zoom levels in an MG3 or MG4 image. You might
resample an image for placement in an online catalog where you know it will only be displayed at

a certain maximum size.

The resampling operation copies zoom levels from an existing image to make a new image. As a

result, you can only resample images that meet the following criteria:

e Theimage must be in the MG3 or MG4 format.

o The output format for the image must be the same as the input format. For example, for
an MG3 input image, you can only create a resampled MG3 output image.

o Theimage must have been created as an optimizable image. By default, MG3 and MG4
images are optimizable.

¢ The resampling operation cannot be combined with other image manipulation operations
that require decoding the image data. For example, you cannot perform reprojection or
color balancing operations in the same job as a resampling operation. Instead, resample

the image, run the job, and then perform additional operations on the new image.
To resample an image, complete the following steps:

1. Click Advanced in the Properties tab.
Click the Zoom tab.
Select the Resample image option and select the factor by which you want to reduce the

level of detail.
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Resampling by a factor of two removes one zoom level and halves the image's width and height
so that the result has a fourth of the area of the original. Resampling by a factor of four removes
two zoom levels and quarters the image's width and height so that the result has one sixteenth of
the area of the original. The number of resampling factors available in the drop-down menu is

determined by the size of the original image.

Alpha Options

When you select MG4 as the image output format, you can use the Alpha tab to create or regen-
erate alpha bands. In MG4 images, the alpha band records which portions of your image do not

contain image data.

For MG2, MG3, and JPEG 2000 files you can specify no-data values in the Transparency tab.

&) Advanced Job Options

Input I Output I Bands I Zoom Apha | Quartization I Fonnat-Spedﬂcl

—Alpha Source when input image has no Alpha
i* Opague [ Despeckle Qutput

" Transparency Value (metadata) Despeckling Options
" Specify Value

Band | Walue
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Allimages encoded to MrSID Generation 4 (MG4) have an alpha channel or alpha band. If one is
present, GeoExpress uses the alpha band in the input image. If no alpha band is present in the

input image, then GeoExpress creates one.

The alpha band is always encoded losslessly, even if the rest of the image undergoes lossy com-

pression.

MG2 and MG3 do not support alpha channels, but the transparency information in the alpha band
of your source image is still preserved when encoding to MG2 and MG3. The alpha band will first

be applied to the source image and then discarded from the output file.

NOTE: For users of GeoExpress Standard Edition, the encoding of the alpha band does
not additionally decrement your data cartridge. Your encode job will be metered the

same with or without alpha bands.

All images encoded to MrSID Generation 4 have an alpha band.

1. Click Advanced in the Properties tab.
2. Click the Alpha tab.

3. Select the method that you want to use to create an alpha band.
You can select one of the following methods:

o Opaque. The Opaque method specifies that all pixels should be treated as valid
image data. By default the Opaque method is selected.

o Automatically Detect. In the Automatically Detect method, GeoExpress queries
the image metadata for the transparency values and treats all pixels with matching
band color values as transparent.

o Specify Value. You may specify transparency values for each band. GeoExpress
treats as transparent all pixels whose band color values match the specified values.

If you decide to specify a value for each band, you can use the color picker.

If your source image already has an alpha band, a Regenerate Alpha Band check box appears

at the bottom of this tab so that you can discard the existing alpha band. By default, GeoExpress
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uses and preserves a source image's alpha band. This option might be used if your alpha band is

corrupted or incorrect, in which case GeoExpress creates a new one.

Skip to Specifying a Compression Method on page 32.

Speckling is an artifact of lossy compression that causes pixels which should be transparent to dis-

play in the output.

For example, you may specify 0,0,0 as the alpha band values for an RGB image so that all of the
black pixels are made transparent. But in compression, the values of some pixels undergo slight
changes in value. The difference is not be visible to the eye, but a pixel whose RGB values are
0,1,0 0or 0,0,1, while it may still look black, no longer matches the specified transparency profile
and so it will not be rendered transparent. Where this happens, speckling can appear in the collar
regions of an image such as a DOQQ. In this case, select the Despeckle Output check box to

ensure that all of the pixels that should be transparent are treated correctly.

For more information and to manually set despeckling options, see The Despeckle Tool on page
61.

When you select MG2, MG3, or JPEG 2000 as the image output format, you can use the options
on the Transparency tab to define the color of transparency and background areas. One color

must serve for both the transparency and background values.

Y ou can specify colors based on the color space (RGB/grayscale) and color depth (8-bit/16-bit) of

the source image.
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*3 Advanced Job Options

Input I Cutput I Bands I Zoom  Transparency ISecuntyI Fomat-Specific

— Transparency and Background
¥ Set transparency (no-data) and background values

Band | Value |
Red 1]

Green 0
Blue 0

Edit Value: I
to selected | Apply to 3 |

Color Picker... |

Transparency and Background Color

The transparency and background color setting must be within the range of pixel values that the
image's data type supports (e.g. 0 — 255 for 8-bit images and 0 — 65,535 for 16-bit images). These

values are derived from the native metadata for an input image.
To select an alternate transparency and background color do one of the following:

o Enter RGB values for each band using the Edit Value field. Values can be assigned to

single or multiple bands.

e Select a color using the Color Picker.

The effects of the transparency options can be simulated in the Preview tab.
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NOTE: The MG4 format stores transparency in an alpha band whereas MG3, MG2, and
JPEG 2000 images map transparency to a specific color. If your input image is in the
MG4 format, and if the output format is MG3, MG2, or JPEG 2000, transparency is

mapped to the transparency color that you specify.

You can select an 8-bit RGB color value from the color palette or Color Picker if the source
image is an 8-bit RGB.

1. Click Color Picker. The Color dialog box appears with 48 color options displayed, includ-
ing black and white. If desired, custom colors can be added to the existing basic colors
palette.

2. Select the proper color from the displayed palette.

3. Click OK.

GeoExpress uses the standard Windows color picker interface, which allows you to add custom
colors. See your Microsoft Windows or Microsoft Office documentation for more information

about picking colors.

All images in the MrSID format are in either grayscale or RGB mode. Color images are RGB;
black-and-white images are grayscale. Any black-and-white image encoded by GeoExpress, if not
already in grayscale mode, is converted to grayscale; any color image, if not already RGB (for

instance, an indexed color image), is converted to RGB.

To specify a transparency pixel value, determine the RGB value of the transparency area in the
source image. Most commonly, this will be black (0-0-0) or white (255-255-255). If desired, use a
color-finder program to read the transparency RGB values. Once the RGB values for the trans-

parency area have been determined, they must be entered manually.

The RGB color scale for an 8-bit image, with values of 0-255 for the colors red, green, and blue, is
capable of accurately displaying 16,777,216 colors. An indexed color image selects colors from a
scale containing 256 colors. Each color in an indexed color image is specified using a value from 0

to 255.
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Due to the wide variety of indexed-color valuing systems available, a specific color in one indexed
color image can be given one value, while the same color in another image is given a different
value. For example, a color with a single RGB value may be given an indexed color value of 120

by one imaging application and 142 by another.

For this reason, any time the input or output transparency options are used with indexed color

images, the indexed color values must be read in as RGB and entered manually.

If desired, use a color-finder program to read the transparency RGB values.

When you select MG4 as the output format for a floating point image, you can use the options on

the Quantization tab to define a quantization precision value and other quantization options.

For more information on quantization, see Using Quantization for Floating Point on page 43.
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B dvanced Job Option® x|

Input I Output I Bands I Zoom I Alpha Quantization | Funnat-SpedﬁcI

—Quantization when input image is floating point type

Band | Precision | Mo-Diata | Min | Mz
Band 1 Auto Mot Set Auto Auto
Band Z Auto Mot Set Auto Auto
Band 3 Auto Mot Set Auto Auto
Band 4 Auta Mot Set Auta Auto

Precision MNo-Data i Max
|Auto |Not Set |Auto |Auto

| Applytoselected | Apply to all Reset all bands

Quantization Precision

When you compress a floating point image, GeoExpress automatically calculates the optimized

precision value to use for quantization. Alternatively, you can manually specify a precision value.

The pixel values of the compressed output image are accurate to within half of the precision
value. For example, there is a pixel in your floating point image that has a value of 3000. If you
specify a precision value of 0.5, then the same pixel after quantization will have a value between
2999.75 and 3000.25.

As a rule of thumb, you can calculate the optimized precision value used by GeoExpress with the

following formula:

Precision = (Maximum value - Minimum value) / 21°
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Whether you manually specify a precision value or allow GeoExpress to automatically calculate a
precision value, GeoExpress records the precision value used during quantization in the image
metadata. The precision value for each image band is stored in the IMAGE::QUANTIZATION _
SCALE metadata tag. The tag lists the precision value used for each band of the image, including

the alpha band. The last value in the metadata tag is for the alpha band precision value.

TIP: Open the output image in GeoExpress to view the image metadata. For more

information, see Viewing Metadata on page 48.

To set a precision value, enter a value in the Precision field of the Quantization tab. The pre-

cision value that you enter depends on the range of values in the input image.

You can specify one quantization precision value for all the bands in an image, or you can specify

individual precision values for each band.

In addition to the quantization precision value, you can specify the range of values that you want

GeoExpress to keep during quantization.

If the input image contains minimum or maximum values that are far removed from the rest of the
pixel values, then you may want to manually specify minimum and maximum values. For
example, if the input image contains a maximum value of 32,000, but does not contain any pixel
values between 20,000 and 32,000, then you may want to specify a maximum value of 20,000. In
this example, GeoExpress changes all pixel values greater than 20,000 to 20,000. If you manually
constrain the quantization range, you can improve the appearance of images that have very little

data near the minimum and maximum values.

To specify a range of values for quantization, enter minimum and maximum values on the Quant-
ization tab. You can specify one minimum and one maximum value for all the bands in an image,

or you can specify individual values for each band.

Many floating point images denote no-data values as an arbitrary minimum value. For example,

an image may use -9999 as the no-data value even though there aren't any pixel values between -
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9999 and 0.

Such large gaps in pixel values create an artificially wide dynamic range that may cause output

images to appear dark. For more information on dynamic range, see Dynamic Range Metadata

Generation on page 125. To ensure that output images display correctly, ensure that the no-data
value is specified in the metadata before you compress the image. If the no-data value is not in
the metadata, you can manually specify the no-data value in the No-Data field of the Quant-

ization tab.

GeoExpress enables you to lock your encoded MG2 and MG3 files with a password. MG4 does
not support security options. You can access password-protected files with the ExpressView
Browser Plug-in, which is included on your GeoExpress DVD and is optionally installed when you

install GeoExpress.
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&) Advanced lob Options

Input I Cutput I Bands I Zoom I Transparency Security | Fomat-Specific

—Password Protection

[~ Protect encoded image with password ¥ Hide typing

Passwaord: I

Confirm Passwaord: I

The Security tab includes a Protect encoded image with a password check box. If this check
box is selected you can then choose whether or not to hide the password typing with the Hide typ-

ing check box.

Notes
There is no way to access a password-protected file if you forget the password.

The password file is kept in the project file and stays with the project. Although a useful data pro-

tection feature, this is not a fully robust file security solution.
GeoExpress does not allow password-protected files to be used as input.

Only image data is encrypted; geocoordinates and other metadata are still accessible in pass-

word-protected files.
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To perform tasks specific to the MrSID and JPEG 2000 file formats, configure options on the
Format-Specific tab of the Advanced Job Options dialog box.

Use these advanced format-specific options to perform the following tasks:

Configure performance by changing the block size or strip height.

o Configure the display of an image by changing the weight values and sharpness.
o Generate dynamic range metadata for MrSID Generation 4 output images.

¢ Select and edit JPEG 2000 profiles.

For MrSID images, you can select different options for MrSID Generation 4, MrSID Generation 3,
and MrSID Generation 2 files.

NOTE: The options that you can see depend on the output format that you select.

You can use the options for the MG4 output format to configure the display of an image, con-

figure performance, and generate dynamic range metadata.

The following figure displays the options that you can select for the MG4 output format:
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&9 Advanced Job Options

Input I OLrtertI Bands I Zoom I Alpha I Quartization Format-Specific |
—Mr5ID Generation 4

Wweight: |2 Sharpness:
K-\wieight: I Block Size:

Freguency Balance: Strip Height:

v Optimizable

Estimated Memory Usage: 18 MBE

— Dynamic Range Metadata Generation

I Mone ;I

Weight

Weight affects the grayscale portion of a colorimage, which is the part of the image with no color
information. A higher weight setting increases the emphasis on this grayscale aspect of a color
image, while decreasing emphasis on color quality. A lower setting increases the consistency of

color between the MrSID image and the original data.

Images with high color contrast will benefit from a lower weight setting. Images with greater detail

benefit from a higher weight setting.
Acceptable values: 0.0-10.0

Default: 2
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Determines the emphasis for the K band of a CMYK colorimage. CMYK imagery with high color
contrast will benefit from a lower setting. A CMYK image with a high density of detail will benefit
from a higher setting. The practical range of values is 0.0 to 10 where 0.0 represents minimum
intensity (and maximum color consistency between the MrSID image and the original CMYK

data) and 10 represents maximum intensity.
Acceptable values: 0.0-10.0

Default: 0.25

Determines the emphasis given to edges and flat areas in color and grayscale images. Images
requiring precise edge definition will benefit from a lower setting. If precise edges are not as
important as consistency in flat color areas, increase this setting. The practical range of values is
0.1 to 10 where 0.1 represents maximum edge definition with less emphasis on flat areas, and 10

represents minimum edge definition with smoother areas of relatively consistent color.
Acceptable values: 0.0-10.0

Default: 2

Determines the sharpness of boundaries between different areas of an image. Images with large
amounts of textured area (where color or intensity changes are occurring throughout a region,
rather than just at a boundary) will benefit from a lower setting. Use a higher setting for images
with little textured areas. The range of values is 0.0 to 1.0 where 0.0 represents minimum sharp-

ness and 1.0 represents maximum sharpness.
Acceptable values: 0.0-1.0

Default: 0.0

GeoExpress accesses image data in 'blocks' of pixels.
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IMPORTANT: Blocks in MG3 and MG4 encoding are different from blocks in MG2
encoding. The block size parameter in MG3 controls how large the bitplane-encoded
regions are. Lowering this parameter may lower the memory usage of the encoder but
may also decrease the lossless compression ratio. Raising this parameter may
increase memory usage, but may improve the lossless compression ratio. This para-

meter has little effect on overall encode time. Typical values range from 32 to 64.

Acceptable values: 5 - 64

Default: 64

Strip height affects performance and memory usage. The strip height parameter controls how
many rows of the input image are processed at one time. Lowering this parameter may reduce
memory usage, but may increase the encoding time. Raising this parameter may increase
memory usage, but may also decrease encoding time. Unlike the block size, changing this para-

meter will not have any effect on the compression ratio of the output image.

Typical values range from 2 to 128. The encoder may perform more efficiently if the block size is a

multiple of the strip height.
Acceptable values: even integers between 2 and source image height

Default: 64

Determines whether the output MrSID file contains optimization data. By default the Optim-

izable check box is selected.

The option for optimizing images is specific to MG3 and MG4 files. When you optimize an image,
you make it possible to perform some image manipulation operations on the image without re-
encoding or recompressing the image. Image manipulation operations that benefit from optim-

ization include the following:

e Resampling

e Cropping
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e Demosaicking

o Area of interest encoding

Creating an optimized image does not affect encoding time. However, saving optimization data
for an image modestly increases the size of an image by approximately one to five percent. If
image size is critical and you do not plan to perform further image manipulation operations,

deselect the Optimizable option.

Select the Use Temp File option to allow GeoExpress to create temporary files during image

encoding. To specify the default directory for temporary files, see Preferences on page 159.

To improve the appearance of MrSID images in other GIS programs, use GeoExpress to write

dynamic range metadata for images.

You can generate dynamic range metadata for all images with the exception of eight bit images.
For an image where the dynamic range is less than the full range of possible values for the image,
you can use your GIS program to stretch the pixel values across the full range. For example, if you
have a 16-bit image and the dynamic range is 11 bits, then you may want to use dynamic range

stretching to improve the appearance of the image.

To calculate the dynamic range of an image, select a dynamic range generation method.
You can select one of the following methods for generating the dynamic range:
RGB

Calculate the minimum and maximum dynamic range values for an image with red, green, and
blue bands. Select the RGB method to minimize color shifting for RGB images. When you select
the rgb method, GeoExpress calculates the combined dynamic range of the red, green, and blue

bands.
Merged

Calculate the minimum and maximum dynamic range values for an image with multiple bands.

Select the Merged method to preserve the proportions of pixel values across bands. For

-125-



GeoExpress 9.5 User Manual

example, if you want to compare multiple bands in a multispectral image, you may want to select
the Merged method. When you select the merge method, GeoExpress calculates the combined

dynamic range of all bands.
Per-Band

Calculate the minimum and maximum dynamic range values for an image with one or more
bands. Select the Per-Band method to calculate the dynamic range of each band individually.
For example, if you have a multispectral image and you only want to view one band at a time,
select the Per-Band method. When you select the per-band method, GeoExpress calculates the

dynamic range of each band separately.
None

Do not calculate the dynamic range of the image.

NOTE: To enter the minimum and maximum dynamic range values manually, select
None as the dynamic range generation method and edit the image metadata. For more
information on entering dynamic range metadata manually, see Image Metadata on

page 48.

For 16-bit images with unsigned integer data, you can select either Automatic Range or Strict
Range. 16-bit images with signed integer data and all 32-bit images use the Strict Range

option. The following list describes the two ranges that you can select:

« Automatic Range. Set the maximum value to the estimated bit-depth and set the min-
imum value to zero. The estimated bit-depth is the next whole number of bits that contains
the calculated maximum value in the image. For example, if the maximum value in the
image is 3950, GeoExpress estimates that the image was taken with a 12-bit camera and
sets the maximum value to 4095. Because GeoExpress sets a wider dynamic range for the
image, you can minimize color shifting when you display the image.

o Strict Range. Set the maximum and minimum values to the exact dynamic range values

calculated by GeoExpress.
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Advanced MG3 Options

You can use the options for the MG3 output format to configure the display of an image, con-

figure performance, and set optimization options.

The following figure displays the options that you can select for the MG3 output format:

i . H-.
ﬁdmmm Job Options s

Input I Output I Eands I Zoom I Tmnsparenc'_.rl Securty Fomat-Specific I
—MrSID Generation 3

Wwieight: |2 Sharpness:

K-\leight: Block Size:

Frequency Balance: |2 Strip Height:

i~ 1-Pass Optimizer v Optimizable
¥ 2-Pass Optimizer

Estimated Memory Usage: 18 MBE

Weight

Weight affects the grayscale portion of a colorimage, which is the part of the image with no color
information. A higher weight setting increases the emphasis on this grayscale aspect of a color
image, while decreasing emphasis on color quality. A lower setting increases the consistency of

color between the MrSID image and the original data.
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Images with high color contrast will benefit from a lower weight setting. Images with greater detail

benefit from a higher weight setting.
Acceptable values: 0.0-10.0

Default: 2

Determines the emphasis for the K band of a CMYK color image. CMYK imagery with high color
contrast will benefit from a lower setting. A CMYK image with a high density of detail will benefit
from a higher setting. The practical range of values is 0.0 to 10 where 0.0 represents minimum
intensity (and maximum color consistency between the MrSID image and the original CMYK

data) and 10 represents maximum intensity.
Acceptable values: 0.0-10.0

Default: 0.25

Determines the emphasis given to edges and flat areas in color and grayscale images. Images
requiring precise edge definition will benefit from a lower setting. If precise edges are not as
important as consistency in flat color areas, increase this setting. The practical range of values is
0.1 to 10 where 0.1 represents maximum edge definition with less emphasis on flat areas, and 10

represents minimum edge definition with smoother areas of relatively consistent color.
Acceptable values: 0.0-10.0

Default: 2

Determines the sharpness of boundaries between different areas of an image. Images with large
amounts of textured area (where color or intensity changes are occurring throughout a region,
rather than just at a boundary) will benefit from a lower setting. Use a higher setting forimages
with little textured areas. The range of values is 0.0 to 1.0 where 0.0 represents minimum sharp-

ness and 1.0 represents maximum sharpness.
Acceptable values: 0.0-1.0

Default: 0.0
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GeoExpress accesses image data in 'blocks' of pixels.

IMPORTANT: Blocks in MG3 and MG4 encoding are different from blocks in MG2
encoding. The block size parameter in MG3 controls how large the bitplane-encoded
regions are. Lowering this parameter may lower the memory usage of the encoder but
may also decrease the lossless compression ratio. Raising this parameter may
increase memory usage, but may improve the lossless compression ratio. This para-

meter has little effect on overall encode time. Typical values range from 32 to 64.

Acceptable values: 5 - 64

Default: 64

Strip height affects performance and memory usage. The strip height parameter controls how
many rows of the input image are processed at one time. Lowering this parameter may reduce
memory usage, but may increase the encoding time. Raising this parameter may increase
memory usage, but may also decrease encoding time. Unlike the block size, changing this para-

meter will not have any effect on the compression ratio of the output image.

Typical values range from 2 to 128. The encoder may perform more efficiently if the block size is a

multiple of the strip height.
Acceptable values: even integers between 2 and source image height

Default: 64

This option is only available for MrSID Generation 3 (MG3) images. The 1-pass and 2-pass optim-
izer parameters affect encoding performance and memory usage. Although not as fast as the 1-
pass optimizer, the 2-pass optimizer requires much less memory because it splits the encoding

operation into two passes. This is required for very large files.

Note that the Estimated Memory Usage value is only displayed when the 2-pass optimizer is

used.
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The 2-Pass optimizer is automatically used for Area of Interest encoding even if this check box

has not been selected.

By default the 2-Pass Optimizer is used.

NOTE: Encoding with the 1-Pass Optimizer is faster but requires that the entire image
be loaded info memory. If the computer does not have enough memory, the job does not

succeed.

Determines whether the output MrSID file contains optimization data. By default the Optim-

izable check box is selected.

The option for optimizing images is specific to MG3 and MG4 files. When you optimize an image,
you make it possible to perform some image manipulation operations on the image without re-
encoding or recompressing the image. Image manipulation operations that benefit from optim-

ization include the following:

Resampling

Cropping

Demosaicking

o Area of interest encoding

Creating an optimized image does not affect encoding time. However, saving optimization data
for an image modestly increases the size of an image by approximately one to five percent. If
image size is critical and you do not plan to perform furtherimage manipulation operations,

deselect the Optimizable option.

Select the Use Temp File option to allow GeoExpress to create temporary files during image

encoding. To specify the default directory for temporary files, see Preferences on page 159.

You can use the options for the MG2 output format to configure the display of an image, con-

figure performance, and generate image statistics.
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The settings for weight and g-weight affect the color quality and line definition of encoded MrSID
files. These two settings can be adjusted independently of one another. The weight setting does
not affect grayscale images whereas the G-weight setting affects both color and grayscale

images.

The following figure displays the options that you can select for the MG2 output format:

x

B :
&) Advanced lob Options

Input I Output I Bands I Zoom I Tlansparenc'_.rl Securty Fomat-Specific
—Mr5ID Generation 2

Weight: ¥ Image Enhancement
G-Weight: [T Image Statistics
[T Block Size:

Estimated Memory Usage: 21 ME

Weight

Weight affects the grayscale portion of a colorimage, which is the part of the image with no color
information. A higher weight setting increases the emphasis on this grayscale aspect of a color
image, while decreasing emphasis on color quality. A lower setting increases the consistency of

color between the MrSID image and the original data.
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Images with high color contrast will benefit from a lower weight setting. Images with greater detail

benefit from a higher weight setting.
Acceptable values: 0.0-10.0

Default: 2

The G-weight parameter increases or decreases the definition of edges in an MG2 image. A lower
setting for G-weight creates more defined edges with less emphasis on flat areas. A higher set-
ting creates softer edges while smoothing the image in flatter areas with relatively consistent

color.

In applications requiring precise edge definition, decrease the setting for G-Weight. If precise

edges are not as important as consistency in flat color areas, increase the setting for G-Weight.
Acceptable values: 0.0-10.0

Default: 2

MrSID accesses image data in 'blocks' of pixels. Blocks in MG2 encoding are different from blocks
in MG3 and MG4 encoding.

Different block sizes affect system resources. While a smaller block size in MG2 encoding uses
less RAM, the opening and closing of multiple image blocks may impact a system in other ways,
sometimes resulting in an encoding failure. If sufficient RAM is available, a larger block size is

recommended for encoding projects approaching or exceeding a gigabyte in size.

By default, GeoExpress automatically selects a block size for MG2 encoding based on a cal-
culated memory usage curve that is dependent on the input image. The block size corresponding

to the lowest point in the memory curve is selected.

Block size may be set manually by selecting the Block Size check box and entering a value in the
field that becomes available. When compressing imagery in excess of a gigabyte in size, use a
block size of 1024. For imagery equal to or greater than three gigabytes, a block size of 2048 is

recommended.
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Changing the block size setting will not affect the rate of compression or the quality of the output

image.

Minimum value: 32.

The Image Enhancement option improves the appearance of some images by adding inform-
ation to the images. This means that pixels of different colors are added to the areas of flat color
to make the artifacts less visible to the eye. The appearance of the resulting images may appear
softer. This option is particularly useful for images that have large areas of similar color or con-
tinuous tone, such as a large blue sky, or a single background color where artifacts may become

perceptible.

By default, image enhancement is enabled. LizardTech recommends that you experiment with a

variety of images to determine which images benefit from this option.

The Image Statistics option collects basic numeric statistics about the image's samples. Data
collected includes the minimum, maximum, mean, and standard deviation of the samples for

each band. The metadata tags that are added to the output file are:
IMAGE::STATISTICS:MAX

IMAGE::STATISTICS:MEAN

IMAGE::STATISTICS:MIN
IMAGE::STATISTICS:STANDARD_DEVIATION

By default, image statistics is disabled.

For JPEG 2000 images,you can select JPEG 2000 profiles and other options.
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]

& Advanced Job Options

Input I OLrtertI Bands I Zoom I Transparency Fomat-Specific |

—Profiles
Selected Profile: None Select A Profile... | Save Profile... |

—JPEG 2000

—Tile Size——— Tile Parts ———— Progression Order: IHF‘EL - I

g Group By:
W Use Tile Size ¥ Flush Period: |4'|:|'5'E

¥ Resclution
\whidth:
i I-ill]-ﬂ-E I Laver ¥ Tile Length Markers: |25~5

Height: I‘i'l:l'ﬂIE [T Component ¥ Use Packet Length Markers

—Codeblock Size —— Q IJE“W Lﬂ}’ﬂrﬂ: Iaﬂ— I_ ze 5-7 Wavelet [lﬂSS'}ﬂ

width:  [58 .
' o Strip Height: |12 Precincts... |
Height: |ﬁ4
Bits Of Precision: [5 v GMLJP2 Metadata.. |

IMPORTANT: The information included below is provided with the assumption that the
user is familiar with the JPEG 2000 standard. Parameter choices accommodated by the
JPEG 2000 specification are of such a broad and varied range that it is possible for
users to select settings that prove counterproductive to their goals. In particular, some
optimal settings can result in degraded decode performance. Considerable trial and error
may be required to achieve desired results when diverging from defaults and recom-

mended settings.

When JPEG 2000 is selected as the output file type, the following advanced options are avail-

able:
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This panel enables you to invoke a list of supported profiles comprised of preset encoding options
for particular workflows, and to save your own custom profiles. For more information see Using
JPEG 2000 Profiles on page 139.

If enabled, the tile size must be no larger than the dimensions of the source image. Smaller tiles
reduce the amount of memory required to encode the image, however the use of tiles may intro-

duce edge artifacts.

Default: 4096 x 4096.

Specifies the organization of tile parts in the codestream. Tile parts can be grouped by resolution,

layer or component, depending on which progression order you use.

Some progression orders preclude grouping by one or more of the options. For example: the fact-
ory default progression order of RPCL sets the Tile Parts option to Resolution, while making

the Component option available and the Layer option unavailable.

JPEG 2000 codeblock size is subject to the following restrictions:

o width and height must be powers of two

o width and height must be greater than 4

o width x height must be less than 4096

¢ width and height must be less than width and height of tile size

o width and height must be less than width and height of image if tile size is not specified

The default codeblock value is 64 x 64.

This value indicates the number of quality layers with which to encode the image. Among other
things, quality layers enable better “streaming” (progressive transmission and display) in some

applications.
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Default: 30

Affects memory usage. Increasing this value may improve runtime performance, but at a cost of
requiring more physical memory. This value should be decreased when encoding very large

images. Changing the strip height does not affect the quality of the output image.

Default: 12

Enables you to choose how many significant bits are to be used from the samples of the source
imagery. For example, an image may consist of 16-bit data values, but only eleven of those bits

may be meaningful.

Default: Enabled

When codestream flushing is enabled, less memory may be required to encode the image. The
flush period should be on the order of the strip height being used. Using the flush period should

not significantly affect output image quality.

Default: 4096

May have a significant impact on the time and memory usage required to encode and/or decode

the image. Different progression orders should be used for different target workflows.

Default: RPCL

Determines whether or not Tile Length Markers (TLMs) are to be put into the JPEG 2000

codestream. Use of TLMs may provide better decode performance.

Default: 255
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Enables or disables the use of packet length markers. Use of packet length markers may improve

decoding performance.

Default: Enabled

Specifies that the floating point 9-7 wavelet be used for encoding, instead of the default integer 5-
3 wavelet. The 9-7 wavelet will not encode an image losslessly, however, it may result in a better

looking image at higher compression ratios. This option is disabled by default and is only available
when the "Encode Losslessly" option is not selected. By default, the NPJE and EPJE profiles use

the 9-7 wavelet.

The table below indicates GeoExpress’ original or “factory” default JP2 settings. Unless you have
changed your JPEG 2000 preferences, they are the settings that will serve as defaults for your

JP2 encoding.

To edit preferences, see Setting Preferences on page 159.

Default JP2 Settings
Option Setting
Use of tiles Enabled
Tile Size 4096 x4096
Quality Layers 30
Strip Height 12
Flush Period 4096
Progression Order RPCL
Width: 64
Code Block Size
Height: 64
Tile Length Markers 255
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Option Setting
Tile Parts By resolution
Packet Length Markers Enabled
9-7 Wavelet (Lossy) Disabled
Precincts 256 x 256

Metadata Forms Included in Output

MrSID, World file,
GeoTIFF (GeoJP2)

Using precincts may improve the performance of decode operations for certain image encodings

such as those in which tiles are not used. The Precinct Editor enables the user to enter precinct

sizes for all of the zoom levels of the image.

Default: GeoExpress uses precincts in which width and height values are both 256.

To access the Precincts Editor:

1. Make sure that JPEG 2000 is selected as the output format.

2. Click Precincts... on the Format-Specific tab of the Advanced Job Options dialog

box.

The Precincts Editor dialog box appears.

To disable use of precincts, clear the Use Precincts check box.

To edit a precinct value:

1. Access the Precinct Editor as described above.

2. Select a precinct number in the precinct list and click Edit Precinct.... A new editing dia-

log box appears.

3. Change width and height values and click OK.

Precinct sizes must be powers of two, except for the last one in the list, which has the lowest res-

olution.
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Click the GMLJP2 Metadata button to write GML metadata to the JPEG 2000 image or to spe-
cify a GML data file.

When the GMLJP2 check box is selected, GML metadata is added to the output file according to
the GMLJP2 Application Schema version 3.1.1., which can be found at http://s-

chemas.opengis.net/gml/.

If you would rather use an external file that contains all the coverage and other GML data, you

may specify that file when the "Write GMLJP2 metadata box" check box is cleared.

By default this check box is selected.

If an external world file is present, its information trumps any metadata. Absent a world file,

metadata are evaluated in the following order of priority:

GMLJP2
GEOJP2/GEOTIFF
MrSID metadata

> 0w Dd =

World file metadata

NOTE: If a world file is present, then no coordinate reference system is associated with
the output file (a NULL WKT is applied).

GeoExpress includes a selection of industry accepted profiles — groups of preset JPEG 2000
encoding options for particular workflows — and an interface for managing them. The Profile Man-

ager enables you to select and edit profiles and create and save new ones.

1. Make sure JPEG 2000 is selected at the output file format.
2. Click the Advanced button on the Properties tab.

3. Click the Format-Specific tab.
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4. Clickthe Select A Profile... button in the Profiles panel.

The Profile Manager appears.

In the Profile Manager, select a profile from the drop-down menu and click OK. The selected pro-

file is listed on the Format-Specifc tab and the options are set to match the profile.

GeoExpress provides profiles composed of preset encoding options for particular workflows.
These are EPJE, NPJE, Large Image, Large Image without TLMs, and Default. In the current
implementation of GeoExpress, the EPJE profile is identical to the NPJE profile except for pro-
gression order. The profile named Default is not the same as the default GeoExpress encode set-

tings.

When a profile is selected from the drop-down list, it may display a user-defined description in the

Description field to help identify it. Clicking OK applies a selected profile.

You can also choose to load a custom profile stored anywhere on your network.

NOTE: Selecting “(None)” from the profile list sets the JPEG 2000 options to the

defaults set in the GeoExpress preferences.

EPJE

Stands for "Exploitation Preferred JPEG 2000 Encoding". The EPJE profile sets the values to the
encoding parameters preferred by the National Geospatial-Information Agency (NGA) for image

exploitation.
NPJE

Stands for "NGA Preferred JPEG 2000 Encoding". The NPJE profile sets the values to the encod-

ing parameters preferred by the National Geospatial-Intelligence Agency (NGA) for archiving.
Large Image

This profile is optimized for encoding very large images.

Large Image w/o TLMs

This profile disables tile length markers for better rendering in viewers that don't support them.
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Default

This profile represents LizardTech's general purpose JP2 encode settings, determined at the SDK

level. These are NOT the same as the GeoExpress factory default encode settings, which are

recommended for large images.

NOTE: The NPJE and EPJE standardization process is not yet complete. These pro-
files use settings that are compliant with the NPJE and EPJE standards as the NGA cur-
rently defines them; however, if the specifications for the standards change, files
encoded using the current NPJE and EPJE profiles may not be compliant with the final-
ized standards. As the standards evolve, LizardTech will make available updated pro-
files (XML files) to reflect any changes to the standards. Contact your LizardTech sales

representative to learn more.

After a profile is selected and applied, the profile name appears in the Selected Profile field on
the Advanced tab. If any encode settings are modified after applying a profile, the Selected Pro-
file field indicates that the current settings differ from the original profile settings, unless no pro-
file was selected. For example, if you apply the EPJE profile and change one or more options, the

profile is now listed as EPJE (modified).

You can save the current encode settings as a custom profile.

1. Onthe Format-Specific tab of the Advanced Job Options dialog box, click Save Pro-

file....
The Save Profile dialog box appears.

Enter an output file name and a name for the profile if desired.
Optionally, add a description.
4. Click OK.

You can only save a profile if all of the encode parameters are discrete and unambiguous values.
The default location for user profiles on Windows is "C:\Documents and Settings\<user

name>\My Documents\LizardTech\GeoExpress\9\profiles". Any profiles in this directory will auto-
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matically be available in the profile selector's drop-down list. To save a profile, you must enter a

unique profile name.

1. Access the Profile Manager as described above.

2. Click Load Custom Profile... and browse for the desired custom profile, then click
Open.

3. Optionally, add a description and click OK.

A profile is a collection of settings, not a singular entity. After a profile is applied to a job, only the
particular settings — not the profile — are saved in the job. The profile itself is stored on disk. If a
profile is edited or deleted after it is applied to a job, those changes are not retroactively applied

toward any existing encode jobs.

Not all of the settings in the dialog are preserved in a profile — only the ones that affect how the
output file is encoded. Most notably, thumbnail size and strip height are not included in the profile
system. Profiles are used to store information about what JPEG 2000 options were used in choos-
ing the organization of the file format (algorithmic codec settings), not encoder implementation
choices. Changing the strip height or thumbnail size does not affect the layout of the file, since

they are really encoding performance parameters.
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A mosaicis a group of images or point clouds that you want to view together. Each of the images

or point clouds that make up a mosaic is called a tile.

You can manage the tiles in a mosaic to add tiles, remove tiles,or change the order of tiles. For

raster images, you can also crop tiles.

For raster mosaics, you can perform the same manipulation operations that you perform for single

images. For example, you can crop or despeckle a raster mosaic.

NOTE: You can only create LIDAR mosaics in the MrSID Generation 4 format.

Use the Create New Mosaic button in the toolbar to create a mosaic. The mosaic options that

you can select depend on the mosaic format that you select.

s
1. Click the Create New Mosaic Lo button in the toolbar.

The Create New Mosaic dialog box appears.

2. Select the mosaic type. You can select either Raster or LIDAR.
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3. Click Browse to select the directory where you want to save the mosaic, and enter a file

name for the mosaic.
If the mosaic is a LIDAR mosaic, click OK.

4. Forraster mosaics, select the mosaic output format that you want to use in the Format

drop-down.

For more information on mosaic formats, see Mosaic Output Formats on page 144.

5. Optionally for raster mosaics, select Enable multiresolution mosaicking to create a

mosaic from input files with different image resolutions.

For more information, see Multiresolution Mosaics on page 146.

6. Optionally for raster mosaics, select Allow multiple projection systems to create a

mosaic from input files with different projection systems.

For more information, see Mosaics with Multiple Projection Systems on page 146.

7. Forraster MrSID mosaics, select the flat or composite mosaic option. For NITF mosaics,

select the mosaic option for single or multiple image segments.

For more information, see Mosaic Output Formats on page 144.

8. Click OK.
The Select tiles dialog box opens.

9. Select one or more images that you want to add to the mosaic and click Open.

NOTE: Because images with different compression types and color lookup tables can
be combined when multiple images are joined together, color lookup table information

may not be reported forimage mosaics.

GeoExpress can create raster mosaics in the MrSID format, the JPEG 2000 format, and the

NITF format. GeoExpress can create LiDAR mosaics in the MrSID Generation 4 format.

If you create a mosaic from existing MrSID images or JPEG 2000 images, GeoExpress does not

deduct data from the data cartridge. Additionally, if you create a mosaic from NITF files that
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contain JPEG 2000 images, GeoExpress does not deduct data from the data cartridge. For more

information on output formats, see Supported Output Formats on page 30.

Use the MrSID file format to create flat mosaics and composite mosaics. A flat mosaic is a single
image that you create from multiple input images. A composite mosaic is a group of images that

display as a single image.

When you create a flat mosaic, GeoExpress creates a single image from the input tiles. Because
a flat mosaic is a single image, it displays more quickly than a composite mosaic. You can per-

form any image manipulation operation on a flat mosaic that you can perform on a single image.

When you create a composite mosaic, GeoExpress creates a MrSID file that contains multiple
input tiles. You can only create composite mosaics out of input tiles in the MrSID format. To cre-
ate a composite mosaic out of images in other formats, first convert the input images to the

MrSID format, then create a mosaic out of the MrSID files.

Because a composite mosaic is a container for existing files, you can create a composite mosaic
without running an encoding operation. Use composite mosaics when you want to create mosaics

quickly, for example, when you want to create mosaics from large input tiles.

A composite mosaic in the MrSID Generation 4 (MG4) format can only contain MG4 input tiles. A
composite mosaic in the MrSID Generation 3 (MG3) format can contain MG3 and MG2 input

tiles.

An MG4 composite mosaic contains an overview image for viewing at low resolutions. As a result,
MG4 composite mosaics display more quickly than MG3 or MG2 composite mosaics. However,

MG4 composite mosaics may take slightly longer to create.

When you create mosaics in the JPEG 2000 format, GeoExpress runs an encoding operation that
creates a single image from the input tiles. JPEG 2000 mosaics are equivalent to flat

MrSID mosaics.
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Use the NITF file format to create mosaics with single or multiple image segments. An image seg-
ment is an image in a NITF file. When you create a mosaic in the NITF file format, you can com-
bine the input tiles into a single image or you can add each image to the NITF file separately. If
you add images to the NITF file separately, the mosaic is called a multiple image segment
mosaic. If you combine the input images into a single image, the mosaic is called a single image
segment mosaic. A mosaic made up of a single image segment is equivalent to a flat

MrSID mosaic. A mosaic with multiple image segments is similar to a composite mosaic in that it
preserves the information from each input tile. However, multiple image segment mosaics require

an encoding operation unlike composite mosaics, therefore they take longer to create.

A multiresolution mosaic is a raster mosaic made up of input images with different resolutions.
When you create a multiresolution mosaic in any format, the resulting mosaic is a single image, in
other words, it is a flat mosaic. The exception to this is the MrSID Generation 4 (MG4) format.
You can create an MG4 composite mosaic out of multiresolution images if all of the input tiles are

also in the MG4 format.

To add images with multiple resolutions to a mosaic, select the Enable multiresolution mosa-
icking option when you create the mosaic. To select this option after you create a mosaic, com-

plete the following steps:
1. Select a mosaicin the Job List.
2. Click Advanced in the Properties tab.
The Advanced Job Options dialog box appears.

3. Inthe Output tab, select Enable multiresolution mosaicking.

GeoExpress can create raster mosaics out of images with multiple projection systems. However,
because images with different projection systems display discrepancies in their positioning,

GeoExpress reprojects all of the images to the same coordinate reference system (CRS). By
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default, GeoExpress reprojects images to the WGS 84 projection system. To use a different pro-

jection system, see Reprojecting an Image on page 86.

To add images with multiple projection systems to a mosaic, select the Allow multiple pro-

jection systems option when you create the mosaic. To select this option after you create a

mosaic, complete the following steps:

1.

2.

Select a mosaicin the Job List.
Click Advanced in the Properties tab.
The Advanced Job Options dialog box appears.

In the Output tab, select Allow multiple projection systems.

NOTE: When you select Allow multiple projection systems, GeoExpress also

selects the Enable multiresolution mosaicking option. Because reprojecting an

image changes the geographic area covered by the image, reprojection often changes

the resolution of an image. As a result, GeoExpress automatically selects the Enable

multiresolution mosaicking option to correct discrepancies in image resolution.

If one or more of the tiles in the mosaic does not have a valid CRS, or if you are using world files,

you can manually assign a CRS to each tile in the Tile Manager. For more information, see

Assigning a CRS to Tiles on page 150.

Manage the tiles in a mosaic job to complete the following tasks:

Add tiles to the mosaic job.

Remove tiles from the mosaic job.

Change the order of tiles. If tiles in a mosaic overlap, the mosaic displays whichever tile
you place lower in the tile list.

Crop the tiles in a raster mosaic.

Assign a coordinate reference system (CRS) to individual tiles of a raster mosaic. This
option is only available if you have enabled multiple projections for the mosaic. For more

information, see Mosaics with Multiple Projection Systems on page 146.
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You can manage tiles in the Tile Manager. To access the Tile Manager, right-click a mosaic in
the Job List, and click Tile Options. Alternatively, click the Options menu and select Tile

options.

The following figure shows the Tile Manager:

a'ﬁle Manager | 2|

Tiles:

ages GeobBpresst Sampleimagen® 1ltet 444707 sid Add Tiles. .. |
ages GeobBpresst Sampleimagen 1 ltet 444737 sid
ages GeobBpresst Sampleimagen 1 0tet 455707 sid

ages Geobxpressh Samplelmageny™ 1 (tet 455722 =id e |
ages Geobpress Sampleimagen® 10tet 459737 sid
agesGeo E::pres -..Samplelmager'_.r'ﬂﬂt474?D?.5|d Remove Al Tiles |

agesGeoBxpresst Samplelmageny 1 et 474722 sid
ages Geobxpressh Samplelmageny™ 1 (tetd 74737 =id
ages Geobpresst Sampleimagen® 10tet 485707 sid |

5ges'GeoExpress’.Sample Imageny. 1 0tet 489722 sid Crop Tile. .
ages GeobBpresst Sampleimagen 1 0tet 435737 sid
ages Geobxpressh Samplelmageny™ 1 0tet 504707 sid
ages GeobBpresst Sampleimagen® 10tet 504 722 sid
ages Geobpresst Sampleimagen 10tet 504737 sid Assign... ‘

Coordinate System

] | 10 [ ¥

Remaove. .. ‘

Tile Coordinate Reference System:
MADS3 / UTM zone 10N (26510)

Move Up Move Down oK Cancel |

NOTE: The Tile Manager is for raster mosaics only. However, you can manage raster

and LiDAR mosaics quickly from the Job List:

e Dragtiles into the Job Listto add them to a mosaic.

e Right-click a mosaic tile in the Job List and click Remove to remove it from the
mosaic.

e Click and drag tiles in the Job Listto change their order.

Adding Tiles

1. Right-click the mosaicin the Job List to which you want to add tiles and click Tile

Options.

The Tile Manager appears.
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2. Click Add Tiles.
3. Select one or more images that you want to add to the mosaic and click Open.
4. Click OK.

TIP: Alternatively, for raster and LIDAR mosaics, drag images into a mosaic in the Job

List from your system's file manager.

1. Right-click the mosaicin the Job List to which you want to add tiles and click Tile

Options.
The Tile Manager appears.

2. Select one or more tiles that you want to remove from the mosaic job and click Remove

Tiles.
Alternatively, click Remove All Tiles to clear the tile list.

3. Click OK.

TIP: To remove raster and LIiDAR tiles quickly, select tiles in the Job List and press
Delete.

1. Right-click the mosaicin the Job List to which you want to add tiles and click Tile

Options.
The Tile Manager appears.

2. Select one or more tiles and click Move Up or Move Down.
Alternatively, drag the selected tiles to another place in the tile list.

3. Click OK.

NOTE: If tiles in a mosaic overiap, the mosaic displays whichever tile you place lower in
the tile list.
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TIP: To move raster and LIDAR tiles quickly, select tiles in the Job List and drag them

to another position.

1.

Right-click the mosaic in the Job List to which you want to add tiles and click Tile

Options.

The Tile Manager appears.

2. Select atilein the tile list and click Crop Tile.
The Image Crop dialog box appears.

3. Select a cropping format and enter a crop region.
Alternatively, click Show Image to select a cropping region using the graphical cropping
tool.

4. Click OK.

For more information on cropping images, see The Image Crop Tool on page 64.

NOTE: You can only crop the tiles of a raster mosaic.

You can only assign a CRS to tiles if you have enabled multiple projection systems for the

mosaic. For more information, see Mosaics with Multiple Projection Systems on page 146.

1.

Right-click the mosaic in the Job List to which you want to add tiles and click Tile

Options.

The Tile Manager appears.

Select one or more tiles in the tile list and click Assign.
The Coordinate Reference System Selector opens.

Select a CRS from the System drop-down or select Use Custom WKT to select a well

known text (WKT) string.

NOTE: You can only assign a CRS to raster tiles.
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Most raster image manipulation operations that you can perform are the same for mosaics and for

single images.

However, when you perform color balancing for a raster mosaic you can also perform additional
color corrections to match the appearance of tiles to each other. You can perform color balancing

for mosaics with the following output formats:

e MrSID Generation 4
¢ MrSID Generation 3
« JPEG 2000

e NITF

For the MrSID output formats, you can only perform color balancing for flat mosaics. For the

NITF format, you can only perform color balancing single image segment mosaics.

When you preview a mosaic, you can preview individual tiles or selected tiles.

When you perform color balancing for mosaics, you can perform uniform corrections, non-uniform
corrections, and automatic corrections.You can apply corrections to the RGB bands or the Gray-

scale band, and you can apply multiple corrections to the same mosaic.

For more information on the types of corrections that you can apply, see The Color Balance Tool

on page 79.
1. Select a mosaicin the Job List.

2 Click the Color Balance button ¥ on the toolbar.

The Color Balance Manager appears.
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Uniform Comections | Non-uniform Comections I

Band: I Intensity hd l

Min: ID Gamma: I'I.DD Molanc: |4112

g s

R

¥ Enable Live Updating

Reset All Corrections | Band Selector... |

—Automatic Corrections
Correction Method: I Ll

rTile Selector Opti
Tile |Name > i L pRucee

Tile8_rgbn sid Qutline Calor: -
Tiel]_robn sid Highliaht Color: [N

1
2

3 Tile12_rgbn sid ] ]
4 Tile7_ngbn.sid ¥ Show Tile Qutlines

Select All Tiles

Deselect &ll Tiles

0K

3. Select the color balancing corrections that you want to perform and select the tiles to
which you wan to apply the corrections. Select tiles in the tile list or click the Tile Select
button to select tiles in the preview image.

o To perform uniform corrections, click the Uniform Corrections tab. Select one or
more tiles that you want to correct. If you do not select a tile, the corrections that
you perform are applied to all the tiles.

e To perform non-uniform corrections, click the Non-Uniform Corrections tab and
select one or more options.

o To perform automatic corrections, select a correction method from the Automatic
Corrections panel in the lower left corner of the Color Balance Manager. Then,
click Apply Corrections.

4. Click OK.
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NOTE: Uniform corrections will be more effective among image tiles composed of sim-
ilar ground cover types than, for example, an array of tiles showing dense urban devel-
opment and vegetation or bodies of water, and may require additional manual
manipulation to make the tiles match their neighbors. Automatic corrections work on a
tile by tile basis, so any boundaries, seams, or lens effects that occur inside of a tile will

still be visible regardless of uniform corrections.

Select a raster or LIDAR mosaic in the Job List and click the Preview tab to preview all the tiles
in the mosaic. Alternatively, select one or more tiles in the Job List that you want to preview.

[ E—
For raster mosaics, when you select bands using the Band Selector button ===, your selections

apply to all of the tiles in the mosaic, even if only one tile in the mosaic is selected.

When you crop a raster mosaic, the preview image only displays the cropped area of the image. If
you select a tile in the Job List that is not included in the cropped area of the image, the preview

image is blank.

For more information on the preview tab, see Preview Tab on page 21.

For raster mosaics, you can create a composite mosaic to update one part of an image with new
imagery. This is useful when, for instance, a particular region of an aerial photo mosaic needs to
be updated because of building development or other geographic changes but an entire new
image set is not needed. By updating just the affected image tiles geospatial image users can

keep pace with geographic changes without constantly acquiring new image data for every region.

To update an image, create a new raster mosaic and select the composite mosaic option.

NOTE: Updating an image or set of images results in a flattened mosaic if flattening is

specified by the user or if tiles of differing resolutions are used.

If two or more tiles in a raster mosaic overlap, the resulting mosaic displays whichever tile you

place lower in the Job List.
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If you create a mosaic out of overlapping tiles and the tiles are compressed images, despeckle the

tiles to minimize compression artifacts between image tiles. For more information, see The

Despeckle Tool on page 61.

If the transparency borders of individual tiles obscure image data in neighboring tiles, set trans-
parency values for the mosaic. For example, when images are geographically rectified to align
accurately with a fixed point such as magnetic North, the images appear tilted and contain bor-
ders of transparency along the edges. For more information on setting transparency values, see

Transparency Options on page 113. The following figure shows an example of a mosaic with over-

lapping transparency borders:

Mosaics with GeoTIFF Images

If you create a mosaic that contains GeoTIFF images, you can select the georeferencing inform-
ation that you want to use. A GeoTIFF image can store georeferencing information in a TIFF
world file and in embedded metadata. If the GeoTIFF image has georeferencing information
stored both in a world file and in its metadata, GeoExpress uses the embedded metadata by
default. To use the georeferencing information in the world files, select the Allow World Files
to Override Native Georeferencing preference. For more information on setting preferences,

see Preferences on page 159.

If you encode a GeoTIFF image using georeferencing information from a TIFF world file, other
spatial referencing information such as the coordinate reference system (CRS) found in the

GeoTIFF metadata tags is saved in the MrSID metadata. In a mosaic composed of both TIFF
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and GeoTIFF images, GeoExpress saves metadata in the mosaic if the first input tile is a

GeoTIFF image with metadata.

Rather than use GeoExpress to select images or point clouds that you want to mosaic, you can
create a text file which lists the images and point clouds that you want to mosaic. For raster mosa-
ics, the text file must have a .mos extension. For LiDAR images, the file must have a .list exten-

sion.

For raster mosaics, you can create mosaic lists for images that do or do not have gereferencing

information. For LIDAR mosaics, the images must have georeferencing information.

By default, the output image from a mosaic list is written to the directory where the mosaic list file

is located. The file is given the same name as the mosaic list file, but with a ".sid" extension.
To add a mosaic list file, complete the following steps:
Lo
1. Clickthe Create New Mosaic button ™ on the toolbar.
The Create New Mosaic dialog box appears.

Select a mosaic type and mosaic options.
Click OK.

Select All Files from the “Files of type:” drop-down menu.

o A~ DN

Select the mosaic file and click Open.

For georeferenced images and point clouds, the text in the mosaic list file contains the file paths
of the images that you want to mosaic. In the following example, a mosaic is created from four

TIFF files: "image_nw.tif", "image_ne.tif", "image_sw.tif", and "image_se.tif".

Ensure that each image has an associated *.tfw file (the names of the corresponding files must
match exactly, differing only in the .tfw file extension). This *.tfw file must be in the same directory

as the file to which it refers. A sample file for this project is:
C:\maps\image nw.tif
C:\maps\image ne.tif

C:\maps\image sw.tif
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C:\maps\image se.tif

When presented with a list of images, GeoExpress immediately looks for corresponding geor-
eferencing information. The “Input File Size” and “Target File Size” reflect both the on-disk size of
the source data and the estimated output file size of the full mosaic. When encoded, the images

are combined in a seamless mosaic based on the information given in the georeferencing files.

NOTE: GeoExpress does not recognize mosaic list files with spaces in either the listed
file names or in the listed paths. In addition, the first line in the file cannot be blank and

the last line in the file must be followed by a carriage retumn.

When creating a raster mosaic using images with no georeferencing information, the text file
must list the file names and the upper left corner pixel location for each image. Each image must

be listed based on the following format:
image name x-pixel location y-pixel location

Only a single space is required between each of the three items in the list. Each image listed must

be on a separate text line.

Base the upper left corner pixel location of each image on the location of the image relative to an

x=0, y=0 pixel location of the upper left corner of the entire set of images.

Consider an example where a single image is being created from four separate scanned Sun

Raster images, each 640 by 480 pixels in size.
The file requires the following four lines:
image nw.ras 0 0

image ne.ras 640 0

image sw.ras 0 480

image se.ras 640 480

The first line in the file must not be left blank.

The sample auxiliary file above joins the specified images as follows:
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0,0 640,0

image nw.ras image ne.ras
0,480 640,480
image_sw.ras image_se.ras

As you add more tiles to a mosaic, performance becomes increasingly important. The following

list provides some advice on encoding performance for mosaics:

o Change the encoding options for strip height and block size for faster encoding on
machines with more memory. As a rule of thumb, you can create mosaics up to 500,000
pixels in width if you set the strip height to 12 and the block size to 64 on a machine with

2 GB of RAM. For more information see Calculating Memory Usage on page 195.

a. Strip height. Set a higher strip height for faster encoding but more memory usage.
For more information, see Strip Height on page 129.

b. Block size. Set a lower block size to use less memory. However, selecting a lower
block size will result in a lower quality compression. By default, the block size is set
to the maximum of 64. Do not change the block size unless you need to restrict
memory usage. For more information, see Block Size on page 129 .

o Create mosaics in a single job even when there are many input tiles. It takes longer to
encode many small mosaics and then encode the small mosaics into one large mosaics. If
you need to create both small mosaics and large mosaics, create one large mosaic first,
and then create tiles in the Job Options.

o Work from uncompressed images when possible. If you want to perform multiple image
manipulation operations on a mosaic, perform the image manipulation operation on the
uncompressed input tiles. Many image manipulation operations that you perform on a com-

pressed mosaic decode the mosaic first, perform the image manipulation operations, and
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then compress the mosaic again. Exceptions to this rule are crop operations, resampling
operations, and composite mosaic operations for the MrSID Generation 3 and Generation

4 formats.
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Complete administrative tasks to set preferences for GeoExpress and to view log file information.

Every time that you create a job by adding an image or mosaic to GeoExpress, the job uses a set

of default options from the preferences. Set your preferences to change these default options. To

access the preferences for raster jobs, click Options > Preferences in the menu bar. To access

the

preferences for LiDAR jobs, click Options > LiDAR Preferences in the menu bar.

1. Click the Options menu and select Preferences for raster preferences or LIDAR Prefer-

ences for LiDAR preferences.

2. Select the tab for which you want to set preferences. Use the arrows in the upper right

corner to scroll through tabs.
3. Click OK.
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NOTE: For raster preferences, you can restore the default preferences from when you

first installed GeoExpress by clicking Restore Program Defaults.

The Preferences dialog box can be used to set default job options and other global settings for
raster files. In this dialog box you can set general preferences, default parameters for MrS1D and

JPEG 2000 encoding, and color and line appearance in editors and selectors.
The Preferences dialog box is divided into six tabs:

e General

e MrSID Generation 4
e MrSID Generation 3
e MrSID Generation 2
« JPEG 2000

e Appearance

Set general preferences to set the default settings for all files.
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General | MrSID Generation 4 | MrSID Generation 3 | MrSID Generation :

— Default Directories

Temp: I Browse. .. |
Clutput: I Browse... |

Log Files: IC:"'-.USers‘-jdominguez*\.DocumerrtsHlJzard' Browse... |
Histograms: IC:‘\USers‘-jduminguez\Ducuments\Uzard' Browse... |

—Output File Generation —— [ Default Output File Format ———
¥ Create unigue file name II'u'IrSID Generation 4 ;I

" Prompt if cutput file exists . Same as Input

—Georeferencing:
\world Files: [T Use [T Generate

P XML Files: [T Use [T Generste

—Error Checking
[~ Suppress pop-up error messages during enceding

—Apply Metadata to Image
[~ NITF RPC

¥ Rotation

—Concurrency Control

I-l 3: Concurrent Jobs I-i 3: Total Threads

Restore Program Defaults |

Default Directories

You can define default Temp, Output, Log File and Histogram directories by browsing or by enter-

ing a filepath.
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When GeoExpress encodes a MrSID Generation 2 image, it creates a series of temporary files
that are used in constructing the final MrSID image. Collectively, the temp files are roughly equi-
valent in size to the created MrSID image. These files are deleted immediately upon completion

of an encoding project.

Encoding requires enough disk space to accommodate both the output image and the equivalent

size of the output image in temporary files. (For more information, System Requirements on

page 5.)

By default, GeoExpress uses the default Windows temp directory, typically C:\Temp, to store
these temporary files. You can specify an alternate directory by entering the full path name in the
Temp Directory field. If you are unsure of the entire path, click Browse to navigate to the preferred

directory.

If an output or temp directory has been specified and afterwards deleted or moved, GeoExpress

will prompt you to specify a new directory.

By default, the output directory is the same location in which the input image resides. In the case
of image mosaics, the output directory is the location in which the first image listed within the

mosaic resides.

To have all MrSID images written to a single directory, enter the desired directory path in the Out-
put field. Specifying a default output directory does not affect filenames already in the Job list.
Only images and mosaics added to the Job list after the default directory is specified adopt the

new output directory.

This check box enables the user to set the Log File output directory. If the user does not manually

change the directory location the default location will be displayed.

By default, histogram files are created in the same place as their source images, but if they can-
not be created there (for example if the source images are in a non-writable directory), then they

are created in an auxiliary directory specified in the Histogram field. If the histograms cannot be
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created in the image source directory and this field is blank, the histogram files are saved to

"C:\Documents and Settings\username\My Documents\LizardTech\GeoE xpress\9\histograms".

If the “Create unique file name” radio button is selected when a new MrSID file is created in a dir-
ectory where a file of the same name exists, the new file name is appended with an underscore
and a number. For instance, if two files named image . sid are created in the same directory,
GeoExpress names the second file image - copy 1.sid. Additional files created are appen-

ded with incremental numbers (such as image - copy 2.sid).

If the “Prompt if output file exists” radio button is selected, you will receive a prompt when GeoEx-
press finds an existing file with the same name as the output file. A “Save As...” dialog box

appears asking for a new file name.
If the “Always overwrite” radio button is selected, GeoExpress overwrites existing files.

Many USGS DOAQ files have the same file name with a different extension. If “Always overwrite”
is selected, MrSID files created from multiple USGS DOAQ files overwrite one another. LizardTech
recommends that the “Always overwrite” feature NOT be used when working with USGS DOQ

images.

A drop-down list enables you to select the default file format to use for output files. Regular
options are MrSID Generation 4 (MG4), MrSID Generation 3 (MG3), MrSID Generation 2 (MG2)
and JPEG 2000. Support for encoding NITF images is available for GeoExpress (contact your Liz-
ardTech representative to purchase the NITF Extension for GeoExpress). Unless this default is

changed manually, it is MrSID Generation 4.

A check box can be selected to automatically generate world files upon encoding.

A check box can be selected to automatically generate AUX files upon encoding. This enables

you to make sure the georeferencing metadata in your MrSID and JPEG 2000 imagery will be
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readable in Esri applications.

When georeferencing information for an image or mosaic tile is also given in a world file, GeoEx-

press uses the georeferencing information from the world file if this check box is selected.

IMPORTANT: This option will override any coordinate reference system (CRS)
metadata — including well-known text strings (WKTs) —that may have been embedded in
the file. You can manually edit the CRS in the image metadata with the Edit Metadata
tool. For more information on selecting a CRS in the metadata, see Editing Raster
Metadata on page 46.

For more information, see World Files on page 182.

When several jobs are being encoded as a batch, errors may occur that could interrupt the encod-
ing project. These errors may be internal (for example, GeoExpress may encounter a corrupt or
incompatible image or mosaic), or they may be external (for example, a Windows or network
error). To force GeoExpress to ignore any such error messages and attempt to continue with the
encoding project, select the Suppress Pop-Up Error Windows During Encoding option .

The error messages will be written to the log file.

If your images contain metadata for image rotation or rapid positioning capability (RPC), you can
manipulate the image so that it reflects the information in the metadata. You can select the fol-

lowing preferences for image metadata:

NITF RPC metadata maps pixel data to location data for orthorectification. Select this option to

apply the orthorectification described in the NITF RPC to the image.

NOTE: To apply orthorectification, the NITF RPC metadata must use the WGS 84

datum.
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Burn in Rotation

Image rotation metadata describes the direction that an image should point. For example, an
image might contain metadata that rotates an image so that it points north. Select this option to
create rotated images with empty space in the corners. The empty space is compressed so that it
does not add to the size of the image. This option is selected by default so that your images are
displayed with the correct orientation even in viewers that do not support metadata for image rota-

tion.

The following figure shows a rotated image:

The black areas represent the parts of the image that do not contain data values. In
MrSID Generation 4 images, the no-data values are stored in the alpha band. For more inform-

ation on alpha bands, see Alpha Bands and MrSID on page 112.

Concurrency Control

If you run GeoExpress on a machine with a multi-core processor or on a machine with multiple pro-
cessors, GeoExpress creates multiple threads to process jobs more quickly. You can set the fol-

lowing preferences for concurrency:

e Concurrent jobs. The maximum number of jobs that GeoExpress can run at the same
time. Each job uses one or more threads. If the number of concurrent jobs exceeds the
number of total threads, GeoExpress does not run the full number of concurrent jobs.

o Total threads. The number of threads that GeoExpress uses. GeoExpress always uses

the total number of threads available regardless of the number of jobs.

The maximum number of concurrent jobs and total threads that you can set equals the number of

cores in your processor. For example, if your machine has six cores, you can run a maximum of six

-165-



Chapter 11: Administration

concurrent jobs and six threads. For machines with more than eight cores, the maximum is eight.

By default, the number of concurrent jobs and total threads equals the maximum.

If you reduce the number of total threads, GeoExpress uses fewer cores. Reduce the number of
total threads when you want to perform other processor-intensive tasks on the machine that runs

GeoExpress.

You have 12 jobs that you want to run on a machine with six cores. The following list describes

how GeoExpress runs the jobs for various preference combinations:

¢ If you set the number of concurrent jobs to six and the number of threads to six, GeoEx-
press runs six jobs at a time and allocates one thread to each job. Use this combination for
optimal performance.

o If you set the number of concurrent jobs to three and the number of threads to six, GeoEx-
press runs three jobs at a time and allocates two threads to each job.

o If you set the number of concurrent jobs to six and the number of threads to three, GeoEx-
press runs three jobs at a time and allocates one thread to each job. Because GeoExpress

uses one thread for each job, GeoExpress cannot run the full number of concurrent jobs.

GeoExpress continues running as many concurrent jobs as possible until it finishes all 12 jobs.

The Appearance tab of the Preferences dialog box enables you to change the color and width of
lines and highlights that are applied in the Image Crop, Area of Interest and Color Balance Tile

Selector dialog boxes. Colored rectangles display the color currently selected.
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MrSID Generation 3 | MrSID Generation 2 | JPEG 2000 Appearance |

—Cropping Editor

Outline Color: [Jll  Hiohlioht Color: Il Line Width: [1

—bArea Of Interest Editor

Outline Color: [Jll  Hiohlioht Color: Il Line Width: [1

—Color Balance Tile Selector

Outline Color: [Jll  Hiohlioht Color: [l Line Width: [1

Restore Program Defaults

Changing Colors

1. Click on the rectangle whose color you wish to change. A color picker appears.

2. Select a color and click OK.

To change a line width, enter the desired value in the appropriate Line Width field.
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This page describes the preference options for MrSID Generation 4 (MG4), MrSID Generation 3
(MG3) and MrSID Generation 2 (MG2).

You can set the following preferences for MG2, MG3, and MG4 files:

o Compression ratio preferences. For more information on compression ratios, see Com-

pression Overview on page 39.

o Zoom levels preferences. For more information on zoom levels, see Zoom Options on
page 108.
¢ Advanced preferences. For more information on advanced options such as weight and

block size, see Format-Specific Options Overview on page 121.

The MrSID Generation 3 (MG3) and MrSID Generation 4 (MG4) preferences mirror the settings
found in the MG3 and MG4 format-specific options on the Advanced Job Options dialog, with
the exception that a default compression ratio can be specified for both color and grayscale
images. When you add a new MG3 or MG4 encode job, the compression settings are initially set
to the values declared on this tab. The effects of these options can be simulated on the Preview
tab.
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General MrSID Generation 4 | MrSID Generation 3 I MrSID Generation 2

—Compression Ratio
% Compression Ratio
Caolor: |2'|] a [T Lossless
Grayscale: I‘H] 2 [T Lossless
Multispectral: |‘||} 1 ¥ Lossless

" Target File Size I‘I megabytes

—Zoom Levels

™ Mumber Of Zoom Levels |5
¥ Target Thumbnail Size |32 pixels

™ Use Maximum Zoom Levels

—Advanced
weight: |2— Sharpness: Iﬂ—
K-vieight 025 BlockSize |64
Freguency Balance: IE— Strip Height: |'54—

¥ Optimizable Alpha Source: ¢ Opague

™ Transparency Value
[~ Apply RGE Color Transform to First Three Bands

[ Despeckle Output

—Despeckling——— |’D1_.rnarnic: Range Metadata Generation —

IHGE Automatic Range ;I

Restore Program Defaults |

The preference options for MG3 and MG4 are the same with the following exceptions:

o Compression ratio preferences for MG4 include a setting for Multispectral, which by

default is set to "Lossless", and a Lossless option can be selected individually for RGB and
Grayscale.
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o Advanced MG4 preference options include an "Apply RGB Color Transform to First Three
Bands" check box to specify that multispectral files whose first three bands are R,G and B
(in that order) should have this transform run on them.

o Advanced MG4 preference options include two Alpha Source options, one to specify that
all pixels are opaque and one to specify that the transparency or "nodata" value should be
automatically detected from the image metadata.

o Advanced MG4 preference options include Dynamic Range Metadata Generation options.
For more information on generating dynamic range metadata, see Dynamic

Range Metadata Generation on page 125.

o Advanced MG3 preference options include radio buttons for selecting either the one-pass

or two-pass optimizer.

The MrSID Generation 2 preferences mirror the settings found in the MG2 format-specific options
on the Advanced Job Options dialog, with the exception that a default encode ratio can be spe-
cified for both color and grayscale images. When you add a new MrSID Generation 2 encode job,

the encode settings will initially be set to the values declared in this tab.
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Mr51D Generation 4 I MrSID Generation 3 MrSID Generation 2 | JPEG 2.4

—Compression Ratio
Color Images: |20 (Grayscale Images: IH] 1

—Zoom Levels

" Number Of Zoom Levels IE-
¥ Target Thumbnail Size |32 pixels

™ Use Maximum Zoom Levels

—Advanced
\Weight: [¥ Image Enhancement
G-Weight: I2 [ Image Statistics

[ Block Size: I

Restore Program Defaults

JPEG 2000 Preference Options

This page describes the preference options for JPEG 2000 preferences.

A drop-down list appears on the General tab of the Preferences dialog box enabling you to

choose one of the JPEG 2000 modes as your default output file format.
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The JPEG 2000 tab of the Preferences dialog box has a number of basic JPEG 2000 options, as
shown below. These are the same options as those available for MrSID encoding. For more

information on compression, see Compression Overview on page 39. For more information on

zoom levels, see Zoom Options on page 108.

MrSI0D Generation 3 I MrSID Generation 2 JPEG 2000 | Appearance I

—Compression Ratio
f* Compression Ratie  Color: |20 1 Grayscale:[10 a

i” Encode Losslessly

—Zoom Levels

™ Mumber Of Zoom Levels IE
™ Target Thumbnail Size |32 pixels

% ze Maximum Zoom Levels

—Despeckling
[T Despeckle Output

Advanced Settings ...

Restore Program Defaults

Click the Advanced Settings... button for further options, which are available on a separate dia-

log box, shown below.
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ral I
Advanced JPEG 2000 Prefe x|

Tile Size :
v Flush Pericd: [4096
[ Use Tile Size

‘width: A096 I+ Tile Length Markers: |255

Height:  |4036 [v Use Packet Length Markers

Tile FParts [ Use 97 \wWavelet (lossy)
v R [ | ' C

B ion Order: [RPCL =
Codeblock Size rogression Order l—_l
Whdth:  [pa W Use GMLIPZ Metadata
Height: IE""—

Precincts
[v Use Precincts

width: 56
Height: |25

Strip Height: 12
Quality Layers: (30

The parameters set on the tab and dialog shown above determine the default options that appear
in the Advanced Job Options dialog box, which includes all of these. Changes made on the
Advanced Job Options dialog only affect the current job. To change the default settings, the

parameters must be changed here.

For details about the advanced options see Advanced JPEG 2000 Options on page 133.

LiDAR Preferences

The LiDAR Preferences dialog box can be used to set the default preferences for LiDAR data,

including compression options, text parsing options, and preview options.
The LiDAR Preferences dialog box is divided into three tabs:

o Compression
e Text Parsing

o Viewing
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Compression Preferences

Set general compression preferences for LIDAR data.

The following figure shows the compression preferences tab:

&3 LiDAR Preferences S
Text Parsing Viewing
Compression ratio: | 1,00 1 [V Lossless

Block size: 4096

¥ Omit custom LAS VLR metadata from output

Help

Cancel

Compression Ratio

How much you want to compress the data. Depending on the compression ratio, the resulting file
may have fewer points than the original point cloud. Alternatively, select the Lossless check box

to create a compressed point cloud identical to the input point cloud.

Block Size

The number of points to process and store at one time. Enter a large block size to increase the
compression speed. Enter a small block size to decrease memory usage. Valid values are from

2048 through 16384. The default value is 4096.
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Omit Custom VLR Metadata

Omit custom variable length record (VLR) metadata from LAS files. VLR metadata can include

vendor-specific data, user-specified data, and more.

Text Parsing Preferences

Set options for LIDAR point clouds stored as text files.

The following figure shows the text parsing preferences tab:

3 LiDAR Preferences

When a text file is added:
v Prompt me to map columns

I Read the whole file to determine properties and enable previewing

Manage custom fields...

Cancel

Map Columns

If you select this check box, GeoExpress displays a dialog that you can use to select columns from

the input text file and map their values to standard fields like X, Y, Z, intensity, and more.
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Read the Whole File

If you select this check box, GeoExpress reads all of the data in the input text file to determine

properties like the point cloud extents and to enable previewing the file.

Manage Custom Fields

Click the Manage Custom Fields button to see the default fields available for LIDAR point
clouds and to create custom fields. For example, you may want to create a custom field for a non-

standard time format, for sensor information, and more.

Viewing Preferences

Set preferences for previewing LiDAR files.

The following figure shows the text parsing preferences tab:

3 LiDAR Preferences

Compression | Text Parsing

Mumker of points to render:

—Help
The number of points to display when you preview the point cloud. Enter a large value to display more
detail. Enter a low value to display point clouds faster. The minimum value is 50,000 and the default
value 1= 500,000,

Cancel
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Enter the number of points to display when you preview the point cloud. Enter a large value to dis-
play more detail. Enter a low value to display point clouds faster. The minimum value is 50,000
and the default value is 500,000.

You can access log information for GeoExpress encoding and publishing operations in the log

folder or directly from the GeoExpress graphical user interface (GUI).

By default, text files containing log records are located in "My Docu-
ments\LizardTech\GeoExpress\9\logs". You can change the location of the log files in the Prefer-

ences dialog.

The log folder contains separate logs for completed encoding and completed publishing jobs. If

there are no log files in the folder, it means no encoding or publishing jobs have been performed.

Encoding jobs are recorded in the "GeoExpress log.txt"and "session log.txt"files.
"GeoExpress_log.txt"isa persistent log that is appended with each encoding operation the
user runs, whereas "session log.txt"isatemporary log that lists only the images that were

encoded in the current job. It is overwritten upon each new encoding operation.

Publishing jobs are recorded in the "GeoExpressPublish log.txt"and"publish ses-
sion_ log.txt"files. As with their encoding counterparts, "GeoExpressPublish
log.txt"isa persistent record of publishing operations that grows over time, while "publish

session_ log.txt" records only the last completed publishing job.

A description of recently completed encoding projects can be viewed on the Output tab for a

selected job.
1. Click the Output tab.

The session log appears.
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2. Use the scrollbar to locate information about a specific image.

TIP: If you select a job in the Job List while you view the Outputtab, the session log

only shows information about the selected job.

Click the Export Log button to save the session log for a selected job. You can export the ses-

sion logtoa CSV or TXT file.

Upon completion of a publishing operation, the text window of the Publish Images dialog
reports the results of the publishing operation. This is the same information logged in the "GeoEx-

pressPublish log.txt"and"publish session log.txt"files.

You may wish to copy information from the log entry and paste it elsewhere. Use the standard
Windows copy (Ctrl+C) and paste (Ctrl+V) shortcuts on any text in the Session Log text box of
the Output tab.

You can print out the entire session log. This is the same information that is displayed on the Out-

put tab.
To print the session log, do one of the following:

e Click Ctrl + P (Windows keyboard shortcut) when the Output tab is active.

o Select Print Session Log from the File menu.

Following is an example of an output log entry. Details will be different depending on whether the
output is to a file system or to an Express Server. This example is for an image encoded to a file

system.
0 6/27/2013 2:30:01 PM GeoExpress Session Log
GUI Version: 9.5.0.0.3774

Engine Version: 9.5.0.0.3774
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Thursday, June 27, 2013 2:30 PM
Job ID Time Message Status
9 6/27/2013 6:07:37 PM

9 6/27/2013 6:07:37 PM

9 6/27/2013 6:07:37 PM
2013 6:07:37 PM

9 6/27/2013 6:07:37 PM

9 6/27/2013 6:07:37 PM

ages\4bittiff\48120g5g.tif

9 6/27/2013 6:07:37 PM
9 6/27/2013 6:07:37 PM
MB (18750000 Dbytes)

9 6/27/2013 6:07:43 PM
9 6/27/2013 6:07:43 PM
9 6/27/2013 6:07:43 PM

mages\4bittif£f\48120g5g.sid

9 6/27/2013 6:07:43 PM
KB (939415 bytes)

9 6/27/2013 6:07:43 PM
9 6/27/2013 6:07:43 PM
9 6/27/2013 6:07:43 PM
9 6/27/2013 6:07:43 PM
9 6/27/2013 6:07:43 PM

Job name: 48120g5g.tif (4 threads)

Operation: Encode image

Start time: Thursday, June 27,

Input properties:

Input file name: \\SEA-DEV-IMAGE\Testim

Input file type: TIFF

Input image size: 17.9

Output properties:

Output file name: \\SEA-DEV-IMAGE\Testi

Output file size: 917.4

Output file type: MrSID Generation 4

Encoder version: 9.5.0.0.3774

Target compression ratio: 20.00:1

Actual compression ratio: 19.96:1
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9 6/27/2013 6:07:43 PM Start time: Thursday, June 27,
2013 6:07:37 PM

9 6/27/2013 6:07:43 PM Finish time: Thursday, June 27,
2013 6:07:43 PM

9 6/27/2013 6:07:43 PM Total time: 5 seconds Succeeded

9 6/27/2013 6:07:43 PM
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In addition to image compression and manipulation operations you can perform the following oper-

ations:

o Publish images to an Express Server.
o Use world files to specify georeferencing information for images or generate world files for
your images.

o Generate Esri AUX files for your images.

You can use GeoExpress to publish images directly to Express Server. Express Server supports
MG4, MG3, MG2, and JPEG 2000 images. Publishing is a one-time operation that does not use

project files and does not alter or delete the source images on the machine's hard disk.
To publish existing images:
1. Inthe Tools menu, click Publish Images.
The Publish Images dialog box appears.

2. Addimages to the Source Images list by clicking Add Images To Publish, selecting

images, and clicking Open. Alternatively, drag files into the window.
3. When you finish adding images, click Publish to Express Server.

The Express Server browser appears. For more information, see Selecting an Express

Serveron page 92.

4. Click OK to begin the publishing process.
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The Publish Image dialog changes to display two progress bars. The bottom bar mon-
itors the publishing progress of an individual image and the top bar monitors the aggregate

progress of all the images in a job.

To cancel the operation, click either Cancel All or Cancel Current Image.

The results of a publishing operation are displayed in the Publishing dialog. Alternatively, you can

view the results by opening the log files stored in the following directory:
<User directory>\Documents\LizardTech\GeoExpress\9\logs
There are two log files related to publishing:

e GeoExpressPublish log.txt isarunning log of all publishing operations.
e publish session log.txt isatemporarylog that only lists the images published in

the most recent publishing operation.

For more information see Viewing and Using Log Information on page 177.

A "world file" is a simple text file containing auxilliary georeferencing information for an image. It
can be used to georeference an image that has no georeferencing information within it, or to over-

ride existing georeferencing information.

By convention, the filename for a world file is the same as the image it pertains to, with a different
extension. The three-letter extension is made up of the first and last characters of the image file-
name extension, followed by a 'w'. For example, the world file for a TIFF image named "bain-
bridge.tif" would be "bainbridge.tfw"; the world file for a MrSID image named "madison.sid"

would be named "madison.sdw".

A check box can be selected on the General tab of the Preferences dialog box to automatically

generate world files upon encoding.

-182-



Chapter 12: Other Operations

The world file format is six lines, each line containing a double precision value (represented in

text). No additional lines may be present. Leading and trailing whitespace are allowed.
The meanings of the six values are:

dimension of a pixel in map units in x direction
first rotation term

second rotation term

dimension of a pixel in map units in y direction

x-coordinate of the center of the upper-left pixel

S T o

y-coordinate of the center of the upper-left pixel
The y-dimension is, by convention, a negative value.

GeoExpress ignores the rotation term in most cases.

This is an example of a world file:
0.20000000
0.00000000
0.00000000
-0.20000000
780.10000000

219.90000000

This world file indicates the image resolution is (0.2, -0.2) and the upper-left is at (780.1, 219.9).

The rotation terms are zero, meaning no rotation is required.

Once you have added imagery to the Job list, you should check its extents on the Properties tab to
make sure it has the proper positioning. If it does not, check for the presence of world files in the

source directory. If there are world files, you can instruct GeoExpress to use them.

To specify that world files should be used:
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1. Select animage in the Job List and click the Advanced button on the Properties tab.
The Advanced Job Options dialog box appears.

Select the Input tab.
Select the Use World Files check box.
Click OK.

IMPORTANT: Use of world files removes the CRS or other georeferencing information

from the image.

TIP: If no world file exists or if using world files does not result in correct positioning, you
can change the image extents by editing the image metadata. For more information see

Editing Raster Metadata on page 46.

AUX files are used in older Esri products in the ArcGIS suite to specify coordinate reference sys-
tem information. They have the extension ".aux". You may want to generate Esri AUX files if your

imagery will be used in Esri ArcGIS 9.1 or earlier.
To generate Esri AUX files:

1. Select Preferences... from the Options menu. The Preferences dialog box opens.
2. Select the Generate Esri AUX Files check box in the World File Support group of
options.

3. Make any other changes to Preferences and click OK.

AUX files will now be generated upon encode and output to the same folder as the output

images.
To stop generating Esri AUX files, clear this check box.

By default Esri AUX files are not generated.
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GeoExpress enables your applications to use JPEG 2000 compression on geospatial images with
the same level of efficiency, metadata, and large-image support already available with MrSID.
JPEG 2000 image compression offers many of the advantages implemented in the MrSID

format, plus the added benefits of being an international standard (ISO/IEC 15444).

All of the basic options and some of the advanced options that are available for MrSID encoding
are also available for the JPEG 2000 format. Certain advanced operations such as creating and

updating composites and optimizing images are not available for JPEG 2000 encoding.

GeoExpress supports encoding JPEG 2000 files in two different modes,"GMLJP2" and "Part |".
By default GeoExpress uses GMLJP2, which is the best option for most workflows. For applic-
ations that do not support GMLJP2, the Part | mode generates files that do not use any Part |1
extensions. GMLJP2 metadata is not available in this mode. Other encoding features, such as
the use of NPJE profiles and other metadata forms, are still available. Use the Part | mode only
when you are sure that the image user's workflow entails applications that cannot read GMLJP2

files.

The two modes are included as options in the Output Format drop-down list. For convenience

when creating mosaics, this drop-down list also appears on the “Create New Mosaic” dialog box.

JPEG 2000 encoding utilizes the same data cartridge deduction mechanism that MrSID encoding

does (see Frequently Asked Questions on page 226 and Data Cartridges on page 217). Oper-

ations involving only MrSID and/or JPEG 2000 input files do not decrement the cartridge.
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GeoExpress allows Geography Markup Language (GML) metadata to be added to JPEG 2000
(JP2) imagery to comply with the Open Geospatial Consortium (OGC) GMLJP2 standard.

GML (Geography Markup Language) is an open, XML-based specification for representing geo-
graphic information including geographic features, coverages, observations, topology, geometry,
coordinate reference systems, units of measure, time and other values. Because it is an XML

grammar, it is both extensible and adaptable to any application within the broad geospatial field.

As a wavelet-based image compression format, JPEG 2000 (JP2) is capable of handling images
into the gigabyte range and beyond. But until recently, JP2 was not particularly suited to the
needs of the geospatial community because it didn't have a designated geospatial metadata
standard. However, because the JPEG 2000 format allows for the inclusion of XML data, GML
has emerged as the ideal partner for JPEG 2000 imagery, bridging the gap between JP2 and
GIS.

GMLJP2 is the specification that standardizes that partnership and opens the door for greater
interoperability between your imagery and the thousands of current and future geospatial applic-
ations that might use it. Containing its own geographic metadata, your JP2 imagery becomes
"spatially aware" and is thus of increased value in geospatial applications. Prior to the adoption of
GMLJP2, the lack of a geospatial metadata standard meant that applications and viewers may or

may not have been able to read geospatial metadata in a JPEG 2000 file.

The GMLJP2 specification was officially adopted in February 2006 by the Open Geospatial Con-
sortium (OGC) as an open standard for representing geographic information in JPEG 2000
imagery. LizardTech supports open standards and is committed to the success of the GMLJP2

specification.

Jointly proposed and developed by LizardTech, Galdos Systems and a consortium of forward-look-
ing aerospace and technology companies, GMLJP2 represents the most advanced means of
including geographic metadata within compressed geospatial imagery and making that inform-

ation useful in downstream applications now and in the future.
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GeoExpress already offers the most complete and easy-to-use implementation of the open JPEG
2000 standard. Now, your JP2 imagery encoded with GMLJP2 metadata is secure for the future
because, like JPEG 2000, the GMLJP2 specification is an open, non-proprietary standard.

NOTE: Some applications that support JPEG 2000 do not support all of the features that
are required to implement the GMLJP2 standard. For more information, see JPEG 2000

Output Selections on page 185.

The GML option is available among the metadata control settings of the advanced JPEG 2000
options (see GMLJP2 Metadata on page 139).

Learn more about the GML and GMLJP2 specifications at http://www.opengeo-

spatial.org/specs/?page=specs.

The GMLJP2 Application Schema version 3.1.1. can be found at http://s-

chemas.opengis.net/gml/.

JPEG 2000 images can be created with an essentially unlimited number of bands, so multis-
pectral output can be created from multispectral input without having to go through an output
color space. For JPEG 2000 encoding, the color compositor allows multibanded images to be cre-

ated from files representing individual bands.

For more information see Creating Multiband JPEG 2000 Files on page 188.

JPEG 2000 supports the use of an alpha band or "alpha channel" for masking out portions of an
image. GeoExpress supports creating alpha bands in JPEG 2000 files where the TIFF or JPEG

2000 source image has an alpha band.

When an image that has an alpha band is encoded to the JPEG 2000 format, GeoExpress

encodes the alpha band losslessly to preserve its integrity.
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NOTE: For users of GeoExpress Standard Edition, the encoding of the alpha band does
not additionally decrement your data cartridge. Your encode job will be metered the

same with or without alpha bands.

GeoExpress allows the creation of multiband JPEG 2000 files from a collection of single-band
grayscale image files. The input files must all have the same dimensions, resolution, bit depth,

and geographic positioning. Empty bands are allowed, and treated as zero data.
1. Select Add color composite image to encode... from the File menu.
The Add Color Composite Image dialog box appears.

2. Select a color space for the image from the drop-down menu, either RGB or Mult-
ispectral. RGB populates the list box with editable red, green, and blue bands. Mult-
ispectral populates the list box with bands that range from 1 to n. You can change the
number of bands in a multispectral image by clicking Edit number of bands... and typing

in a new value.

3. Toadd animage file to a band, select the desired band and then click Edit file name....

The Edit File Name dialog box appears as shown below.

4. Type in afile name or click Browse... to bring up a file browser. If you want to remove a
file from a given band, simply clear the text from the file name field. A color composite

image must have at least one band specified.

For information on NITF image segments in color composite images, see Using a NITF Image

Segment as a Component Band in a Color Composite Image on page 191.
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Creating NITF images requires a NITF license. This chapter offers information about how to cre-

ate National Imagery Transmission Format (NITF) images with GeoExpress.

The acronym NITFS sometimes seen refers to the NITF standard, which was created by the
Department of Defense as a means of formatting digital imagery and imagery-related products
and exchanging them among members of the intelligence community, the Department of
Defense (DOD), and other government departments and agencies. NITF was created partly
because government agencies needed a single common image representation that supported cer-
tain metadata features and workflows. While it is called an image format, NITF is perhaps more

precisely described as a file format that wraps image files and metadata about those files.

The NITF format requires information is entered on numerous metadata fields on several forms.
For NITF JPEG 2000 encoding, you can edit the metadata fields — as well as the LizardTech

metadata tags — in the Metadata Manager.

For details about how GeoExpress saves NITF metadata, see NITF Metadata on page 55.

NOTE: When you use a NITF file as an input image, sometimes the band order of the
image does not match the band order in the metadata. If this is the case, GeoExpress

changes the order of bands in output images to match the metadata band order.

GeoExpress supports the following NITF standards:
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o version 2.1 of the NITF file format (MIL-STD-2500C, May 2006, plus change outlined in
RFC NTB-038) for writing

¢ versions 2.1 and 2.0 of the NITF file format for reading

o version 01.10 of the BIIF Profile for JPEG 2000 (BPJ2K01.10, April 2009) including the
J2KLRA TRE

o version 2.1 of the Commercial Dataset Requrements Document (NCDRD STDI-0006,
February 2010)

¢ version 1.0 of the Implementation Practices of NITF (STDI-0005 IPON v1.0, August 2007)

o version 00.20 of the JPEG 2000 Test Plan (BPJ2K01.00 Test Plan Draft Version 00.20,
March 2010)

NOTE: These NITF standards may change and future releases will track the evolution

of these standards to ensure interoperability.

You may select NITF 2.1 as an output format from the Output Format drop-down list, which

appears in two places:

o onthe Properties tab

« onthe Create New Mosaic dialog box

Two different types of NITF encoding are available: raw (uncompressed) and JPEG 2000.

Because raw files are uncompressed, when NITF 2.1 (Raw) is selected as the output format
encode ratio, target file size and other options become unavailable, and the Format-Specific tab
of the Advanced Job Options dialog box is absent. Metadata editing is not supported for raw

NITF encoding.

When NITF 2.1 (JPEG 2000) is selected as the output format, the source imagery is encoded to
JPEG 2000. Thus, when JPEG 2000 is selected, all of the JPEG 2000 encoding options become
available. The options common to MrSID formats reappear on the Properties tab . These and all

of the options specific to JPEG 2000 become available on the Format-Specific tab of the
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Advanced Job Options dialog box. For more information about these options, see Advanced
JPEG 2000 Options on page 133.

You may specify NITF 2.1 as your default output format by selecting it from a drop-down list on

the General tab of the Preferences dialog box. For more information, see Setting Preferences on

page 159.

To be valid, the image segments comprising an incoming NITF file must be mosaickable. They
must have compatible resolutions, colorspaces, and datatypes, and must all fall on the same

coordinate space.

To view the image segments in a multisegment NITF image, right-click on the job in the Job List
and select NITF Image Segments. The segments can be removed from the output image by

clearing the check boxes beside each image segment.
If no segments are selected, the input image is considered invalid.
When the image is encoded, the selected segments are mosaicked into a single flat image.

NITF mosaic tiles behave the same way as other image tiles in the encoding process; the selec-
ted segments of each tile are mosaicked together first, and then the tiles are mosaicked together

for the final output.

To use a multisegment NITF file as a component band in a color composite image:
1. Click the File menu and select Add color composite image to encode.
The Add Color Composite Image dialog box appears.
2. Select RGB or Multispectral from the Color Space drop-down list at upper right.

3. Select a band and click Edit File Name....
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The Edit File Name dialog box appears.

4. Enter afile name or click Browse... to locate the file, then click OK. If the file you selec-
ted is a multiple image segment NITF file, a third dialog box (the Image Segment

Selector dialog box) appears.

5. Select which 1-banded image segment of the selected NITF file you wish to use as the

“active segment” for the selected band, then click OK.

You can change the active segment in a color composite image at any time.
To change the active segment:
1. Click the File menu and select Add color composite image to encode.
The Add Color Composite Image dialog box appears.
2. Click Select Image Segment....
The Image Segment Selector dialog box appears.

3. Select a different 1-banded image segment from the drop-down list and click OK.

To create a NITF file with multiple image segments, the individual segments must be mosa-
ickable. This is because they must be placed on a common grid. All of the mosaicking rules for
other kinds of images apply to multisegment NITF images. For more information on mosaics,

Mosaics on page 143.
To create a multisegment NITF file:
e
1. Click the Create New Mosaic button ™ on the toolbar.
The Create New Mosaic dialog box appears.

Select NITF as the output format.
Select the Create multiple image segments radio button.
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NOTE: Multisegment NITF encoding supports up to 999 image segments. If you
attempt to encode more than 999 tiles as a multisegment NITF file, an error message
informs you that you have exceeded the maximum number of image segments and asks
whether or not you would like to flatten the input tiles first. Clicking “Yes” will result in a
single image segment NITF file. This is equivalent to clearing the “Create multiple image

segments” check box. Clicking “No” simply cancels the addition of that tile.
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The amount of memory that GeoExpress uses to perform operations depends on the following

factors:

o The image manipulation operations that you perform.
e The operating system.

e Theimage input format.

o The number of bands in the output image.

e The number of threads and concurrent jobs.

e The strip height and block size.
Of these factors, you can control the strip height and the block size that GeoExpress uses.

Memory usage is constant over the length of the encode operation

The Estimated Memory Usage value is displayed on the Properties tab except when the out-
put format is other than MrSID or the 1-pass optimizer is used. GeoExpress uses the 2-pass

optimizer by default.

The following formula describes the approximate amount of memory used by GeoExpress to com-

press a single image to the MrSID Generation 4 (MG4) or MrSID Generation 3 (MG3) format:
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Memory = ((8 + 4 * BlockSize + MIN(StripHeight, BlockSize)) * 4 +

StripHeight) * NumBands * Width

The following list describes the variables used by the formula:

Memory is the estimated memory usage in bytes.

BlockSize is set by the user on the Format-Specific tab of the Advanced Job
Options dialog box. For more information on block size, see Block Size on page 129.
MIN (StripHeight, BlockSize) evaluates the values for the strip height and block
size and equals whichever value is smaller.

StripHeight is set by the user on the Format-Specific tab of the Advanced Job
Options dialog box. For more information on strip height, see Strip Height on page 129.
NumBands is the number of bands in the image to be encoded — typically 1 or 3 (This
value is noted in the Properties tab.)

Width is the width of the input image in pixels. (This value is noted in the Properties
tab.)

The following formula describes the approximate amount of memory used by GeoExpress to com-

press a single image to the MrSID Generation 2 (MG2) format:

Memory = ((8 + 4 x BlockSize + 64) x NumBands x Width x 4) + (

0.005 x ExpectedOutputFileSize )

Memory is the estimated memory usage in bytes.
BlockSize is set by the user on Format-Specifictab of the Advanced Job Options

dialog box. For more information on block size, see Block Size for MG2 on page 132.

NumBands is the number of bands in the image to be encoded — typically 1 or 3 (This

value is noted in the Properties tab.)

Wwidth is the width of the input image in pixels. (This value is noted in the Properties
tab.)

ExpectedOutputFilesSize isthe target file size. (This value is noted in the Prop-
erties tab.)
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The size of a mosaic is calculated from the nominal size of the output mosaic. For raster images,
the nominal size is the product of the image width, the image height, the number of bands, and
the number of bytes per band. Also for rasterimages, the nominal size assumes that all portions
of the image include valid data, whether or not this is this the case. For LiDAR point clouds, the
nominal size is a measure of the number of points in the point cloud and the number of fields for

each point.

As a result, the size is not adjusted for the presence of transparency regions in the mosaic, such

as when:

e amosaic of non-contiguous images is created

o the output image for a contiguous mosaic does not conform to a rectangular shape

In these cases, the transparency regions in the output image are included in the mosaic size. Also
in these cases, the estimated output file size may be considerably larger than the actual output

file size.

NOTE: The cost charged to the data cartridge is not always equal to the mosaic size. It
is calculated from the sum of the nominal sizes of the input tiles rather than from the

nominal size of the resulting mosaic.

GeoExpress calculates the resultant image filesize as part of the encoding process, taking into
account the user-defined compression ratios for inside and outside the area of interest. Selecting
the weight radio button enables you to specify an encode ratio for the area of interest or select the
Lossless check box. The outside area will be encoded at the compression ratio specified in the job

options.

As an example, consider a 1-band (grayscale), 8-bit input image measuring 1000 x 1000 pixels.
The user specifies compression for this image at 100:1. An area of interest measuring 100 x 100
pixels is then defined within the image, and the compression ratio inside the area of interest is set
at 10:1.
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100 x 100 A0 ta be
compressed at 1001

&

&

1000 x 1000 image to be
compressed at 100;1

Based on these dimensions and specifications, GeoExpress makes the following calculations:

AOI compression ratio (CRAOI) =10

Base compression ratio for the image (CRother) =100

Area of the entire image (Area, , )is 1000 x 1000 pixels = 1,000,000 pixels

total

Area of the AOI (AreaAOI) is 100 x 100 pixels = 10,000 pixels

Area of the portion of the image surrounding the AOI (Areaother) is 1,000,000
pixels — 10,000 pixels = 990,000 pixels

GeoExpress then makes the following filesize calculations:
Filesize of the AOI (FS, ) = Area,  / CR, ; = 10,000/ 10 = 1000 bytes

/CR =990,000/ 100 = 9900

) = Areaother other

Filesize of the “outside” (FS

bytes

other

Total filesize (FStotal) = FS, , + FS_, = 1000 + 9900 = 10,900 bytes

GeoExpress then calculates the “overall compression ratio”:

Compressionratio= Area, ./ FS =1,000,000/10,900=91.73

total total ~
In order to calculate the overall target filesize for the encode process the compression ratio for the

overall image is set to 91.73. The target filesize thus becomes:

1,000,000/91.73 = 10,901 bytes

NOTE: This calculated filesize appears on the Properties panel for the image once you

close the Area of Interest dialog box. The actual output is reported in the GeoExpress
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log file on the Output tab of the Properties panel (see Viewing and Using Log Information

on page 177).

A BBB image consists of two files, a binary file containing only the raw sample values of the
image and a text file describing the image properties. The raw data may be organized in one of
three layouts: "band-interleaved by pixel" (BIP), "band-interleaved by line" (BIL), and "band

sequential" (BSQ). The three formats are collectively referred to as the BBB file format.

Because BBB files only contain raw data with an easily editable header format, they are often
used as a "least common denominator" interchange format. However, there is no set standard for
the keywords that may be contained in the header. This document describes the header format

that GeoExpress supports.

GeoExpress recognizes four filename extensions: ".bip", ".bil", ".bsq", and ".bbb". The first three
imply the layout is BIP, BIL, or BSQ respectively; the ".bbb" extension implies the default layout,
which is BIP. The header file for a BBB image has the same name as the image, but with a ".hdr"

extension.

The header file is a simple text file containing keywords and their associated value, one keyword/-
value(s) set per line. All keywords and values are case-insensitive. Blank lines are ignored. Lead-
ing and trailing whitespace is ignored. A line that begins with a '#' character, possibly preceded by

whitespace, indicates a comment line. Comment lines are ignored.

The keywords and their allowed values are as follows:

Keyword Description Notes

Corresponding metadata tags are created,
BANDGAPBYTES but the actual values are not used in setting

the geocoordinates of the inputimage
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Keyword Description Notes
Corresponding metadata tags are created,
BANDROWBYTES but the actual values are not used in setting
the geocoordinates of the inputimage
BANDS Same as NBANDS
Allowed values: MOTOROLA, M, BIG,
BIGENDIAN, NA
Endiannessinter-
BYTE_ORDER The value NA may only be used if the num-
pretation of data
ber of bandsis 1
Default: host endianness
BYTEORDER Same asBYTE ORDER
Allowed values: GREY, GREYA, GRAY, GRAYA,
GREYSCALE, GREYSCALEA, GRAYSCALE,
GRAYSCALEA, RGB, RGBA, CMYK, CMYKA,
The colorspace of the
COLORSPACE MULTISPECTRAL, MULTISPECTRALA
image
Default: GRAY for 1-banded images, RGB for
3-banded images, otherwise
MULTISPECTRAL
COLS Same asNCOLS
The data type of the Allowed values: U8, U16, S8, S16, F32
DATATYPE
samples Default: Us
Allowed values: a single floating-point value
The midpoint of the )
DYNAMICRANGELEVEL (applies to allbands)
range of the data
Default: (none)
Allowed values: a single floating-point value
The maximum dynamic .
DYNAMICRANGEMAX (applies to all bands)
range
Default: (none)
Allowed values: a single floating-point value
The minimum dynamic .
DYNAMICRANGEMIN (appllesto allbands)
range
Default: (none)
DYNAMICRANGEWINDOW | The size of the range of | Allowed values: a single floating-point value
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Keyword Description Notes
(applies to all bands)
the data
Default: (none)
Sphere eccentricity Corresponding metadata tags are created,
E_SQUARED squared, for geor- but the actual values are not used in setting
eferencing the geocoordinates of the inputimage
INTERLEAVING Same as LAYOUT

The data layout; use of

this keyword overrides

Allowed values: BIP,BIL, BSQ, Or NA

The value NA may only be used if the num-

LAYOUT
the layoutimplied by the | ber of bandsis 1
filename extension Default: BIP
Corresponding metadata tags are created,
Measurement unit for
MAP_UNITS but the actual values are not used in setting
georeferencing
the geocoordinates of the inputimage
The number of bands in Allowed values: 1-65535
NBANDS )
the image Default: (none; this keyword is required)
Allowed values: 1 to (total number of bits per
Number of bits used
NBITS sample)
per sample
Default: the total number of bits per sample
Allowed values: 1 to 2431
NCOLS Width of image, in pixels
Default: (none; this keyword is required)
Height of image, in Allowed values: 1 to 231
NROWS )
pixels Default: (none; this keyword is required)
PIXEL_HEIGHT SameasYDIM
PIXEL_WIDTH Same as XDIM

PROJECTION_NAME

Name of projection sys-

tem, for georeferencing

Corresponding metadata tags are created,
but the actual values are not used in setting

the geocoordinates of the inputimage

PROJECTION_
PARAMETERS

Numeric projection

parameters, for geor-

Corresponding metadata tags are created,

but the actual values are not used in setting
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Keyword

Description

Notes

eferencing

the geocoordinates of the inputimage

PROJECTION_ZONE

Projection zone num-

ber, for georeferencing

Corresponding metadata tags are created,
but the actual values are not used in setting

the geocoordinates of the inputimage

RADIUS

Sphere radius, for geor-

eferencing

Corresponding metadata tags are created,
but the actual values are not used in setting

the geocoords of the inputimage

ROWS

Same as NROWS

SEMI_MAJOR_AXIS

Semimajor axis, for

georeferencing

Corresponding metadata tags are created,
but the actual values are not used in setting

the geocoords of the inputimage

SEMI_MINOR_AXIS

Semiminor axis, for

Corresponding metadata tags are created,

but the actual values are not used in setting

SKIPBYTES

georeferencing
the geocoords of the inputimage
Allowed values: 0 to (image size in bytes)
Default: 0

Number of bytes at top

ofimage file to skip

This can be used for raw formats which con-
tain a fixed number of "header" bytes at the

top of the data file

SPHEROID_NAME

Name of projection sys-

tem, for georeferencing

Corresponding metadata tags are created,
but the actual values are not used in setting

the geocoordinates of the inputimage

TOTALROWBYTES Not currently supported — value is ignored
UL_X_COORDINATE Same as ULXMAP
UL_Y_COORDINATE Same as ULYMAP

ULXMAP

Upper-left x-position,

for georeferencing

Allowed values: (any floating point value)

Default: (none)

ULYMAP

Upper-left y-position,

for georeferencing

Allowed values: (any floating point value)

Default: (none)
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Keyword Description Notes
Allowed values: 1 or 2
Number of bytes per
WORDLENGTH Default: 1, unless overridden by
sample
DATATYPE
Size of pixel in x-dir- Allowed values: (any floating point value)
XDIM ection, for geor-
. Default: (none)
eferencing
Size of pixelin y-dir- Allowed values: (any floating point value)
YDIM ection, for geor- Default: (none)
eferencing NOTE: thisis expected to be a positive value

These keywords are required: NBANDS, NCOLS, NROWS. All other keywords have default values.

If dynamic range is used, either both DYNAMICRANGEMIN and DYNAMICRANGEMAX must be set

or both DYNAMICRANGEWINDOW and DYNAMICRANGELEVEL must be set.

This BBB header file describes a 640x480 RGB color image, using 16 unsigned bits per sample.
NROWS 480

NCOLS 640

NBANDS 3

DATATYPE U16

Note that some of the header syntax supported by GeoExpress may not be supported by other
vendors' BIP/BIL/BSQ implementations. In particular, the following features and keywords may

be somewhat specific to LizardTech:

o interpretation of .bbb extension as meaning layout of BIP
e support for comment lines
o the COLORSPACE keyword
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e the DYNAMICRANGEMIN, DYNAMICRANGEMAX, DYNAMICRANGEWINDOW, and

DYNAMICRANGELEVEL keywords

GeoExpress reads and maintains accurate georeferencing forimages in USGS DOQ format.

DOAQ files contain metadata information in an ASCII| header file contained within the file.

GeoExpress can read images in both old and new DOQ header formats. The less common “expo-

nential” DOQ header format is not supported.

The following is an example of the current standard USGS DOQ header format:

BEGIN USGS_ DOQ HEADER *

QUADRANGLE NAME “QUINCY WEST” 3.75 or 7.5-min. name%*

QUADRANT NE quadrant indicator if cell size = 3.75minutes*

WEST LONGITUDE -91 26 15.000 signed deg., min. &amp; sec.*

EAST LONGITUDE -91 22 30.000 signed deg., min. &amp; sec.*
NORTH LATITUDE 40 0 0.000 signed deg., min. &amp; sec.*

SOUTH LATITUDE 39 56 15.000 signed deg., min. &amp; sec.*
PRODUCTION DATE 1995 07 13 yyyy mm dd*

RASTER ORDER LEFT RIGHT/TOP_ BOTTOM video display order*

BAND ORGANIZATION SINGLE FILE single file or BSQ, or BIL or BIP*
BAND CONTENT BLACK&amp; WHITE blacké&amp; white or red green blue*
BITS PER PIXEL 8 *

SAMPLES AND LINES 6076 7641 number of columns and rows*
HORIZONTAL DATUM NAD83 primary horizontal datum*

HORIZONTAL COORDINATE SYSTEM UTM *
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COORDINATE ZONE 15 coordinate system zone number*
HORIZONTAL UNITS METERS coordinate system units*

HORIZONTAL RESOLUTION 1.0 coordinate system geometric resolu. in h

oriz. units*
SECONDARY HORIZONTAL DATUM NAD27 secondary horizontal datum*

XY  ORIGIN 633063.000 4429328.000 coord.of wupper left pixel-pr

i. datum*

SECONDARY XY ORIGIN 633079.000 4429113.000 coor.-upper left pixe

l-sec datum*

NATION USnation code*
STATE IL state fips codes*
STATE MO state fips codes*

NW_ QUAD CORNER XY 633377.438 4428926.385 X-Y coords. of pri. NW

quad corner¥*

NE QUAD CORNER XY 638712.782 4429021.805 X-Y coords. of pri. NE

quad corner¥*

SE_ QUAD CORNER XY 638839.205 4422084.460 X-Y coords. of pri. SE

quad corner*

SW_ QUAD CORNER XY 633498.995 4421989.077 X-Y coords. of pri. SW

quad corner*

SECONDARY NW_ QUAD XY 633380.942 4428716.377 X-Y coords. -sec. NW

quad cor.*

SECONDARY NE QUAD XY 638716.426 4428811.800 X-Y coords. -sec. NE

quad cor.*

SECONDARY SE QUAD XY 638842.847 4421874.579 X-Y coords. -sec. SE

quad cor.*
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SECONDARY SW QUAD XY 633502.497 4421779.193 X-Y coords. —-sec. SW

quad cor.*
RMSE XY 0.82 dog horiz.accuracy*

IMAGE SOURCE iblack &amp; white film b&amp; w, color, infrared or

other*

SOURCE _ IMAGE ID NAPP 2231-2" source image identification*
SOURCE  IMAGE DATE 1991 03 24 source image date as yyyy mm dd*
SOURCE _ DEM_ DATE 1995 07 00 source DEM date*

AGENCY WesternMappingCenter (WMC) name of oversight agency*
PRODUCER WesternMappingCenter (WMC) name of DOQ producer*

PRODUCTION SYSTEM 1DV1.2 03/ 93 OV1l.1 04/ 93” name of the producti

on HW &amp; SW*

STANDARD VERSION 1996 12 version of DOQ standard*

METADATA DATE 1996 7 13 date created or changed, yyyy mm dd*
DATA FILE SIZE 46432792 data set size in bytes*

BYTE COUNT 6076 header byte count*

END USGS_ HEADER *

The Properties tab in the GeoExpress interface provides information about the input images used
in a project. Information about any TIFF compression technique used in the input images is also

provided, even if the technique is not supported by GeoExpress.

The following table lists TIFF compression types displayed by GeoExpress and whether the com-

pression type is supported by GeoExpress.
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TIFF Compression Types and Support in GeoEx-

press
Compression Supported?
CCITT Group 3 fax No
CCITT Group 4 fax No!
Limpel-Ziv-Welsh (LZW) Yes
Old JPEG No
Standard JPEG, including 12-bit Yes
NeXT run-length No
CCITT run-length encoding Yes?
Pixar image format No
Desktop color separation No
Standard JBIG No
Pack-bits encoding Yes
ThunderScan No
Deflate method (PNG) No

1GeoExpress is able to process single-page Group 4 TIFF files, but encoding this format is not

recommended.

2There are many different types of run-length encoding. Some methods are supported; others are

not. GeoExpress works best with uncompressed images.

Following is the header metadata from a sample MrSID image.

Record O:

Tag: GEOTIFF CHAR::GTModelTypeGeoKey
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Type: ASCII[1]

Data:

[0]: ModelTypeProjected

Record 1:

Tag: GEOTIFF CHAR::GTRasterTypeGeoKey
Type: ASCII[1]

Data:

[0]: RasterPixelIsArea

Record 2:

Tag: GEOTIFF CHAR::GeogEllipsoidGeoKey
Type: ASCII[1]

Data:

[0]: Ellipse GRS 1980

Record 3:

Tag: GEOTIFF CHAR::GeogGeodeticDatumGeoKey
Type: ASCII[1]

Data:

[0]: Datum North American Datum 1983
Record 4:

Tag: GEOTIFF CHAR::ProjLinearUnitsGeoKey
Type: ASCII[1]

Data:

[0]: Linear Meter

Record 5:
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Tag: GEOTIFF CHAR::ProjectedCSTypeGeoKey
Type: ASCII[1]

Data:

[0]: PCS NAD83 UTM zone 10N

Record 6:

Tag: GEOTIFF NUM::1024::GTModelTypeGeoKey
Type: UINT16[1]

Data:

[0]: 1

Record 7:

Tag: GEOTIFF NUM::1025::GTRasterTypeGeoKey
Type: UINT16[1]

Data:

[0]: 1

Record 8:

Tag: GEOTIFF NUM::2050::GeogGeodeticDatumGeoKey
Type: UINT16[1]

Data:

[0]: 6269

Record 9:

Tag: GEOTIFF NUM::2056::GeogEllipsoidGeoKey
Type: UINT16([1]

Data:

[0]: 7019
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Record 10:

Tag: GEOTIFF NUM::3072::ProjectedCSTypeGeoKey
Type: UINT16[1]

Data:

[0]: 26910

Record 11:

Tag: GEOTIFF NUM::3073::PCSCitationGeoKey
Type: ASCII[1]

Data:

[0]: Universal Transverse Mercator; North American 1983; GRS80; Zon

e Number 10N

Record 12:

Tag: GEOTIFF NUM::3076::ProjLinearUnitsGeoKey
Type: UINT16[1]

Data:

[0]: 9001

Record 13:

Tag: GEOTIFF NUM::3080::ProjNatOriginLongGeoKey

Type: FLOAT64[1]

Data:
[0]: =123.000000
Record 14:

Tag: GEOTIFF NUM::3081::ProjNatOriginLatGeoKey

Type: FLOAT64[1]
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Data:

[0]: 0.000000

Record 15:

Tag: GEOTIFF NUM::3082::ProjFalseEastingGeoKey
Type: FLOAT64[1]

Data:

[0]: 500000.000000

Record 16:

Tag: GEOTIFF NUM::3083::ProjFalseNorthingGeoKey
Type: FLOAT64[1]

Data:

[0]: 0.000000

Record 17:

Tag: GEOTIFF NUM::3092::ProjScaleAtNatOriginGeoKey
Type: FLOAT64[1]

Data:

[0]: 0.999600

Record 18:

Tag: IMAGE::INPUT FILE SIZE

Type: FLOAT64[1]

Data:

[0]: 75121662.000000

Record 19:

Tag: IMAGE::INPUT FORMAT
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Type: ASCII[1]

Data:

[0]: GeoTIFF

Record 20:

Tag: IMAGE::INPUT NAME
Type: ASCII[1]

Data:

[0]: H:\Seattle\1l0tet279287.tif
Record 21:

Tag: IMAGE::WIDTH
Type: UINT32[1]

Data:

[0]: 5000

Record 22:

Tag: IMAGE::HEIGHT
Type: UINT32[1]

Data:

[0]: 5000

Record 23:

Tag: IMAGE::COLOR SCHEME
Type: UINT32[1]

Data:

[0]: O

Record 24:
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Tag: IMAGE::DATA TYPE
Type: UINT32[1]

Data:

[0]: O

Record 25:

Tag: IMAGE::NO DATA VALUE
Type: UINT8[3]

Data:

Record 26:
Tag: IMAGE::TRANSPARENT DATA VALUE
Type: UINT8[3]

Data:

Record 27:

Tag: IMAGE::XY ORIGIN
Type: FLOAT64[2]
Data:

[0]: 527900.150000

[1]: 5230199.850000
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Record 28:

Tag: IMAGE::X RESOLUTION
Type: FLOAT64[1]

Data:

[0]: 0.300000

Record 29:

Tag: IMAGE::Y RESOLUTION
Type: FLOAT64[1]

Data:

[0]: 0.300000

Record 30:

Tag: IMAGE: :WKT

Type:

Data:

ASCII[1]

[0]: PROJCS["NAD83 / UTM zone 10N",GEOGCS
["NAD83", DATUM["North American Datum 1983",
SPHEROID["GRS
1980",6378137,298.2572221010002, AUTHORITY
["EPSG","7019"11,

AUTHORITY ["EPSG","6269"]],PRIMEM["Green-
wich",0],UNIT["degree

(supplier to define representation)
",0.01745329251994328]

, AUTHORITY ["EPSG","4269"]], PROJECTION["Trans-
verse Mercator"],
PARAMETER["latitude of origin",0], PARAMETER
["central meridian",-123],

PARAMETER["scale factor",0.9996], PARAMETER
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["false easting",

500000], PARAMETER["false northing",0],UNIT
["metre", 1,
AUTHORITY["EPSG","9001"]],AUTHORITY
["EPSG","26910"]]
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Data Cartridges

If you have a copy of GeoExpress Standard Edition, you may need to install a data cartridge

before being able to encode images.

To install cartridges, visit https://www.lizardtech.com/support/product-activation/. To order addi-

tional cartridges, contact your LizardTech sales representative.

The information below tells you how to access and use the Data Cartridge Manager and how to

calculate cartridge usage.

For more information see Installing Data Cartridges on page 11 and Data Cartridge Gauge on

page 16.
Data Cartridge Manager

The Data Cartridge Manager has tabs for configuration, administration, and history of the Express

Cartridge Manager (ECM) as shown below.

To access the Data Cartridge Manager select Data Cartridge from the Tools menu.
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Configuration | Administration | Local ECM History |

Express Cartridge Manager
+ |Jze local ECM " |Use network ECM

Local ECM Info
Express Cartridge System (D | FO1G0AEZETTCD 164

Amount of data encoding available: 0 KB

Your local Data Cartridge is empty and no encoding can be performed. See the
Administration tab for information on how to order and install a new local Data
Cartridge.

Configuration

The Configuration tab shows which ECM system is currently active, either a local ECM or a net-
work ECM. You must have a local ECM installed to run GeoExpress in case a network ECM is
unavailable. The configuration tab also shows the amount of units remaining in the active data
cartridge. If "local ECM" is selected, the tab also displays the system ID for the local ECM. If "net-
work ECM" is selected, the host name and port ID of the network ECM are displayed, which you
can change by clicking the “Select a network ECM...” button. A valid host name and port ID must
be supplied for a network ECM, and the application won't accept the specified network ECM until

it initializes it successfully.
Administration

The Administration tab displays instructions for ordering and installing a new local data cartridge

and has a button for selecting a local data cartridge to install.
History

The History tab loads and displays the transaction log file for the local ECM. It only gets loaded
once during the lifetime of the Data Cartridge Manager, so the dialog must be dismissed and

opened again to refresh the history information.
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The number of megabytes deducted for a job is approximately equal to the nominal size of the
image or point cloud. For raster images, you can calculate the nominal size with the following

equation:
width x height x number of bands x bytes per band

For LiDAR point clouds, the nominal size is a measure of the number of points in the point cloud

and the number of fields for each point.

For mosaics, the cost is calculated from the sum of the nominal sizes of the input tiles rather than
from the nominal size of the resulting mosaic. This means that in cases where a mosaic of non-

contiguous images is created you are not charged for the areas without tiles.

NOTE: Because the charge is based on the nominal size of the image rather than the
physical input file size, the encoding of compressed images such as JPEG deducts the

cartridge by the same amount as the encoding of input images that are not compressed.

Floating licenses enable a user on a networked computer to lease or “check out” a GeoExpress
license for the period of time they are working. When the user exits the program, the license is

returned to the License Server and available for another user.

The LizardTech License Server runs as a service named LizardTech License Server.

The License Server is installed from the GeoExpress installation DVD. You must have admin

rights to install the License Server.
Toinstall the LizardTech License Server:

1. Insert the GeoExpress DVD in the DVD drive. The DVD browser screen appears. (Note: If

the DVD browser does not appear, double-click the autorun . HTA file found on the DVD)

2. Select License Server w/Tools and Documentation, then follow instructions until
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finished. By default, the product is installed in "C:\Program Files\LizardTech\License

Server".

The installation creates the LizardTech License Server service.

For additional information on the setup and usage of LizardTech License Server, see the

SentinelLM System Administrator's Online Guide installed with your License Server.

Once you have installed the License Server you must acquire a license code or “unlocking code”

from LizardTech. An unlocking code is required for each License Server you add to your network.
To add a license for a License Server on Windows or Linux:

1. Runthe echoid.exe file to display your locking code. On Windows this file is located by
default in "C:\Program Files\ LizardTech\License Server\bin". On Linuxit isin "/us-

r/local/LizardTech/LicenseServer/". Record this value.
2. Copy your locking code, then use a Web browser to navigate to the following URL:
www.lizardtech.com/support/activation/.

3. Enter and submit your locking code. You will receive your unlocking code within 24 hours.

When you receive your unlocking code, run the 1slic. exe file in the same Tools dir-

ectory by one of the following methods:
a. Openacommand line interface and enter 1slic.exe -A <Unlocking
Code> (where Unlocking Code is the code given to you by LizardTech)
b. Select Run from your Start menu. In the Open field of the Run dialog box, enter
lslic.exe -A <Unlocking Code> (where Unlocking Code is the code given

to you by LizardTech).
Alternatively, you can manually add the locking code to following file:

/usr/local/LizardTech/LicenseServer/licenseserver/lservrc
To manually start the License Server, run the . /1serv utility.

While using LizardTech License Server on a UNIX platform, you must be logged in as root to:
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o Start the License Server

o Change distribution criteria (for redundant servers)
e Shut down the License Server

e Turn license server logging on and off

e Turn token borrowing on and off

o Add or delete license servers from the redundant license server pool

Only the user who started the license server can stop the license server. It is strongly recom-

mended that only the root user administer the license server.

In most cases, you will not be aware of the floating license leasing process because it will occur
invisibly and automatically. In these cases, the user need only install the LizardTech License
Server. However, there are situations where the end-user will have to adjust their settings to
ensure that they are using the correct license, as for example when a client machine has access to
both a standalone and a NITF-enabled network version of the same license, or if there are two dif-
ferent versions of a license on the license server and the user would prefer one over the other (i.e.
NITF-enabled versus non-NITF-enabled). In these cases, GeoExpress by default prefers the non-
NITF version if one is available. To change this you must set your licensing options so that pref-

erence is given to the NITF-enabled license.
To specify a preferred License Server:
1. Select Licensing from the Options menu.
The License Management dialog box appears.

Enter a license server and click OK.
Optionally, to specify a preference for a NITF-enabled license, select the Prefer

NITF License check box.

As the license server administrator, you may control the percentage of available floating license
seats that can be used as commuter licenses. That is, the number that can be checked out and

used without a connection to the network.

To configure licenses:
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Set your LSERVOPTS system environment variable with the following:
-com <percentage>

where <percentage> is an integer between 0 and 100. Do not include a percent sign. This per-

centage value determines the number of licenses that can be checked out as commuter licenses.

For example, specifying "-com 0" ensures that no floating licenses can be checked out as com-
muter licenses, while specifying "-com 100" ensures that all floating licenses may be checked out

as commuter licenses.

NOTE: The percentage value rounds down so that, for example, specifying "-com 50"
on a server that has 3 licenses allows only 1 license to be checked out as a commuter

license.

This environment variable affects all application licenses your license server is serving out,
whether for GeoExpress or other applications. This means users of other software applications
whose licenses you are administrating through your license server can be affected. For example,
suppose you have 4 licenses for GeoExpress and you want to make 2 of them available for com-
muting. Suppose also that you have 1 license for Acme Supersoft. Specifying "-com 50" will
make half of your GeoExpress licenses available as you planned but will have the additional side
effect of restricting your Acme Supersoft license from being checked out (50% rounded down of

one license is 0).

Several utilities are available to help server administrators manage the LizardTech License Server
on their network. By default these tools and their documentation are installed from the GeoEx-

press DVD when you install the License Server.

IMPORTANT: The License Server should be installed on the same subnet as any cli-
ents who wish to access it. If your License Server is not installed on your local subnet,
you will be prompted to specify the name of the computer you wish to connect to for a

floating license in the GeoExpress Licensing dialog box.

Following are descriptions of other utilities included in GeoExpress that administrators are likely
to need to access and use. For more information on these utilities and on others not listed below,

see the SentinelLM System Administrator’s Online Guide installed with your License Server.
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License Server Utilities

Utility Platform Description
echoid All Generates a locking code
Iserv Unix only Starts the server (must have admin rights)
Starts/stops the server (see the SentinelLM System Admin-
Iservnt NT only
istrator’s Online Guide for parameters)
loadls NT only Loads the License Server service into NT services
Windows
WImAdmin.exe Displays a list of servers/licenses
only
Isrvdown All Stops the server (must have admin rights)
Islic All Adds a license to your license file.
Ismon All Monitors license server transactions.
Iswhere All Displays a list of license servers.

In most cases, you will not be aware of the license check-out process because it will occur invisibly

and automatically (see Setting License Server Options on page 221 above).

IMPORTANT: When using floating licenses a constant connection to the license server

is required to perform encodes. If network connectivity is lost, encodes will fail.

A commuter license is a floating license that has been disconnected from the network. If you are
using a portable (laptop) computer, as for traveling purposes, you can check out a license from a
license server on your network and then disconnect from the network. You can then use GeoEx-

press to encode images, no matter where you go, even out of the country.
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NOTE: You must have purchased the Floating License option for GeoExpress in order
to use commuter licenses. For more information, contact your LizardTech rep-

resentative.

To check out a commuter license, run the appropriate commuter utility as shown in the table

below. These utilities ship with GeoExpress. Instructions for using them are given below.

IMPORTANT: You must check in a commuter license when you are through using it
(see instructions for each utility below). If you leave a license checked out after you are

finished using it, it remains unavailable for other users.

Commuter License Checkout Utilities

On this plat-
Use this utililty...
form...
LizardTech's Commuter Licensing utility or 1tcom-
win32
mute.exe
LizardTech's Commuter Licensing utility or 1tcom-
win64
mute.exe
Linux lcommute

Use the Commuter Licensing utility for win32 and w64 platforms as an alternative to Lcommute

or 1tcommute. The Commuter Licensing utility uses the executable wcommute . exe.
To check out a license using LizardTech's Commuter Licensing utility:

1. On the Start menu select Programs > LizardTech > GeoExpress > Commuter
Licensing.
Alternatively, run the executable wcommute . exe. The Commuter Licensing dialog

appears.

2. Click Single Server... and specify a server name, then click OK. Alternatively, click
Search Subnet. Available licenses are displayed.

3. Select alicense and click Check Out. The license is now marked with a red check.

To check a license back in using the Commuter Licensing utility:
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1. Onthe Start menu select Programs > LizardTech > GeoExpress > Commuter
Licensing. The Commuter Licensing dialog appears.

2. Click Single Server... and specify a server name, then click OK. Alternatively, click
Search Subnet. Available licenses are displayed.

3. Select the license (it will be marked with a red check when it is checked out) and click

Check In. The license becomes unmarked and is now available for another user.

Use the 1 tcommute utility for the win32 and win64 platforms.

To check out a license using 1 tcommute use the following command:
-co -s <server> -fn <feature name> -fv <feature version>

To check a license back in using 1 tcommute use the following command:

-Ci -s <server> -fn <feature name> -fv <feature version>

Use the 1commute utility for Linux platforms.

The 1commute utility can be used either with parameters or interactively. To operate inter-
actively, specify no arguments at the command line (for more information see the System Admin-

istrator's Online Help, distributed on your GeoExpress DVD-ROM).
To check out a license using 1 commute use the following command:

-C 0 -0 n -s <server> -f <feature> -v <version>-d 0
IMPORTANT: Zero (0) must be used with the —-d argument.

To check a license back in using 1 commute use the following command:

-ci -0 n-s <server> -f <feature> -v <version>

If you wish to use GeoExpress in a Terminal Services environment, you must have GeoExpress
Remote Edition, which must be served from a valid License Server (see above). For more inform-

ation contact your LizardTech representative.
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Following are answers to some frequently asked questions. If the information you need is not
among the answers here, see for a brief outline of where to find particular information in this doc-

umentation.

Data cartridges are small, binary encrypted files that enable you to encode images
with GeoExpress. Cartridges are a software-based replacement for the traditional
physical dongle or hardware lock. They are generated by LizardTech, based upon

your system ID, and then emailed to you as an attached file.

Data cartridges are installed through the GeoExpress user interface. The user inter-
face displays the amount of data in the installed cartridge and the amount of ‘encod-
ing’ capacity remaining on the cartridge. The data cartridge is decremented based
on the amount of input data calculated by multiplying the number of pixels to be

encoded times the pixel depth.

For raster jobs, only the initial creation of MrSID and JPEG 2000 images charges
the cartridge. Working with images that are already in the MrSID or JPEG 2000
format does not decrement the data cartridge. For instance, you can create a
lossless MrSID or JPEG 2000 file, which decrements the cartridge, and then use
that file to create visually lossless compressed MrSID or JPEG 2000 files that do
not charge against the cartridge. Additionally, updating mosaics and creating mosa-

ics of existing MrSID or JPEG 2000 files do not charge against the cartridge.

For LiDAR jobs, the following operations charge the data cartridge:

¢ Creating a MrSID image from any other file format. However, creating a

MrSID image from another MrSID image does not charge the data
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cartridge.

o Creating a LAZ image from a LAS image or a LiDAR text file. However, cre-
ating a LAZ image from another LAZ image does not charge the data cart-
ridge.

e Creating a LAS image from a LiDAR text file.

If you have an input MrSID image, you can decode the image to LAS or LAZ
without charging the data cartridge.

Yes. GeoExpress has a server-based shared capacity cartridge. This is NOT a float-
ing license (for floating license information see below) but rather a “big bucket” of

capacity that can be accessed by multiple licensed users on the network.

For more information see Licensing GeoExpress on page 9 and Floating Licenses on page 219.

License Server options are accessible on the Options menu under “Licenses”.

When you run GeoExpress after the temporary license has expired, the program
first looks for a valid standalone ("local") license on your computer. If there is none,
it looks for a valid floating license by trying to connect to a license server on your
local subnet. If it cannot find one you are prompted to either activate a permanent
standalone license or specify a license server on your local subnet or a broader net-

work.

Y ou may also specify whether or not GeoExpress should prefer a NITF-enabled
license if it has to go to the network to get a license. By default, GeoExpress gives
preference to a non-NITF-enabled license. You can change this on the License

Management dialog box (see Setting License Server Options on page 221).
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The File menu enables you to add images and tiles to the Job List and work with GeoExpress

project (.prj) files. A project file is a collection of jobs and global settings.

Menu Item Shortcut Function

Enables you to add input files to theJob list.

The supported image formats are TIFF/GeoTIFF, AUX
(special mosaic text file), raw (BIP/BIL/BSQ), Windows
BMP, Erdas Imagine, JPEG/JFIF, JPEG 2000, LAN,
MrSID, NITF, Sun Raster, and USGS DOQ. File types are

Add image(s)...

determined by file extensions, and if a file with an unre-
cognized file extension is selected, you will be asked to

identify the file type via the “Identify File Type” dialog.

Adds an empty Mosaic job to the Job list. You must specify
the file type of the source images that willbe used in the
mosaic. (For supported file formats in GeoExpress see

Create new mosaic of
Supported Input Formats on page 26.) User can also

mages... select a multi-resolution mosaic option and whether the
output mosaicis a flat file or composite MrSID mosaic
(MrSID format input files only).
Enables you to add an image job consisting of separate
Add color composite source files that represent the red, green, and blue bands
image to encode... of a single image. A dialog box is presented with options for

adding each band, and at least one band must be supplied.
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Menu Item

Shortcut

Function

All of the bands must be single banded images of the same

file type and have the same dimensions and resolution.

New project

CtrlI+N

Clearsthe current project and gives you a new empty pro-

jectto populate.

Open project...

Ctrl+O

Enables you to open a previously saved GeoExpress pro-

ject file from disk.

If the project file was created by MrSID GeoEncoder, the
application gives you the option of converting the file and
saving it to a new file. Project files are supported for pre-

vious versions of GeoExpress.

Save project

Ctrl+S

Saves the current project file to the existing project file on

disk.

Save project as...

Ctrl+Shift+S

Saves the current project file to a new file, which is spe-

cified by the user via a standard Save File dialog box.

The application saves project files in the GeoExpress .prj

format.

Print session log

Ctri+P

Prints out the log of all encode jobs run since the applic-
ation was opened. This is the same information displayed
in the Encode Results window on the Output tab of the Job

Properties panel.

Recent projects

Keeps a list of the last four project files to be accessed, so
they can be quickly loaded without having to go through an

Open File dialog.

Recent files

Keeps a list of the last four non-project files to be added to

the project, so they can be easily added to the Job list.

Exit

Ctr+Q

Enables you to save your current project and/or cancel the
current encode operation before it shuts the application

down.

The Jobs menu provides another means of executing jobs.

The Jobs menu consists of the following items:
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Menu Item

Function

Run selected jobs

Runs all the jobs that are selected in the job list.

Run alljobs

Runs alljobs, whether selected or not.

The Options menu provides access to basic encode parameters, preferences and licensing.

Menu Item

Function

Job options...

Displays the most common options for the selected job, including com-

pression options, output options, and more.

Advanced options...

Displays advanced job options for the job, including transparency

options, band options, format-specific options, and more.

Tile options...

Brings up the Tile Manager and is only selectable when a mosaicfile is
highlighted in the Job list. This dialog enables you to add and remove
tiles from the selected Mosaic or Update job. It also has an option for
cropping tiles, which invokes the Crop Manager. The “Move Up” and

“Move Down” buttons change the order of the selected tiles in the list,

and tiles can also be added and rearranged by dragging and dropping.

NITF image segments...

Displays the image segments in the selected NITF file.

Select the default preferences for raster files. You can edit the default

Preferences... output directory and file format, set a default compression ratio for
each file format, and more.
Select the default preferences for LIDAR files. You can edit the default
LIDAR Preferences... compression ratio, the default number of points to display in the pre-
view of point clouds, and more.
Enables user to specify a preferred License Server or that preference
Licensing

be given to a NITF-enabled license if one is available.

The Tools menu offers options related to more complex encoding functions.
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Menu Item

Function

Metadata...

Brings up the Metadata Manager. This provides fields for inputting the
classical MrSID user metadata tags for company name, copyright,
credit, summary, keywords, comments, image 1D, imaging date, ima-
ging time, source device, scan info, and geographic location. These
tags are only available for MrSID Image and Mosaic encode oper-

ations.

Despeckling...

Brings up Despeckling Options dialog, where you can choose to des-

peckle your image or tile and set despeckling options.

Image crop...

Brings up the Image Crop dialog box. This tool enables you to specify a
region of interest for the selected job by entering coordinates in the text
fields or by drawing a rectangle in the visual representation of the
image. You can choose to represent the region of interest in either
pixels or geospatial coordinates. The supported rectangle descriptions
are edge offset (the classical format), upper-left lower-right, upper-left

width-height, and center width-height.

Area of interest...

Brings up the Area of Interest dialog box. The area of interest controls
look and operate much the same way as those of the image crop func-
tion. However, whereas image crop permanently removes all data
from the area outside the desired region, area of interest can be used
to increase or decrease the level of visual quality in a particular region
of animage, or to make a desired region download completely before

the rest of the image is resolved.

Color balance...

Brings up the Color Balance dialog box, enabling you to balance bright-

ness, contrast and color values among mosaic tiles.

Reproject...

Brings up the Reprojection Manager enabling you to reproject one or
multiple images from one spatial reference system (SRS, sometimes

also called a coordinate reference system or CRS) to another.

Data cartridge...

Brings up the Data Cartridge Manager, which has tabs for con-
figuration, administration, and history of the Express Cartridge Man-

ager (ECM).

Publishimages...

Brings up the Publish Images dialog box, enabling you to publish exist-

ing images directly to an Express Server.
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The Help menu provides information about GeoExpress and access to additional resources.

Menu Item

Shortcut

Function

Contents...

Ctrl+H

Invokes this online help system.

About GeoExpress 9.5...

Displays product information and legal text,

along with the version number of the software.

LizardTech online tech sup-

port...

Ahyperlink to LizardTech’s support website that

invokes your default HTML browser.

Open log files folder

Opens the directory containing session and job

logs.
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GeoExpress Feature History

The following features and improvements to existing functionality were added in past versions of

GeoExpress.
GeoExpress 9.1

Floating Point Support for MrSID Generation 4

When you compress a floating point image, GeoExpress uses quantization to compress the

image. You can create 32-bit floating point images in the MrSID Generation 4 format.

Quantization is a lossy compression method that reduces the number of pixel values in the image.

Quantization is necessary for floating point images for two reasons:

Performing arithmetic on floating point values results in rounding discrepancies.
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Compressing floating point values results in unnecessarily large images. This is because some of

the digits in each pixel value contain data that is not significant and cannot be compressed.

As a result, GeoExpress uses a lossy compression method for floating point images, but guar-

antees the accuracy of the image data to an optimized precision value.

To improve the appearance of MrSID images in other GIS programs, you can use GeoExpress to
write dynamic range metadata forimages. For an image where the dynamic range is less than the
full range of possible values for the image, you can use your GIS program to stretch the pixel val-

ues across the full range. For example, if you have a 16-bit image and the dynamic range is 12

bits, then you may want to use dynamic range stretching to improve the appearance of the image.

When you create an auxiliary file for an image, GeoExpress writes additional metadata into the
auxiliary file. If the image contains regions without image data, the no-data values are stored in
the auxiliary file. Additionally, if you generate dynamic range metadata for the image, the

dynamic range values are stored in the auxiliary file.

The performance of multi-core processing has been improved. Each job that you run in GeoEx-

press uses less processing power and finishes faster.

You can calculate image statistics for each band in an image from the command line. The image
statistics include the minimum value, the maximum value, the mean value, and the standard devi-

ation. Enter the following command to calculate statistics for an image:

mrsidgeoinfo -stats <Image Name>

Any images that you add to the GeoExpress graphical user interface appear in the same simple

job list. You can view and run all jobs in the same job list regardless of the image compression
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and manipulation operations that you want to perform. Previously, jobs were scattered across mul-

tiple tabs.

GeoExpress automatically uses its optimization feature whenever possible. The optimization fea-
ture performs a subset of image compression and manipulation operations without re-encoding
images. Previously, to use optimization you needed to remember which operations supported

optimization, and you needed to add images to a separate Optimize tab.

The user interface includes updated window graphics and icons.

If you run GeoExpress on a machine with a multi-core processor or on a machine with multiple pro-
cessors, GeoExpress creates multiple threads to process jobs more quickly. The number of
threads and jobs that you can run at one time depends on the number of cores in your machine's

processor.You can use a maximum of eight cores for image encoding.

For images that include rotation metadata, GeoExpress creates rotated output images. This fea-
ture is turned on by default so that your images are displayed with the correct orientation even in
viewers that do not support metadata for image rotation. Previously, GeoExpress preserved rota-

tion metadata without rotating the output image.

You can add custom watermarks to your images. GeoExpress supports watermark images in
BMP, PNG, and JPEG formats. You can use black and white images with maximum dimensions

of 128 pixels by 128 pixels.

You can create mosaics that use multiple coordinate reference systems from the command line.
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GeoExpress now supports PNG files. You can perform any operation with PNG files that you can

perform with other supported file formats.

GeoExpress can now interpret NITF files with RPC metadata.

As of GeoExpress 8.5, you can specify a different compression ratio for each band or any group of

bands in a multispectral image. Customize the compression of your imagery band by band.

GeoExpress 8.5 made it easier for you to control how many of your network license seats can be

checked out as commuter licenses (used without a connection to the network).

GeoExpress 8 introduced compression of raster imagery to MG4, the latest version of the
MrSID image compression format. MG4 files can be viewed in either of LizardTech's free viewers,

GeoViewer and ExpressView Browser Plug-in.

As of version 8 GeoExpress uses the alpha masking capabilities in MG4 to enable you to specify
which areas of your imagery you want to be transparent (nodata areas) and opaque, then creates
an alpha mask and stores it in an alpha band or alpha channel. The alpha band is preserved
losslessly even when you are encoding lossily, so that your imagery is always free of the speckling

artifacts that can appear after compressing nodata.
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GeoExpress 8 introduced support for multispectral and hyperspectral images, enabling you to
compress up to 255 bands. Whether you need to compress 4-band color images containing an
infrared channel, take advantage of the latest 8-band satellite imagery, or compress high-res-

olution RGB datasets, GeoExpress has you covered.

GeoExpress 8 also introduced improved mosaicking options. Previously, mosaics were either
quick to create but slower for end users to open, or took a long time to create but opened rapidly in
viewing applications. Now you can combine thousands of MrSID files without spending valuable
time reprocessing them. MG4 mosaics open as quickly as a single image, so you save time cre-

ating images and your users save time viewing them.

As of GeoExpress 7, export imagery to Express Server (version 6.0 or later) directly from GeoEx-
press. Newly encoded imagery can be output directly to an Express Server and you can publish

your existing images to an Express Server without having to reencode them.

The optional Express Server Management Console is an easy-to-use Microsoft Management Con-
sole (MMC) snap-in included on your product CD-ROM. Once installed, it can be accessed directly
from the GeoExpress toolbar for creating, indexing, and managing catalogs of MrSID and JPEG

2000 imagery.

As of GeoExpress 7, take advantage of more memory (4+ GB) to create mosaics of imagery mul-
tiple terabytes in size. Encode your MrSID imagery faster than ever before by being able to use

today’s advanced systems.
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As of GeoExpress 7, you can “check out” a floating license for your laptop and take it off the net-
work. Use GeoExpress’ manipulation and encoding functions in the field without having to pur-

chase and activate standalone licenses.

Generate AUX files for georeferencing. Make sure the metadata in your MrSID and JPEG 2000

imagery will be readable in Esri applications by generating an Esri AUX file when encoding.

By selecting a shape file or GML coverage you can crop by a complex polygon rather than a

simple square.

Despeckling — Take advantage of GeoExpress 7’s despeckling technology to remove com-

pression artifacts at the edge of images and make your mosaics look cleaner.

"Recently Used" Projections Feature and Updated Library — GeoExpress 7 saves you time
by making it easier to select the coordinate systems you use most often. Also, support for over

500 additional EPSG coordinate reference systems has been added to GeoExpress.

Improved Status and Error Messages — GeoExpress 7 makes it easier to determine what

licenses are being used and assist with troubleshooting.

Improved Metadata Tools — Edit your MrSID and JPEG 2000 imagery's custom metadata tags
and add new ones. Edit the coordinate system of your imagery without having to reencode. Use
your custom metadata tags to build robust, flexible Web applications with LizardTech Express

Server.

Expert Level Tools — Demosaic or “tile out” your imagery by specifying a grid. Easily decode all
or part of your MrSID or JPEG 2000 image to GeoTIFF directly within GeoExpress. No need to

learn command line tools.
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As of version 6.1, GeoExpress enables you to add GML metadata to JPEG 2000 imagery. GML
stands for Geographic Markup Language, a specification ratified as a standard by the Open GIS
Consortium (OGC) in 2005 and the ideal way for geospatial image metadata to be included within
the JP2 file format. Now you can give your JPEG 2000 imagery "spatial awareness" with the most
advanced method available today for including geographic metadata in your JP2 files. Liz-
ardTech's support for GMLJP2 means you can increase the value of your geospatial imagery
using the same familiar GeoExpress workflow. Now when you mosaic, color balance, reproject,
and specify areas of interest in your JPEG 2000 imagery, you can also include GML metadata
and the GML schemas that downstream applications will use to integrate and make use of your

imagery in geospatial workflows.

The color balancing functionality introduced in GeoExpress 6.0 was expanded in version 6.1 to
address several kinds of nonuniform tonal imbalance. Tilt, vignetting and seam lines can be cor-

rected as part of the familiar GeoExpress image processing workflow.

As of version 6.1, GeoExpress enables you to publish SID and JP2 images to Oracle Database
10g either as direct output from the encoding process or as a publishing operation on existing

imagery.

As of version 6.0, a color balancing tool enables users to perform histogram matching on image
tiles being mosaicked together, reducing the patchy effect that often results from the joining of

adjacent tiles that were captured at different times or in different conditions.
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As of version 6.0, GeoExpress supports using vector overlays for encoding multiple, non-rect-

angular areas of interest.

As of version 6.0, GeoExpress enables greater flexibility for multiple users in networked envir-
onments by supporting floating licenses. Floating licenses can be obtained from a license server
that is included on the GeoExpress CD; users check out a license while they work, and when they

are finished the license becomes available again to other users.

As of version 6.0, GeoExpress:

o supports 12-bit JPEG-encoded variants of input formats such as TIFF and NITF*

o allows users to edit encode jobs while other jobs are encoding in the background

¢ includes a check box among the Output options for converting incoming 16-bit data to 8-bit
data during encoding

e supports encoding 16-bit DTED images to JPEG 2000

¢ adds improved support for custom well-known text strings (WKTs).

As of version 5.0, GeoExpress enables users to reproject images from one coordinate reference
system (CRS) to another. GeoExpress supports reprojection for MrSID Generation 3 (MG3),
JPEG 2000 and NITF 2.1* output formats. Reprojection controls are located on the Reprojection

tab of the Encode Options dialog.

GeoExpress 5.0 includes full support for JPEG 2000 as an output image file format. Now you can
use JPEG 2000 compression on geospatial images with the same level of efficiency, metadata,
and large-image support already available with MrSID. The JPEG 2000 image compression stand-
ard describes many of the advantages that have been implemented for years in the MrSID

format, plus the added benefits of being an international standard (ISO/IEC 15444).

242 -



Appendix D - Company and Product Information

With the addition of support for JPEG 2000 images, GeoExpress 5.0 introduced a Profile Man-
ager for handling the various encoding parameters that JPEG 2000 uses. A profile is a collection
of settings that can be applied to the creation of a JPEG 2000 file. GeoExpress installs several

industry accepted profiles and enables users to create and save their own custom profiles.

The color compositor allows the creation of multiband JPEG 2000 files from a collection of single-
band grayscale image files. The input files must all have the same dimensions, resolution, bit

depth, and geographic positioning. Empty bands are allowed, and treated as zero data.

NITF 2.1 images can be encoded as either raw or JPEG 2000 files.

*Support for encoding NITF images is available for GeoExpress. Contact your LizardTech rep-

resentative to purchase the NITF Extension for GeoExpress.

The area of interest functionality in GeoExpress can be used to increase or decrease the level of
visual quality in a particular region of an image. For example, a large image of a city in the desert
may be encoded with a lower compression ratio for its urban region while the outlying areas are
more aggressively compressed, thus preserving greater detail only where it is needed and else-
where gaining the file-size advantages of higher compression. In the opposite way, the United
States White House or any other sensitive area of an image can be “blurred” through area of
interest encoding so that detail may not be viewed. Area of Interest can also be used to make a
desired region download sooner than the rest of the image, which can be very useful across net-

works and for end-users with low bandwidth.

Color Space Tab — The MrSID file format does not support multispectral color spaces, so in order

to accommodate multispectral input files, an output or “target” color space and band orientation
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must be specified. A Color Space tab appears on the Encode Options dialog box for this purpose.

The target color space is only supported for encoding single images and flat image mosaics.

Transparency Tab — To handle multispectral imagery, the controls on the Transparency tab of the

Encode Options dialog box were updated to handle any number of bands.

As of version 4.1, GeoExpress accepts multibanded image files as input. Multispectral imagery

must conform to the following criteria:

o The data type for the imagery must be 8-bit or 16-bit

o All bands must be of the same data type

o Users can preview multispectral images by viewing the individual bands, or by combining
them in an RGB triplet. The MrSID image format does not support arbitrary color spaces
with n bands, so multispectral input images can only be encoded to a user-specified color

space (e.g. RGB).

In order to support viewing multispectral images, a band selector feature was added to the Pre-
view tab. If the input source image is multispectral, the "Band Selector" button is available on the
Preview tab toolbar. Selecting the "Band Selector" button activates the band selector controls,

which then appear on the right side of the preview window.

World file handling was both simplified and improved to support all input file formats in a uniform
way, not just TIFF and GeoTIFF. In the Preferences dialog box, the "Allow georeferencing from
*.tfw to override GeoTIFF" option was replaced with the more useful "Allow world files to override
native georeferencing” option, which applies to all image formats that support world files. This
option is selected by default, so that world files are always honored. If you wish to ignore world file
data in favor of an image format's native georeferencing (like GeoTIFF or MrSID), deselect this

option.

NOTE: This behavior is different from that of versions of GeoExpress previous to 4.1,
which ignored TIFF world files (*.tfw) by default and only allowed world files to be

ignored for GeoTIFF images.
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As of GeoExpress 4.1, optimize jobs accept MrSID composite images as input, provided that they

contain only MrSID Generation 3 (MG3) tiles.

With version 4.1, GeoExpress became internationalized to help serve the global community, and

now accepts double-byte file names as both input and output.

Thank you for using LizardTech® GeoExpress® software. Try the rest of our product line.

GeoViewer is LizardTech's free, standalone application for viewing geospatial imagery, vector
overlays and LiDAR data. GeoViewer enables you to combine, view and export visual layers from
varied sources, such as local repositories, Express Server catalogs, and WMS and JPIP servers.
GeoViewer supports a wide range of input formats and exports to GeoTIFF, PNG and JPEG. It's

the most efficient means of viewing MrSID and JPEG 2000 images.
For more information about GeoViewer, visit the following URL.:

http://www.lizardtech.com/downloads/category/#viewers.

ExpressView™ Browser Plug-in enables you to view, navigate and print MrSID and JPEG 2000
imagery in Internet Explorer or Firefox. Like GeoViewer, ExpressView enables you to save a por-
tion of an image in a number of other image formats. ExpressView Browser Plug-in is quickly
downloaded, easily installed, and free for individual use. It's the most convenient way to view
MrSID and JPEG 2000 imagery over networks!

For more information about ExpressView Browser Plug-in, visit the following URL.:

http://www.lizardtech.com/downloads/category/#viewers.
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LizardTech LiDAR Compressor™ software enables you to turn giant point cloud datasets into effi-
cient MrSID files that retain 100 percent of the raw data at just 25 percent or less of the original
file size (lossless compression). If storage requirements are critical, you can reduce your LiDAR
file sizes by 90 percent or more by choosing a higher compression ratio and letting LIDAR Com-
pressor select the best way to reach a desired file size (lossy compression). Unlike raw LAS or
ASCII data, LiDAR files compressed to MrSID are easily managed resources you can extract

derivatives from again and again.
For more information about LIDAR Compressor, visit the following URL.:

www.lizardtech.com/products/lidar/.

LizardTech Express Server software is the best solution for distributing imagery in MrSID or
JPEG 2000 format. With Express Server, users on any device access imagery faster, even over
low-bandwidth connections. Express Server is faster, more stable and easier to use than any

other solution for delivering high-resolution raster imagery.
For more information about Express Server, visit the following URL.:

http://www.lizardtech.com/products/exp/.

The MrSID Decode SDK provides a framework for extracting raster or LiDAR data from MrSI1D
files, including MrSID Generation 4 (MG4 ™). Used as the foundation for LizardTech's LIiDAR
Compressor™ and its Express Suite® line of geospatial products — GeoExpress, Express Server
and Spatial Express software — the MrSID Decode SDK is a robust toolkit suitable for complex

application development needs.

MrSID Decode SDK is available for free download at the following URL:
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http://developer.lizardtech.com.

Since 1992, LizardTech has delivered state-of-the-art software products for managing and dis-
tributing massive, high-resolution geospatial data such as aerial and satellite imagery and LiDAR
data. LizardTech pioneered the MrSID® technology, a powerful wavelet-based image encoder,
viewer, and file format. LizardTech has offices in Seattle, Denver, London and Tokyo and is a divi-

sion of Celartem Technology Inc. For more information, visit www.lizardtech.com.
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Technical SUPPOM. . ... 251

This chapter offers information to help you solve issues and recognize error messages you may

encounter using GeoExpress.

Following are descriptions of several problems that could be encountered installing GeoExpress.

The license code was entered incorrectly. The license code is stored in the GeoExpress9\bin dir-
ectory in a file called 1 servrc. Open this file with a text editor and compare the 51-character
license code with the one you received from LizardTech. The code in the 1servrc file can be cor-
rected manually, if necessary. The number (#) character at the end of the license code indicates
the end of the code. Although this character is not required for the license to be considered valid,

it is useful for making sure the entire string is copied, and it is recommended that you leave it in.

The permanent license that you received from LizardTech is keyed for a unique network card iden-
tification number. If the network connection becomes unavailable or your network hardware con-
figuration has changed, the program may not accept the license code. Restore the network
connection or the original network hardware configuration, or fill out the form at https://www.l-

izardtech.com/support/product-activation/ for a new permanent license.

If you have a temporary version of GeoExpress and the clock in your operating system has been

altered — for instance, if you have recently upgraded your system software — security features in
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the licensing software may not allow the program to run. Please contact technical support at

http://www.lizardtech.com/support.

Encoding Problems

If you set a low weight value for an image with low color contrast, you may notice the following pat-

tern of light and dark spots across your image:

The following factors contribute to the creation of this pattern:

o Low weight value

e High compression ratio

e Low color contrast

e MrSID Generation 2 output format

e Image enhancement
To reduce the appearance of this pattern, complete the following steps:
1. Select the image in the Job List.
2. Click Advanced in the Properties tab.

3. Click the Format-Specific tab.
Increase the value in the Weight field. For example, you might change the value from 2 to
3.

5. Optionally, deselect the Image Enhancement option.
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6. Click OK.
7. Clickthe Run Selected Jobs button to run the job.

You may need to know your the version and build number of your GeoExpress software in order to
communicate with LizardTech Support. To find these numbers, select About GeoExpress from

the Help menu.

The version and build numbers are listed on a single line at lower left, in the following format:
Version: 9.5.0.0.3325.default

In this case, the version number is "9.5.0.0" and the build number is "3325".

Below that, a parenthetical note tells you whether the installation is a 32-bit or 64-bit version of

GeoExpress.

Most technical issues can be resolved using the various resources you have available. In addition
to the product documentation and the README file, LizardTech offers a knowledge base and

product updates on the LizardTech website.

http://www.lizardtech.com/support/kb/

The LizardTech Knowledge Base contains articles about known technical and usage issues and is

frequently updated.

http://www.lizardtech.com/forums/

The forums comprise a place to engage in intelligent discourse with the geospatial community.
Ask questions, provide answers, and share product usage tips with other Lizardtech customers

around the world.

http://www.lizardtech.com/products
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Updated versions of LizardTech viewer tools are available for download at no cost.

http://www.lizardtech.com/purchase/other.php

Protect your investment in LizardTech software by participating in a LizartTech support plan. For

more details, please contact your regional LizardTech office.

To contact LizardTech Technical Support, navigate to the following URL in a web browser:

http://www.lizardtech.com/support

The support page includes links to the LizardTech Knowledge Base and the Product Activation

page. A Contact Form is also provided for issues that require further assistance.

In an emergency, call 206-902-2845 between the hours of 8 AM and 5 PM Pacific Time.

IMPORTANT: Please have the following information available to assist in resolving

your problem:

e The task you were working on when the problem occurred

e The command you typed prior to the problem, if applicable

o The exact error message, if applicable

o The type of file you are encoding and the file size

o Whether you have restarted the computer and attempted to reproduce the problem

o Which version of GeoExpress you are running (see Finding Your GeoExpress Version and

Build Numbers on page 251).
o Other LizardTech products you have installed
e The operating system installed on your machine
e The amount of hard drive space available on your machine
o The amount of memory available on your machine

o Any other information you feel is relevant
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Following are descriptions of some terms, phrases and acronyms used in this documentation.

A

Alpha band
An image band that tracks the portions of an image that you do not
want to display. Alpha bands are included in MrSID Generation 4 and
are especially useful for aligning images seamlessly.

B

Band
A band, orimage band, is one set of samples corresponding to one
spectral component of an image. For example, a typical image has
three bands, a red band, a green band, and a blue band.

BBB
The name of a file format for raw images, short for BIL, BIP, and BSQ.

BIL
A band-interleaved by line image. This format stores all bands of
pixel values for each consecutive lline or row of the image.

BIP

A band-interleaved by pixel image. This format stores all bands of

pixel values for each consecutive pixel the image.
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BSQ

A band sequential image. This format stores all pixel values for each

band consecutively.

Byte order

See endianness.

c

Composite mosaic
A MrSID image that contains other MrSID images. Composite mosa-
ics can be created quickly because they do not need to be com-

pressed again, but they may load more slowly than flat mosaics.

Compression
The process of transforming information so that it can be stored or
conveyed in less space than the original information. See also

lossless, lossy and visually lossless.

Compression ratio
A ratio of an image's nominal size and an image's compressed size,
where the nominal size is calculated from the length, width, number
of bands, and number of bits in the image. For example, a raw image

compressed from 10 GB to 1 GB has a compression ratio of 10:1.

D

Dynamic range
The ratio between the largest and smallest values in an image. Image

viewers use dynamic range values to improve the appearance of
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images. For an image where the dynamic range is less than the full
range of possible values for the image, you may want to use your

image viewer to stretch the pixel values across the full range.

Endianness
The order in which bytes are stored in computer memory. There are

two types, little-endian and big-endian.

Flat mosaic
A MrSID image created from multiple input images. Flat mosaics do
not preserve information about each inputimage and require com-
pressing all the inputimages again. However, they load more quickly

than composite mosaics.

Frequency balance
A parameter used in MrSID to determine the emphasis given to
edges and flat color areas when performing compression. See also

weight and sharpness.

G

Gamma
A parameter used in MrSID to determine the emphasis given to
edges and flat color areas when performing compression. In MG3

and MG4 encoding, this parameter is called frequency balance. A
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lower value creates more defined edges, while a higher value creates

softer edges.

GML
Geography Markup Language. An open, XML-based specification for
representing geographic information including geographic features,
coverages, observations, topology, geometry, coordinate reference
systems, units of measure, time and other values. Because itis an
XML grammar, it is both extensible and adaptable to any application

within the broad geospatial field.

K

K-weight
A parameter used in MrSID to determine the emphasis given to the K
(black) band of a CMYK image when performing compression.

L

Level
See zoom level.

Lossless
A compressed image that is identical to the input image across all
pixel values. See also lossy and visually lossless.

Lossy

A compressed image that approximates the pixel values of the input
image. Lossy images are generally significantly smaller than lossless

images. Depending on the compression ratio, a lossy image may
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display compression artifacts or it may appear to the human eye to be

identical to the inputimage. See also lossless and visually lossless.

M

Magnification
The scale at which an image is represented. Magnification is
expressed as a positive floating point value. For example, 1.0 rep-
resents the full image, 0.5 represents a half-scale version, and 2.0 rep-
resents a double-scale version. The magnification value must be a

power of two. See also scale and zoom level.

Metadata
The information stored in an image that is not pixel value information.
For example, typical metadata includes image properties like the
width, height, and colorspace of the image. Alternatively, some
images contain additional metadata such as the name of the image

creator, the organization name, the creation date, and more.

MG2
MrSID Generation 2. A previous version of the MrSID image format.
MG?2 is limited to lossy encoding and does not support optimization

nor some of the advanced features available in MG4. See also MrSID
and MG4.

MG3
MrSID Generation 3. A previous version of the MrSID image format.
MG3 supports lossless encoding, image optimization, composite

images, and more. See also MrSID and MG4.
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MG4
MrSID Generation 4. The current version of the MrSID image format.
MG4 supports all the features of MG3 and adds support for alpha

bands and multispectral images.

Mosaic
An image created from multiple inputimages, also called image tiles,
to form another larger image. There are two types of mosaics, flat

mosaics and composite mosaics.

MrSID

Multiresolution Seamless Image Database - A wavelet-based image
format designed for large, high-quality geospatial imagery. The cur-
rent version of the MrSID file format is MrSID Generation 4. See also
MG4.

Nominal image size
The size of an image calculated from the width, height, number of
bands, and number of bits in the image. The nominal size is iinde-
pendent of the file format or of the compression used on the image.
You can use the nominal size of an image to compare the relative
sizes of images in different formats and to calculate the compression

ratio for an image. See compression ratio.
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(o

Optimization
The process of creating an MG3 image from a source MG3 image
without decoding the image and compressing it again. Common

optimization operations include cropping and removal of resolution

levels.

P

Pixel
A pixel represents a value or set of values for a particular pointin a
raster image. For images with more than one band, a pixel includes
the values of all the bands at the given pixel position.

R

Resolution
A measure of the detail in an image. Typically, this is measured in
ground units per pixel.

S

Scale

The magnification at which an image is represented. Scale is rep-
resented as a signed integer, corresponding to the negative of the log
of the magnification. That is, magnifications of 1.0, 0.5 and 2.0 are
equivalent to scales of 0, 1 and -1 respectively. See also mag-

nification and zoom level.
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Sharpness
A parameter used in MrSID to determine the sharpness of boundaries
between different areas of an image when performing compression.

See also frequency balance and weight.

Strip height
The number of rows of an image to be processed in each step of an
image read operation. Use of smaller strip heights may reduce

memory requirements, but at a possible performance loss.

T

Transparency color
Also called the no-data value. Pixels that match the transparency
color are not displayed. The value can be specificied manually orin

the metadata. See also alpha bands.

v

Visually lossless
An image that appears to the human eye to be identical to the input
image. However, a visually lossless image is actually a lossy image,

and as such only approximates the pixel values of the input image.

w

Wavelet
A mathematical representation of a pixel value that varies by fre-
quency and duration. In wavelet space, the importance of a pixel

depends on the values of its neighboring pixels. Wavelet-based
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image formats are able to present images at multiple zoom levels

without creating image pyramids.

Weight
A parameter used in MrSID to determine the emphasis given to the
grayscale portion of a color image when performing compression.

See also frequency balance and sharpness.

World file
A text file that contains geospatial positioning information to augment

or replace the geospatial metadata in an image file.

Y4

Zoom level
The scale at which an image is represented. Levels are generally
expressed with signed integer values. An image at scale one has half

the width and height of the original. See also scale and magnification.
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weight method (JPEG 2000) 75
weight method (MG3) 74
what is 67
with image crop 72
AUX files
generating 184
AUX files (LizardTech)

creating a mosaic with 155

B

Band and compression options 103
Band selection 105
BIP, BIL, BSQ header files 199

Build number 251

Cc

Calculating memory usage for MG3

encoding 195

Calculating MG3 area of interest
weight 197

Canceling jobs 35
Changing 149
Color balancing
mosaics 151
non-uniform corrections 80

single image 79

Color composite images 188
Color space 103
Commuter license 223
Composite mosaic

updating 153
Composite mosaics 145
Compression ratio 41
Compression ratios

per band 41
Concurrency 165
Context menu 17
Coordinate reference system

changing 86
Cropping animage 64

with area of interest 72
Cropping images

by vector overlay 65

D
Data cartridge 217
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ordering 11
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Default output format
JPEG 2000 171
NITF 191
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at encode 61
point spacing 63
threshold 63

Disk space 5

ECM 217
Editing metadata templates 59
Embedding GML schemas 139
Encode options dialog box 20
Encoding
multiband JPEG 2000 files 188
test images 34
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input 98
output 100
Quantization 116
transparency 113

Execute button 24

Executing jobs 35
Exporting job settings 36

Express Cartridge Manager 217
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File formats
AUX (output) 184
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G
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GeoExpress feature history 235
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GML and GMLJP2 185 removing images 29

about 186 running jobs 35

metadata control 139 selecting images for encoding 29
Graphical user interface 13 JPEG 2000
Grayscale band advanced settings 133

selecting single 106 alpha bands 187

area of interest 75

creating multiband files 188
Header files
default settings 137
for BIP, BIL, BSQ 199
output modes 185
for USGS DOQimages 204
profiles 139

I setting preferences 171
Image reprojection

sample workflow 88
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problems 249
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J administration 221
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Mosaics composite 145
Multi-threading 165
Multiband JPEG 2000 files 188
Multiresolution mosaics 146
Multisegment NITF images

as input 191

creating 192

in color composite images 191
Multispectral imagery

RGB color transform 42
Multispectral images

RGB color transform 103
Multispectral output

selecting and mapping bands
for 107

NITF
as default output format 191
compliance in GeoExpress 189
input metadata 55
JPEG 2000 encoding 190
mosaics 146
multisegement images 191

output metadata 189

raw 190
RPC 164

using NITF image segment in color

composite image 191

NITF images 189

Optimizing

resampling 110
Options

bands and compression 103
Ordering data cartridge 11
Other LizardTech products 245
Output

color space 103
Output directory

specifying 92
Output format

specifying 30
Output formats 30

Output tab 23

P

Part | JPEG 2000 185

Passwords 119
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Project files 36
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Q

Quantization 43

Removing 149
Reprojecting animage 86
Reprojection
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RGB color transform 42, 103
RGB output
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Rotation 165
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Running jobs 35

S
Sample MrSID metadata 207
Seam line correction 80
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Supported TIFF compression
types 206
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Target file size 42
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Testimages 34

Threads 165

Thumbnail size 108

TIFF compression types
supported 206

Tilt correction 80
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Y1Q color transform 42

Zoom levels 108
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